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Credits : 6 Maximum Marks : 100
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Objectives : To train the students of Sociology in basic statistical methods which are

applicable in Sociological problems and data analysis. The course also

intends to acquaint the students with the different computer applications

and their use in the Research.

UNIT-I Quantitative Methods and Survey Research

Measures of Central tendency : Mean, Median and Mode; Geometric

Mean and Harmonic Mean; Measurement and Scaling; Reliability and

Validity in quantitative Research.

UNIT-II Statistics in Social Research

Measures of Dispersion : Standard Deviation, Quartile Deviation, and

Mean Deviation; Correlation Analysis, Regressional Analysis & their

Relationship; Association of Attributes.

UNIT-III Sampling and Statistical Tests

Meaning and Methods of Sampling; Procedure of testing a hypothesis;

Tests of Significance - Student’s t-test, f-test and Chi-square test.

UNIT-IV Computer Application

Statistical data and use of Computers, Introdution to Windows Operating

System; M-S Word,  MS-Excel , M.S. Power Point, Introduction to MS

Office
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NOTE FOR PAPER SETTING :

The question paper will consist of three sections A, B and  C.

Section A will consist of eight long answer type questions, two from each unit with

internal choice. The candidates is required to answer any four questions selecting one from

each unit. Each questions carriers 12 Marks (12x4=48 marks).

Section B will consist of eight short answer type questions two from each unit with

internal choice. The candidate is required to answer  any four questions selecting  one from

each unit. Each question carriers 6 marks (6 x4=24 marks).

Section C will consist of eight objective type questions of one mark each. The

candidate is required  to answer all the eight questions. Total weightage will be of

1 x 8 = 8 marks.
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Course No. : SOC-C-302 Lesson No. 1

Unit - I    MEASURES OF CENTRAL TENDENCY Semester-III

STRUCTURE
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1.2 Objectives
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1.4 Different Measures of Central Tendency

1.5 Arithmetic Mean

1.5.1 Computation of Arithmetic Mean

1.5.2 Properties of Arithmetic Mean
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1.8 Summary

1.9 Glossary

1.10 Assignments

1.11 Lesson End Exercise

1.12  Suggested Readings

1.1 INTRODUCTION

With this lesson, we begin our formal discussion of the statistical methods for

summarising and describing numerical methods for summarising and describing

numerical data. The first step in that direction is to find one representative value

which can be used to locate and summaries the entire set of varying values (data).
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This one value can be used to make many  decisions concerning the entire set of

values. We can define measures of central tendency or location to find some central

value around which the data and to cluster.

In this lesson you will study the concept of measures of central tendency

and its types, Computation of Arithmetic mean, Geometric mean and Harmonic

mean. You will further learn in detail the properties, and limitations of these measures

of central tendency.

1.2 OBJECTIVES

After going through this lesson, you should be able to :

• understand the concept and significance of measures of central tendency.

• learn about different types of measures of central tendency.

• compute various measures of central tendency, such as Arithmetic mean,

Geometric mean and Harmonic mean.

• explain the properties and merits of central tendency, and

• state the limitations of the central tendency.

1.3 CONCEPT OF CENTRAL TENDENCY

In the general pattern of frequency distribution in the data we may identify a single

value around which many other items or values of the data congregate. This is a

value which is some where in the central part of the range of all values. When this

typical item/value of the data ais towards the central part of the data, it is known

as Central Tendency . As it indicates the location of the clustering of items, is also

called a measures of location. Thus, the central tendency (value) of the numerical

data gives the central idea of the entire data. Such a value is called central value

or an average or the expected value of the variable. The word average is very

commonly used in day-to-day conversation. Measures of central tendency enable us

to compare two or more sets of data to facilitate comparison. For example, the

average sales figures of a particular item of  June may be compared with the sales

figures  of previous months.

It should be clear that the concept of a measure of central tendency is concerned

only with quantitative variables (data) and is undefined for qualitative variables

(data) as these are unmeasurable on a scale.
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As the average is a single representative value of the mass of complex data, it must

have the following characteristics :

(i) It should be rigidly defined.

(ii) It should be easy to understand and simple to compute.

(iii) It should be based on all the observations of data.

(iv) It should not be affected by extreme values of the observations. As  single

extreme value i.e., a maximum or a minimum value can unduly affect the average.

A too small item can reduce the value of an average, and a too large item can also

inflate its value to a large extent.

(v) It should be capable of further algebraic treatment. That is an average should

be amenable to further algebraic treatment. That should add to its utility. For example,

if we are given the averages of three data sets of same type, it should be possible

to obtain the combined average of all those three data sets.

1.4 DIFFERENT TYPES OF MEASURES OF CENTRAL TENDENCY

In statistics, various types of measures of central tendencies or averages are studied.

For simplification and clearity, the different measures of central tendencies are

classified as under :

(a)Mathematical Averages :

1. Arithmetic Mean or Mean

2. Geometric Mean

3. Harmonic Mean

(b)Positional Averages :

1. Median

2. Mode

3. Partition values.

At presents however, we are confined to the first set of measures which A.M., G.M.

and H.M. The second set of measures shall be discussed in lesson 10.

1.5 ARITHMETIC MEAN

The arithmetic mean (A.M.) or mean or average is the most popular and widely

used measure of central tendency. It is obtained by dividing the sum of the values
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of all the observations in the given data by the number of observations in that data.

1.5.1 Computation of Arithmetic Mean

In classification and tabulation of data, we observed that the values of the variable

or observations can be put in the form of any of the following statistical series ;

namely :–

(i) Individual series or ungrouped data.

(ii) Discrete Frequency Distribution.

(iii) Continuous Frequency Distribution.

Arithmetic mean for the above series is calculated as under :

(I)Individual Series or Ungrouped Data : Following two methods are used for

calculating arithmetic mean of an individual series or ungrouped data or data without

any frequencies :

(a)Direct Method : Computation of A.M. is very simple when the data is ungrouped

i.e., frequency distribution is not given or done. Just add all the values of the

observation and divide it by the number of observations. Normally, the A.M. is

denoted by which X  which is read  as ‘X bar’. If the values of N observations on

a variable X are X
1
, X

2
, X

3
,......, X

N
; then the A.M., denoted by X , is defined by

1 2 3 N
XX + X + X ...X

X= =
N N


where X means sum of all the observations of variable X and N be the number

of observations.

NOTE :  (read it as sigma is the Greek symbol denoting the summation over

all values.

Example 1. The following table gives the daily income of 8 employees in an office.

Find out the average income of the employees.

Employes : 1 2 3 4 5 6 7 8

Income (Rs.) : 150 350 200 180 250 100 350 200

Solution : Average income can be computed as follows :
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X
X=

N


 =
150 350 200 180 250 100 350 200

8

      

 =
1780

8
=222.50

Thus, average income of the employees is Rs. 222.50 per day.

(b)Short-cut Method : When the values of the observation in the given data

are too large or they are in fraction; then the computation of mean through

direct method becomes difficult.

This difficulty can be solved by using the short-cut method. Under this method,

the following steps are to be followed :

Step–I : Assume any arbitrary mean (A) to find out the deviations of items

from assumed mean. The assumed mean is usually chosen to be a round number

in the middle of the range of the given observations, so that deviations can be easily

obtained by subtraction.

Step–II : Compute the deviation (D) of each observation from the assumed

mean i.e. D = X–A.

Step–III : Obtain the sum of all deviations i.e., D.

Step–IV : Compute the A.M. (average or mean) by using the following formula.

X=A+
N

D
Example 2. Obtain average income of data given in example 1 with short-cut

method.
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Solution : Suppose assumed mean is 200, then make the following table :

Employee No. Daily income D = X–A

(X)

1 150 –50

2 350 150

3 200 0

4 180 –20

5 250 50

6 100 –100

7 350 150

8 200 0

N = 8 D = 180

Thus, the average income is

   X=A+
N

D
 = 

180
200 +

8

= 200+22.50

= Rs. 222.50

NOTE : It may be observed here that answer obtained by the direct method

and the short-cut method is the same.

II. Discrete Frequency Distribution or Discrete Series or Grouped Data :
The following methods are used for computing arithmetic mean in a discrete

series or grouped data :

(a) Direct Method, (b)   Short Cut Method

(c) Step-Deviation Method.

(a) Direct Method : In grouped data or discrete series the average or

mean can be obtained by using the following formula :
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1 1 2 2

1 2

......
X=

...
n n

n

f X f X f X

f f f

fX

f

   


   = 
N

fX
Where X

1
, X

2
, X

3
........... X

n
 are the observations of the variable and

f
1
, f

2
, f

3
, ........... f

n
 are the respective frequencies.

The procedure will be more clear from the following examples :

Example 3. Following table gives the wages paid to 125. Workers in a factory per

day. Calculate the average of wages :

Wages (Rs.) 200 210 220 230 240 250 260

No. of Workers 5 15 32 42 15 12 4

Solution : Calculation of Arithmetic Mean

Wages (Rs.) Number of Workers fX

X f

200 5 1000

210 15 3150

220 32 7040

230 42 9660

240 15 3600

250 12 3000

260 4 1040

N = f = 125 fX = 28490

The average wage is

X=
28490

125

fX

f
 = 227.92

Thus, average wage is Rs. 227.92 per day.
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(b) Short-cut method : According to this method, the formula for calculating

arithmetic mean is

X=A
f D

N


Where

A = Assumed mean

D = X–A, i.e. deviations from assumed mean.

fD = Sum of the products of frequencies and their respective deviations.

Example 4. Calculate the arithmetic mean for the data in example 3 by using short

cut method.

Solution : In this case, assumed mean (A) is taken to be 230 as it is at the centre

of the range of the variable X. The other needed calculations are given in the table.

Wages (X ) No. of Workers Deviations fD

f D=X–230

200 5 –30 –150

210 15 –20 –300

220 32 –10 –320

230 42 0 0

240 15 10 150

250 12 20 240

260 4 30 120

N = f = 125 fD = –260

The arithmetic mean will be

X=A
D 260

230
125

f

f
  

  = 230 – 2.08
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  = 227.92

(e) Step–Deviation Method : In the short cut method, the deviations taken

from an assumed mean generally have a common factor. In continuous

series this common factor is nothing but the uniform class interval. The

computational work in short-cut method can be further simplified if the

deviations are divided by this common factors. The deviations divided by

the common factor are called step–deviations. According to this method the

arithmetic  mean is calculated by the formula :

   X=A
D

h
f

f
 

Here C = the common factor in deviations X–A

D =
X A

h


, the step deviations

Example 5. Use step deviation method for calculating arithmetic mean for the data

in example 3.

Solution : Computation of Arithmetic mean by step Deviation method

Wages No. of Workers Deviations D=
X 230

10


fD

X f X–230

200 5 –30 –3 –15

210 15 –20 –2 –30

220 32 –10 –1 –32

230 42 0 0 0

240 45 10 1 15

250 12 20 2 24

260 4 30 3 12

N = 125 fD=–26

Thus, the arithmetic mean becomes

C
N

9



    
D

X=A+
N

f
h

 
26

=230 +10
125

   
 = 230–2.08

 = 227.92

(III) Continuous Series : In continuous series, the procedure of computing

arithmetic mean is the same as in the case of discrete series. The only

difference is that in continuous series the frequencies within each class are

assumed to be distributed uniformly over its range. With this assumption

each class is then represented by its mid-point, denoted by m. using these

mid-points (m) of the classes and the corresponding frequencies, arithmetic

mean for the continuous series can be calculated by using any of the methods

used in a discrete series. The following example will clearity the procedure:

Example 6. Calculate the arithmetic mean from the following data by using Direct

Method and Step Deviation Method :

Class : 20–25 25–30 30–35 35–40 40–45 45–50 50–55

Frequency : 8 10 12 20 11 4 5

Solution : Computation of A. M.

Class Frequency Mid-Points fm
37.5

D=
5

m
fD

f m

20–25 8
20 25

2


 = 22.5 180.00 –3 –24

25–30 10
25 30

2


 = 27.50 275.00 –2 –20

C

10



30–35 12
30 35

2


 = 32.50 390.00 –1 –12

35–40 20
35 40

2


= 37.50 750.00 0 0

40–45 11
40 45

2


= 42.5 467.50 1 11

45–50 4
45 50

2


= 47.50 190.00 2 8

50-55 5
50 55

2


= 52.50 262.50 3 15

Total N = 70 fm = 2515 –21

Therefore, arithmetic mean is

By Direct Method :

2515
X

70

fm

f
   = 35.93

By Step Deviation Method :

X
fD

A h
f

    = 37.50+5
22

70

   
   = 37.50–1.57 = 35.93

1.5.2  Properties of Arithmetic Mean : The following are the main properties

of arithmetic mean :

(i) The sum of the deviations of the observations from the arithmetic mean is

always zero i.e., (X–X ) = 0. This is explained in the following illustration.

11



X X– X

10 –25

20 –15

30 –5

40 5

50 15

60 25

X = 210 (X- X ) = 0

Here X  = 
X 210

=
N 6


 = 35

(ii) If the number of items and mean are known, the total of the items can be

obtained as X  = 
X

N


, thus X = NX .

(iii) The sum of squares of deviations from the arithmetic mean is minimum i.e.,

it is always less than the sum of squares of deviations of the items taken

from any other value. In other words (X–X )2 is always minimum. We can

verify this  by taking the example

X X– X (X–X )2 X–10 X–20 (X–10)2 (X–20)2

5 –10 100 –5 –15 25 225

10 –5 25 0 –10 0 100

15 0 0 5 –5 25 25

20 5 25 10 0 100 0

25 10 100 15 5 225 25

X=75 (X–X )=0 250 375 375

12



13

Here X  = 
X

N


= 
75

5
 = 15

(X–X )2 = 250, (X–10)2 = (X–20)2 = 375

(X–X )2 is minimum.

(iv) If we add or delete an observation which is equal to mean, the A.M. remains

unaffected.

(v) If each observation is increased or decreased by some constant C, the A. M.

also increase or decrease by C. Similarly, when each observation is multiplied

by a constant, say K the A.M. is also multiplied by the same quantity K.

(vi) If the means and the number of observations of two or more related groups

are known, we can obtain the combined mean of these groups as follows

:

Combined Mean

 X  = 
1 1 2 2

1 2

N X + N X

N + N

Here X = Combined mean

N
1

= No. of observations in first group

N
2

= No. of observations in second group.

X 1
= Mean of the first group

X 2
= Mean of the second group

The formula may also be extended for K–groups as

X  = 
1 1 2 2 k k

1 2 k

N X + N X .....N X

N + N ......N
Example : The A. M. of the production of a item. during the period January to

August 4000 items per months and A.M. for the period September to December is



4300 items per month. Find the average production for the whole year.

Solution : Here N
1
 = 8 (Jan. to August)

N
2

= 4 (Sept. to Dec.)

X 1
 = 4000

X 2
 = 4300

The average production for the whole year (X ) can be obtained by combined mean

formula i.e.

 X = 
1 1 2 2

1 2

N X + N X

N + N

= 
8 4000 + 4 4300

8 + 4

 

= 
32000 +17200

12

= 
49200

12
 = 4100 items per month.

1.6 GEOMETRIC MEAN.

In the situations where we deal with quantities that change over a period of time,

we may be interested to know the average rate of change. In such cases the simple

arithmetic mean is not suitable and we have to resort to the geometric mean. The

geometric mean (G. M.) of a set of N positive items is defined as the Nth root of

their product.

1.6.1 Computation of Geometric Mean : Like arithmetic mean, computation

procedure of geometric mean is different for grouped and ungrouped data. As

defined, the geometric mean is given by

  G. M. = (X
1
. X

2
. X

3
. ...........X

N
)1/N for individual series

14



=  1 2

1

1 2. .... nff f N
nX X X  for discrete series

=  1 2

1

1 2 .... nff f N
nm m m  for continuous series

here N = f
1
+f

2
+ ...... f

n
 (in case of discrete and continuous series) and m be the mid-

points.

For example, the G.M. of three numbers 4, 8 and 16 would be

   G. M. = (4×8×16)1/3 = (512)1/3

= 8

If the number of items is four or more the task of multiplying the numbers and of

finding the Nth root becomes difficult. Therefore, computations can be simplified by

the use of logarithm. The G. M. is then calculated as follows :

  log G.M. = 1 2 NlogX + logX +.... logX

N



= 
logX

N


   G.M. = Antilog 
logX

N

   


Similarly in discrete and continuous series it becomes.

G.M. = Antilog 
logX

N

f   


 for discrete case
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= Antilog 
log

N

f m   


 for continuous case.

Example 8 : The daily income of 10 persons in a locality are given below

(in Rs.): 85, 70, 15, 75, 500, 8, 45, 250, 40, 36. obtain the geometric mean.

Solution : Computation of G.M.

X log X

85 1.9294

70 1.8451

15 1.1761

75 1.8751

500 2.6990

8 0.9031

45 1.6532

250 2.3979

40 1.6021

36 1.5563

Total  log X=17.6373

 G.M. = Antilog 
logX

N

   


= Antilog 
17.6373

10
   

= Antilog [1.76373]

= 58.03

Thus the geometric mean is Rs. 58.03.
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Example 9. Find the geometric mean in the following distribution.

Marks : 0–10 10-20 20–30 30–40 40–50

No. of Students : 5 7 15 25 8

Solution : Computation of G.M.

Marks No. of Mid-point log m f log m

(Class) Students (f) m

0–10 5 5 0.6990 3.4950

10–20 7 15 1.1761 8.2327

20–30 15 25 1.3979 20.9685

30–40 25 35 1.5441 38.6025

40–50 8 45 1.6532 13.2256

Total N = 60 85.5243

Here N = 60, f log m = 85.5243.

Thus, G.M. is

   G.M. = Antilog 
f logm

N

   


= Antilog 
85.5243

60
   

= Antilog [1.4087]

= 25.63 marks.

1.7 HARMONIC MEAN

As you know, generally the data is in varied forms. The manner in which the

data is given counts heavily for judging the appropriateness of the use of the

measures of central tendency. For example, when the total distance is constant

and the speed per unit time is given then harmonic mean would be more

appropriate measure to find average speed. Further, suppose that production
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rate per unit of time is given and we are interested in knowing the average,

then harmonic mean is preferable.

The harmonic mean (H.M.) of a set of observations is the reciprocal of the arithmetic

mean of the reciprocals of the observations. Thus,

   H.M. = 

1 2 N

N
1 1 1

+ +.... +
X X X

= 
N

1
X

    ; for individual series

= 
N

X
f    ; for discrete series

= 
N

f
m

    ; for continuous series

Here symbols have their usual meanings.

Example 10. Obtain harmonic mean of the following observations :

40, 45, 30, 35, 55, 65, 37, 42

Solution. Computation of H. M.

X 1/X

40 0.0250

45 0.0222

30 0.0333

35 0.0286

55 0.0182
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65 0.0154

37 0.0270

42 0.0238

0.1935

Here N = 8, 
1

X
     = 0.1935

The H.M. is

H.M. = 
N

1
X

     = 
8

0.1935
 = 41.34

Example 11. The distribution of marks obtained by students in a class is as under

Marks    : 20 21 22 23 24 25

No. of students : 4 12 15 20 11 8

Find the Harmonic mean.

Solution :– Computation of H.M.

X f
1

X

1

X
f
   

Marks No. of students

20 4 0.0500 0.2000

21 12 0.0476 0.5712

22 15 0.0455 0.6825

23 20 0.0435 0.8700

24 11 0.0417 0.4587

25 8 0.0400 0.3200

N = 70
f

X
    = 3.1024
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Here N = 70, 
f

X
    = 3.1024, thus

H. M. =
f

N

X
    =

70

3.1024

= 22.56 marks.

Example 12. A train goes at a speed of 20 miles per hour for the 16 miles, at a

speed of 40 miles per hour for 20 miles. It covers the last 10 miles at a speed of

15 miles per hour. Find out average speed.

Solution : Computation of H.M.

Speed Distance W/X

M.P.H. X W

20 16 0.800

40 20 0.500

15 10 0.667

Total 46 1.967

Here N = W = 46,  W

X
 = 1.967,

H.M. = 
W

W
X

   

  = 

46

1.967
 = 23.38

Average speed is 23.38 M.p.h.

1.8 SUMMARY

The main characteristics of the data are represented by a single figure known

as ‘an average’ or a mean’. It is the point of location around which individual values
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cluster. An ideal average must satisfy certain properties such as ease of calculation,

rigidity in its definition, should be based on all items, should remain unaffected by

extreme values, and also should have sampling stability. An average gives a bird’s

eye view of the entire data, facilities comparison and become and useful in statistical

inference. In the present lesson we have explained A.M., H.M., and G.M. in detail

alongwith their computational procedures.

1.9 GlOSSARY

Central Tendency :  The central value in data around which all other values

moves.

Arithmetic Mean:   The Simple average value calculated in data set is known as

arithmetic mean.

Geometric Mean :  Average change in quantities over a period of time is called

geometric mean.

Harmonic Mean :  It is the reciprocal of arithmetic mean.

Common difference  :  It is that valve which is common L.C.M of all the frequenies

in continous series. It is usually indicated by small letter ‘c’ .

1.10 Self Assignment

1. Explain the qualities of a good measure of central tendency.

2. What are the various measures of central tendency?

3. Define Arimetic mean. Also mention its properties and limitations.

4. Define geometric mean with its merits and demerits.

5. Give a brief description of harmonic mean. State the purpose of studying

this average.

6. The height (in cm) of 10 students are given as ; 156, 154, 168, 172, 160,

168, 175, 170, 158, 162. Find the A.M., G. M. and H.M.

7. Find, A.M., G.M. and H.M. for the following frequency distribution :
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Class f

10–20 4

20–30 8

30–40 6

40–50 20

50–60 12

60–70 8

70–80 2

8. The average monthly salary of 20 male worker in a factory in Rs. 3200/-

per month and that of 16 female is Rs. 2500/- per month. Find the average

salary of both male and female.

1.11 LESSON AND EXERCISE

1. The simplest of all averages is :-

(a)   Arithmetic mean b)    Geometric Mean

c)    Harmonic mean d)    None of the above

2. In case of continous Series , arithmetic mean is calculate conveniently

by.............

(a)   Direct method b)   Step Deviation Method

c)    Short cut method d)   All of the above

1.12 SUGGESTED READINGS

1. Elhance, R.N. and Veena Elhance. Fundamentals of Statistics.

2. Gupta, S.P. Statistical Methods.

3. Shenoy, G.V. Srivastava V. K. and S.C. Sharma. Business Statistics.

4. Simpson, G and Kafka, F. Basic Statistics.

------------
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Course No. : SOC-C-302        MEASURES OF CENTRAL Lesson No. 2
Unit - I TENDENCY—MEDIAN AND MODE Semester-III

 STRUCTURE

2.1 Introduction

2.2 Objectives

2.3 Median

2.3.1 Computation of Median

2.3.2 Merits and Limitations of Median

2.4 Partition Values

2.5 Mode

2.5.1 Computation of Mode

2.5.2 Merits and Limitations of Mode

2.6 Summary

2.7 Glossary

2.8 Assignments

2.9 Lesson end Exercise

  2.10 Suggested Readings

2.1 Introduction

As you have studied in Lesson 9 that measures of central tendency were

classified into two categories. Mathematic averages (A.M, G.M., and H.M.) have

already been explained in the previous lesson. As you know, these averages are

affected by extreme values and also cannot be obtained in open-end class interval.

Many times we may like to find a average which is not affected by extreme values.

Median and mode are such measures. There are some other measures called portion

values, which are not averages, but similar to median in concept. In the present

lesson you will learn the meaning, computational procedure, limitations of these
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measures of central tendency.

2.2 OBJECTIVES

After studying this lesson you  should be able to :

• understand the meaning of median

• understand the computational procedure of median for different sets of data,

• define quartiles and its computational procedure.

• understand the concept of mode and its computational procedure for

different  types of data, and

• state the uses and limitations of median and mode.

2.3 MEDIAN

In a given ‘array’ i.e., when the observations are arranged in an ascending

or descending order. Any point which divides the array into two equal parts, so that

exactly one half of the observations are below, and one-half are above that point,

is called median. Thus, the median is that value of the variable which divides the

group in two equal parts. The median is  usually denoted by M
e
 or M

d
.

2.3.1 Computation of Median

Median can be obtained for both ungroup and grouped data. But the  methods

are different. Now let us study the methods of computing median  for different

types of data.

I.Individual series or ungrouped data : The determination of median in an

individual series involves the following steps :

(i) The data are arranged either in ascending or descending order.

(ii) Locate median by determining the value of 
   

N 1

2

th

 item in the order, N

being the number of observations in the series. However, the value of median

depends on N i.e whether N is odd or even number.

(a) When N is odd : If N is odd then median is given by Me=
   

N 1

2

th

 item.

For example take the series 8, 12, 6, 4, 16, 13, 9. First we arrange these

values in ascending order as 4, 6, 8, 9, 12, 13, 16. As N = 7, an odd number, thus

median is
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     M
e

=
N 1

2

th     item

=
7 1

2

th     item = 4th item

= 9

(b)When N is even : When N is an even number, 
N 1

2

     will involve a fraction.

In such cases the median is taken as arithmetic mean of two middle values.

M
e

=
   N/ 2 item N / 2 1 item

2

th th 

Example 1. The following data relate to the height of 8 students in a class.

S. No. 1 2 3 4 5 6 7 8

Ht. (in cm) : 153 142 151 144 149 146 141 150

Find median.

Solution. For computing median, we first arrange the data in ascending order as

142 144 146 147 149 150 151 153

As N = 8, an even number, then median is given by

Me =

N N
item 1 item

2 2
2

th th          

=

8 8
item 1 item

2 2
2

th th          

=
4 item 5 item

2

th th

=
147 149

2


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=148 Cm.

II. Grouped Data– Discrete Case : As you know the data is in grouped form

i.e., in the form of frequency distribution, it can be either in the form of discrete

series or continuous series. The methods of computing median is different for these

two types of data. Let us study them separately.

Discrete Series. The procedure in this method consists of the following

steps:

(i) Arrange the data in ascending order,

(ii) Obtain the cumulative frequencies

(iii) Determine the size of 
1

2

th
N      item, N being  the total frequency..

(iv) Median is located at the value of the variable in whose cumulative

 frequency the value of 
1

2

th
N      item falls.

Example 2. Find the median size of the following data :

Size (x) : 4 10 8 5 9 7 6

Frequency : 6 5 20 12 14 28 15

Solution : As a first step, arrange this data (X) in ascending order and prepare the

following table by finding out cumulative frequencies.

Size (X) Frequency (f) CQM frequency

4 6 6

5 12  6 + 2 = 18

6 15 18 + 15 = 33

7 28 33 + 28 = 61

8 20 61 + 20 = 81

9 14 81 + 14 = 95

10 5 95 +  5 = 100

Total N = 100
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Then for locating median, we find the value of

 
N 1

2

th    =
100 1

2

th    = 50, 50th item

Then, as a last step, median is located at the value of item (X) in whose comulative

frequency the value of 50, 50th item falls. Thus

Med = 7

Continuous case : In this case, the procedure for calculating median is totally

different than previous method. First we locate the median class by cumulating the

frequencies until 
N

2

th     point is reached. Finally, the median is determined within

this class by using an interpolation formula. The procedure thus involves the following

steps :

Step : (i) Compute cumulative frequencies

Step : (ii) Find the size of 
N

2

th     item

Step : (iii) Locate the median class in which cumulative frequency column

         where  the size of 
N

2

th     item falls.

Step : (iv)Obtain the median by using the following formula :

Median = 
c f

i
f

N
. .

2L
 

where

L = Lower limit of the median class.

c.f. = Cumulative frequency of the class preceding the median class.

f = Simple frequency of the median  class

c = Class interval of the median

c
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NOTE : If the given frequency distribution consists of inclusive classes, then

true class limits or class boundaries for these classes should be obtained before

computing median.

Example 3. Following is the distribution of marks of 50 students in a class.

Marks : 0–10 10–20 20–30 30–40 40–50 50–60

No. of Students : 4 6 20 10 7 3

Find Median.

Solution. Computation of Median

Marks No. of Students f C.f.

0–10 4    4

10–20 6  4 +  6 = 10

20–30 20 10 + 20 = 30

30–40 10 30 + 10 = 40

40–50 7 40 +  7 = 47

50–60 3 47 + 3 = 50

Since N = 50, 
N 50

2 2
  = 25 which falls in the cum frequency (30) of the class

20–30, thus the median class is 20-30. Therefore to calculate median, we have
N

2
= 25, L = 20, f =20

C.f. = 10 i =10,  hence

Me = L + 

N
. .

2
C f

i
f

 

= 20 +
25 10

20


 ×10

= 20+ 7.5

= 27.50
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Example 4. Determine median for the following income distribution :

Income group : Below100 100–200 200–300 300–400 400–500 above 500

No. of Persons : 5 10 18 30 10 17

Solution : It is an example of open-end frequency distribution as the first class

interval is below 100 and last class interval is above 500. In such types of situations

median can easily be obtained.

Income No. of Persons C.f.

Group f

Below 100 5 5

100–200 10 15

200–300 18 33

300–400 30 63

400–500 20 83

Above 500 17 100

Since 
N

2
 = 

100

2
 = 50, thus the median class is 300–400. Thus

L = 300, f = 300 c.f. = 33, c = 100

Med = 

N
c f

L i
f

. .
2
 

= 300 +
50 33

30


× 100

= 300 +  
1700

30
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= 300 + 56.67

= 356.67

Example 5. From the following data find the value of the median :

Class int. : 11–15 16–20 21–25 26–30 31–35 36–40 41–45 46–50

Frequency : 7 10 13 26 35 22 11 6

Solution. Here inclusive classes are given. Therefore, for median determination

inclusive limits need to be converted into class boundaries as shown in the table.

Given   Class Frequency Cum freq.

Classes Boundaries   f.   c.f.

11–15 10.5–15.5 7 7

16–20 15.5– 20.5 10 17

21–25 20.5–25.5 13 30

26–30 25.5–30.5 26 56

31–35 30.5–35.5 35 91

36–40 35.5–40.5 22 113

41–45 40.5–45.5 11 124

46–50 45.5–50.5 6 130

Since 
N

2
 = 

130

2
 = 65, thus the median class 30.5 – 35.5. Thus

Med. = 

N
. .

2L
C f

i
f

 

= 30.50+
65 56

5
35

 

= 30.50+
9

7
= 30.50+1.2857

c
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= 31.7857

 31.79

2.3.2 Merits and Limitations of Median :

You have studied the meaning and computation of median alongwith the

illustrations. Now let us discuss the merits and demerits of median.

Merits

(i) For an open-end distribution, such an income distribution, the median given

more representative value.

(ii) It is not affected by the extreme items. It is of course affected by the number

of items.

(iii) Median minimizes the total absolute deviations i.e., the sum of  absolution

deviations from the median is the minimum.

(iv) For dealing with qualitative phenomena, median is the most suitable average.

Limitations

(i) Median is not capable of algebraic treatment.

(ii) It is not based on all items of the series.

(iii) It is affected more by sampling fluctuations.

(iv) The median, in some cases, cannot be computed exactly as the mean when

the number of items included in the series of data is even, the median is

determined approximately as the mid-point of the two middle items.

2.4 PARTITION VALUES

As we know that the median is the middle value of the variable and it spilts

the series into two equal parts. That is why it is called positional average. In fact,

there are other positional measures that partition the series into still more number of

equal parts, say four (quartiles) or 10 equal parts (Deciles) or 100 parts (percentiles).

These measures are known as portion values. We shall restrict ourself only to

quartiles.

The values of a variable that divide the series into four equal parts are known

as Quartiles. Since three points are required to divide the data in 4 equal parts, we have

three quartiles Q
1
, Q

2
, and Q

3
. The first quartile (Q

1
), known as a lower quartile, is

the value of a variate below which there are 25% of the observations and above which
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there are 75% of the observations.

The second quartile (Q
2
) is the value of a variate which divides the distribution into

2 equal parts. It means Q
2
 is same as Median.

The third quartile (Q
3
), known as upper quartile, is the value of a variate below

which there are 75% observations, and above which only 25% observations. Thus

it is clear that Q
1
, < Q

2
 > Q

3
. The formula for Q

1
 and Q

3
 is

Q
1 
= 

N
. .

4
C f

L i
f

 
and

Q
3 
= 

3N
. .

4
C f

L i
f

 
where symbols have usual meanings.

Example 6. Calculate Q
1
 and Q

3
 

 
from the following data :

Class : 0–10 10–20 20–30 30–40 40–50 50–60 60–70 70–80

Freq. : 10 15 20 25 35 15 16 14

Solution. Computation of Q
1
 and Q

3

Class Frequency (f) C.f.

0–10 10 10

10–20 15 25

20–30 20 45

30–40 25 70

40–50 35 105

50–60 15 120

60–70 16 136

70–80 14 150

c

c
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Computation Q
1
 : Since 

N

4
= 

150

4
= 37.50 lies in class (20–30), as  it falls in the

c.f. of 45, thus, Q
1
 is given by

Q
1

= 

N
. .

4L
C f

i
f

 

= 
37.50 25

20 100
20

 

= 20 + 
12.50

2
= 20 + 6.25

= 26.25

Computation of Q
3
 : Since 

3N

4
=

3 150

4


 = 112.50 lies in (50–60) class

as it falls in the C.f. 120, thus Q
3
 is given by

 Q
3

= 

3N
. .

4L
C f

f

 × i

= 50 + 
112.50 105

15


 ×10

= 50 + 
7.50

1.50
 = 50 + 5.00

= 55.00

2.5 MODE

The word ‘Mode’ comes from the French word ‘la mode’ which means the

fashion. In statistical language, the mode is that value of a variate which occurs most often

in a series, i.e., a value of a variate which is repeated most often in data  set. But it is not

c
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exactly true for every frequency distribution. Rather it is that value of the variate around

which the other items tend to concentrate most heavily. It shows the centre of concentration

of the frequency in and around a given value. It is commonly denoted by M
o
. For

example, take the case of a shopkeeper who sells shoes. He is interested to know the sizes

of shoes which are commonly demanded. Here in such a situation, mean would indicate

a size that may not fit any person. Median may also not provide a representative size

because of the unevenness in the distribution. It is the mode which will help in making

a choice of approximate size for which an order can be placed.

2.5.1 COMPUTATION OF MODE :

The method of computing mode is different for grouped and ungrouped data.

Now let us study those method separately.

(i) Ungrouped Data or Individual Series :  For  an ungrouped data or individual series

the mode can be located simply by inspection. Here, the value that occurs most frequently in

the data is taken as a mode. For example, the ages (in years) of 10 boys are 9, 11, 10, 14, 17, 14,

9, 11, 12, 11. Here the number 11 appeared thrice. Therefore, mode age is 11.

In some cases there may be more than one mode. For example; 8, 7, 12, 10, 8, 12, 8

12, 6, 5. In this case both the numbers 8 and 12 appear equal number of times (three). Therefore,

there are two modes; 8 and 12.

(ii) Discrete Series : In discrete series; when the  values of individual items are

known, mode can be determined just by inspection. By inspection you can find out the

value of the variate ordering  which the items are most heavily concentrated.

Example 7. Find the mode for the following data :

Size of item : 8 9 10 11 12 13 14

Frequency : 10 12 18 16 19 14 12

Solution : In this frequency distribution size of item 12 has the highest frequency, implying

that there is a heavy concentration of items at this value. Therefore mode is 12.

In a series like this it is easy to obtain mode. Difficulty arises when nearly equal

concentrations are found in two or more neighbouring classes. To locate modal

class in situations, there is a need for Grouping Method. In grouping method the
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values are first arranged in ascending order alongwith their frequencies. Normally,

the grouping table has the following six columns :

Column 1. The maximum frequency is marked by putting a mark or a circle.

Column 2. The frequencies are grouped in two’s and the highest total is marked.

Column 3. Leaving the first frequency, the remaining frequencies are grouped in

twos and the highest total is marked.

Column 4. The frequencies are grouped in threes, the highest total is marked.

Column 5. Leaving the first frequency, the remaining frequencies are grouped in

threes and the highest total is marked.

Column 6. Leaving the first two frequencies, the remaining are grouped in threes

and the highest  total is marked. After completing the

grouping table, an analysis table is formed for finding the value which

is repeated the highest number of times. The same procedure is adopted

for determining modal class in the case of continuous series.

(iii) Continuous Series : In a continuous series, frequencies are given in various

classes. A class having maximum frequency is called modal class. In case nearly

equal concentration of frequencies is observed in two or more classes, the grouping

method may be used to determine the modal class. After determining the modal

class, the mode can be obtained by using the following formula :

M
o

= 1 0

1 0 2

L
2

f f
i

f f f

  
where

L = Lower limit of the modal class

f
1

= Frequency of the modal class

f
0

= Frequency of the class preceding the modal class

f
1

= Frequency of the class succeeding the modal class

i = Class interval of the modal class

Note :  (i) While applying this formula, it is necessary to have uniform class

intervals. If they are unequal, first they should make equal.

c
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(ii) Where mode is ill-defined, its value may be obtained by using mean

and median  as

Mode = 3 Median–2 Mean

This is called empirical mode.

Example 8. Obtain mode of the following distribution :

Class : 10–20 20–30 30–40 40–50 50–60 60–70

Frequency : 8 12 25 45 11 9

Solution.

Class Frequency

0–20 8

20–30 12

30–40 25f
0

40–50 45f
1
 highest frequency

50–60 11f
2

60–70 9

MQ = 
1 0

1 0 2

L
2

f f
i

f f f

  
= 

45 25
40 10

2 45 25 11

   
= 

20
40 10

54
 

= 40+ 3.70 = 43.70

2.5.2 Merits and Limitations of Mode :

Merits

(i) In certain cases mode is the only suitable average. For example, modal size

of garments, shoes, modal wages.

(ii) Its value can be determined in open-end frequency distributions.
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of garments, shoes, modal wages.

(ii) Its value can be determined in open-end frequency distributions.

(iii) The value of mode can also be obtained graphically.

(iv) It can be used to describe qualitative phenomena.

(v) Like median, mode is not unduly affected by extreme values.

Limitations  :

(i) The value of mode cannot always be determined.

(ii) The value of mode is not unique.

(iii) The value of mode is not based on all the observations.

(iv) The value of mode is affected undually by the size of class intervals.

2.6  SUMMARY

In case of calculation of mean , we see there was a limitation of affecting its value by

changing the value of extreme item.

But while calculating the value of median or mode, this limitation is automatically

overcome. Here in this lesson we learned hoe to calculate median, mode and other

partition values such as quanties deciles and percentities . All these have their different

utilities of calculating

2.7 GLOSSARY

 Median: This measure of central tedency divides whole series into two equal parts

Mode :- This refers to that values in data which repeats most/ maximum times.

Quartile: Quartile divides whole of the series into four equal parts.

Decites : It divide whole data into ten equal sets.

Pencentices: It divides whole data set into 100 equal parts.

2.8 Assignments

1. What is Median? Explain its limitations.

2. Define mode. How is it different than median?

3. From the following data, obtain

(i) Median (ii) First and third quartiles (iii) Mode
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Wages Daily No. of employees

(in Rs)

20–40 8

40–60 12

60–80 20

80–100 30

110-120 40

120–140 35

140–160 18

160–180 7

180–200 5

4. Determine the model size of the collar by using grouping method.

Collar Size (in cm) : 32 33 34 35 36 37 38

39 40 41

No. of Students : 7 14 30 28 35 34 16 34 36 16

2.9 LESSON END EXERCISE

1.Which tool of statistics divides series into two equal parts

a) Mean b) Median c) Mode

2. _______indicates the quantity of data repeated maximum times in series.

3. The formula of calculating Q3 is ______________

2.10 SUGGESTED READINGS

1. Elhance, R.N. and Veena Elhance . Fundamentals of Statistics.

2. Gupta. S.P. Statistical Methods.

3. Shenoy, G.V. Srivastava V.K. and S.C. Sharma. Business Statstics.

4. Simpson, G. and Kafka, F. Basic Statistics.
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Course No. : SOC-C-302 Lesson No. 3

Unit - I      SCALING Semester-III

STRUCTURE

3.1 Introduction

3.2 Objectives

3.3 Meaning

3.4 Types of Scale

3.5 Summary

3.6 Glossary

3.7 Assigments

3.8 Lesson end Exercise

3.0 Suggested Readings

3.1 INTRODUCTION

Scales are techniques employed by social scientists in the area of attitude measurement.

They consist of a number of statements or questions and a set of response categories,

related to a score. They place respondents in a continuum between very low (or

negative), over a neutral, to a very high (or positive position. Each item is chosen

so that persons with different points of view on this item react to is in a different

way. In this sense they are a part of surveys and questionnaires and are considered

during the process of questionnaire construction.

7.2 OBJECTIVES

After going through this lesson , you should be able to :

.Understand the meaning of scaling

Types of Scale
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Understand the steps involved in constructing scales

7.3 MEANING

Scaling involves a high degree of operationalisation and allows researchers to measure

complex issues. Furthermore, it enables researchers to summate values of several

variables into one score and this with a relatively high degree of reliability. In

general, it offers respondents a choice of picking their  answers out of given sets

of alternatives, which as we shall see, are established in a very careful but also a

cumbersome way.

There are nominal, ordinal and interval/ratio scales. Of these, nominal scales are not

very common. Most popular are the Likert scales, the Thurstone scales and the

Guttman scales, which do not use nominal measurement.

Scales vary not only in their level of measurement but also in their aims and their

method of construction. Some are constructed by means of a very complicated

process, while others are built in a relatively simple manner. In all cases, however,

there are some basic points the experts such as Edwards (1957) and Likert (1932)

some time ago said should be considered during scale construction—points that are

still respected and practised in social research today many investigators. The following

are some examples :

Language must be simple, clear and direct.

Items must be brief (up to 20 words) and contain one issue only.

Complex sentences must be avoided.

Items referring to past events and factual items must be avoided.

Ambiguous and irrelevant items must be avoided.

Items that may be accepted or rejected by all respondents must be avoided.

Words such as all, always, no one, never, only, exactly, almost should be

avoided.

Use of professional jargon and double negations should be avoided.

Response categories must be mutually exclusive, exhaustive and

unidimensional (i.e. measuring one single construct).
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Reasons for using scales

Scales are used for a number of reasons. Apart from general methodological

motives, the following reasons are most common (see Vlahos. 1984) :

• High coverage : Scales help to cover all significant aspects of the concept

• High precision and reliability. Scales allow a high degree of precision and

reliability.

• High comparability. The use of scales permits comparisons between sets of

data.

• Simplicity. Scales help to simplify collection and analysis of the data.

Scales are a most useful tool of social research and also one that is very

difficult to construct. Construction and statistical testing are very involving and

time-consuming tasks and therefore not easily accessible to the ordinary researcher.

However, researchers developed and tested in the past a very large number of scales

which have been adequately tested and are available to other researchers to use. In

this sense, scale construction is less common than scale use. Scale construction may

be a step to consider after having completed your current course of study. in the

meaning using already available scales may be the way to go when addressing

issues for which scales are available.

3.4 TYPES OF SCALE

The Thurstone scale

Description

This scale was developed in the USA in the 1920s; it consists of a list of items

constructed with the aid of experts who are very closely related to the construction

of the scale. It is employed mainly in the area of attitude measurement, and is

developed through a cumbersome and demanding process, as explained below.

Construction

The construction of the scale is as follows :

Steps 1
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The researcher selects a number of relevant statements containing a set of response

categories (‘agree’, ‘disagree’) allowing respondents to express their attitudes to the

issue in question freely.

Step 2

These statements are given to a number of judges, who are asked to order them on

a continuum from 1 to 11, according to the way they judge the statements. If in the

opinion of the judge the statement describes the most favourable attitudes to the study

object, it is given the score 1; if it describes slightly less favourable attitudes, it is given

the score 2 and so on. In this way, statements are allocated a scale value.

Step 3

The statements are scrutinised in terms of the value they received from the judges.

Statements that were ordered by the judges uniformly are retained and given an

average scale value (the closest to the average); those that received a diverse value

are discarded.

Step 4

The remaining statements are processed further by the researcher, and their number,

reduced. The resulting scale is constructed so that statements are distributed evenly

between 1 and 11 and each statement is identified through its scale value.

Evaluation

Although Thurstone scales are still used, they are criticised. among other things, for

their demanding and time-consuming manner of construction, and the emphasis

they place on the views of the judges. They are a valuable tool of methodology, and

are employed as the sole technique or together with other methods of attitude

measurement.

The Likert scale

Description

Developed by Likert in 1932, this scale operates in a way similar to that of the

Thurstone scale. It consists of a set of items of equal value and a set of response

categories constructed around a continuum of agreement/disagreement to which

subjects are asked to respond. It is very popular among social scientists, is relatively
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easy to construct and is believed to be more reliable than the Thurstone scale.

Construction

Likert scales are constructed in the following way :

Step 1

A number of items related to an issue are collected. In general 80 to 120 items are

thought to be sufficient, but four times as many items as needed are generally

considered.

Step 2

Five-answer response categories are assigned to each item, ranging from ‘strongly

agree’ through ‘agree’, ‘undecided’ and ‘disagree’ to ‘strongly disagree’ including

numerical values, for example from 1 to 5 respectively.

Step 3

Statements are administered to respondents in a pilot study, and total scores are

computed and further processed to determine, for instance, unidimensionality, that

is measuring one and the same concept (usually through factor analysis), and internal

consistency (e.g. correlation with the total score is calculated).

Step 4

Items with a substantial correlation are retained ; items with low correlation

are discarded. The constructed scale is then administered to all respondents.

Example. There is a lot of sexism going on in this community.

Strongly agree Agree Undecided Disagree Strongly disagree

1 2 3 4 5

Evaluation

Likert scales are very popular among social scientists and have been so for more

than half a century. The reason for this is that they : (1) have a high degree of

validity even if the scale contains only a few items ; (2) provide single scores from

a set of items ; (3) have a very high reliability (between 0.85 and 0.94); (4) allow

ranking of the respondents; and (5) are relatively easy to construct. Nevertheless,

researchers point to some drawbacks of this method. For example, total scores
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referring to many and diverse items say little about a person’s response to the

various aspects of the research object; also, it is difficult to achieve equal items in

the scale (Kimmon, 1990).

The Bogardus social distance scale

Description

This scale was developed in the USA and was employed to measure ‘social distance’

between the respondents and persons of other nationalities or races: it is still used

to determine how close a respondent is willing to place himself or herself to persons

of other races or nationalities.

The scale consists of a number of statements that indicate the degree of distance

between the respondent and the groups under study. More particularly the

respondents are asked to state their reactions to a set of statements varying in

intensity of closeness to a population group. As a concrete example, respondents

could be asked to state which of the following seven statements (which actually

make up the scale) reflect accurately and honestly their true feelings towards

Aborigines, and whether they would accept an Aborigine as a :

•close relative by marriage

•personal friend

•neighbour

•colleague at work

•speaking acquaintance only

•visitor to their country

•person to be kept out of their country

Interpretation

The results obtained through this procedure are evaluated as shown below:

•Compute the mean values for each group.

•Rank each group according to the value of the mean.

•The higher the value, the greater the social distance, that is the lower the willingness
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to assume contacts with that group; and the stronger the negative prejudice

and attitude to that group.

Application

This scale, although originally developed to measure distance among ethnic

groups, can be equally successfully employed in other areas, for example in

market research and studies of race relations. One could, for instance, develop a

range of questions related to a certain item (car, television set, record player, etc.)

that could best describe a person’s intention and willingness to buy this item. For

example, questions ranging from I would most certainly buy this product’ to ‘I

will never buy such a thing a my life’ can be used to measure the degree of a

person’s readiness to purchase the item.

Evaluation

This scale has been used very extensively by social scientists. The three most

common advantages of the scale are the following (see Kimmon, 1990) :

1.A very high split-half reliability (r is equal to or greater than 0.90).

2.A high content validity of the scale items.

3.A satisfactory overall validity and reliability.

Although there are some problems associated with the construction of the steps of

the scale and their order, the scale is considered to be a very useful tool of social

research.

The Guttman scale

Description

This is another scale that measures social distance, or rather proximity’. It consists

of a number of statement placed in a hierarchical order ranging from low to high

in such a way that if respondents reject one statement they will also reject all other

statements above it; an if they accept one statement they will accept all other

statement below it.

Respondents are normally asked to state whether they agree or disagree with each

of the statement. The result obtained are expected to show the degree of proximity
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or distance of the subjects from the research object (e.g. migrants, blacks, homosexuals

etc.). More particularly, it will show how far the respondents will allow certain people

to come close to them.

Construction

Construction of such a scale is complicated and time consuming. In a simplified

form it can be constructed in the following way :

Step 1

A number of statements thought to be cumulative, that is, they fall in a hierarchical

order ranging from low to high, are formulated in such a way that if respondents

reject one statement they will also reject all other statements above it; and if they

accept one statement they will accept all other statements below it.

Step 2

These statements are presented to a number of subjects (say, 10), who are asked to

state whether they agree or disagree with each statement.

Step 3

A table with the numbers of the statements on the top, and the side, is constructed;

the agreements of the subjects with each statement are entered (note that disagreement

are not recorded).

Step 4

The statements are then ordered so that the one accepted by one subject only is

placed first, the statement accepted by two subjects second, the statement accepted

by three subjects third and so on.

Step 5

The reproducibility value, which is I minus the fraction consisting of the number

of errors (numerator) and the number of responses (denominator) is computed. If

the score is 0.90 or better the scale is satisfactory.

Evaluation

This scale has been employed very extensively in the past and is still considered
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to be valid and useful way of measuring social proximity. But, it is considered to

be more cumbersome than the Bogardus social distance scale, which is used more

frequently.

The semantic differential scale

Description

This technique was developed by Osgood, Suci and Tannenbaum in 1957 and has

been used by social scientists to measure the impression concepts make on people

and the meaning they invoke. Concepts are measured independently as well as in

comparison with other concepts, and can be related to a variety of contexts, issues

or objects, in this way allowing the researcher to draw relevant conclusions about

the respondents.

The semantic differential scale consists of a number of opposite concepts, which

may range from 7 to over 70. Examples of such opposites are given below. The

data sheet containing the sets of opposites is administered to the respondents with

instructions to place an individual (e.g. a teacher) or a group of individuals (e.g.

Asian migrants) in a specific position between the extremes of a continuum.

Example. Some opposites

Good 6 5 4 3 2 1 0 Bad

Democratic 6 5 4 3 2 1 0 Authoritarian

Sociable 6 5 4 3 2 1 0 Unsociable

Strong 6 5 4 3 2 1 0 Weak

Flexible 6 5 4 3 2 1 0 Rigid

Cooperative 6 5 4 3 2 1 0 Uncooperative

High 6 5 4 3 2 1 0 Low

Hard 6 5 4 3 2 1 0 Soft

Conformist 6 5 4 3 2 1 0 Non-conformist

Fair 6 5 4 3 2 1 0 Unfair

Difficult 6 5 4 3 2 1 0 Easy
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Active 6 5 4 3 2 1 0 Passive

Sharp 6 5 4 3 2 1 0 Dull

Independent 6 5 4 3 2 1 0 Dependent

Irritable 6 5 4 3 2 1 0 Calm

Hot 6 5 4 3 2 1 0 Cold

Harmonious 6 5 4 3 2 1 0 Unharonious

The numberals indicate the degree of agreement or disagreement of the subjects

regarding the concepts under evaluation. In the example, 6 stands for very good,

strong, high, etc., 5 for moderately good, strong, etc., 4 for fairly good, strong, etc.,

3 for undecided, 2 for fairly bad, unsociable, weak low, etc., 1 for moderately bad,

unsociable, weak, etc., and 0 for very bad, unsociable weak, low, etc.

The subject’s judgement is based on three distinct characteristics, namely evaluation

of the individual, judgement of the potency or power of the individual, and judgement

of the activity of the individual. General evaluation is judged by opposites such as

good-bad, sociable-unsociable, high-low and harmonious-unharmonious. Potency

is judged by means of opposites such as hard-soft, large-small, difficult-easy and

unyielding-lenient. Activity is judged by opposites such as hot-cold, active-passive,

sharp-dull and irritable-calm. Of these three dimensions the first (evaluation) seems

to be the most important.

Respondents are advised to evaluate the study person or group, by indicating the

number that corresponds to their feelings on the specific item. If the respondents

think that the person in question is modetely good they are advised to circle ‘5’ at

the ‘good’ and ‘bad’ item; if they feel that this person is fairly unsociable they

should circle ‘2’ in the second line, and so forth. Each circle represents a score

which can be high or low depending on the subject’s judgement of the concept or

the individual, for example the teacher. When the evaluation is completed, a total

score for the impression of the concept or the person in question is computed by

adding up all individual scores. A high score represent a high impression and a low

score indicates a low impression of the concept or the person.

This scale can be employed successively in a number of different groups, such as
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Asian migrants, Italian migrants and British migrants, allowing comparisons to be

made between these groups.

Interpretation

The results of this procedure can be interpreted and presented in many

ways. The method of adding up the individual scores mentioned above is one.

Drawing profiles, computation of correlation coefficients and of the semantic

distances are other ways.

Evaluation

The semantic differential method offers precise information about the attitudes

of people toward others. It allows evaluation of concepts, comparisons and

measurement of different types on the same measure, and is relatively easy to

construct. It has, however, to be treated with caution. For instance, a long list of

points to choose from might cause confusion and also inaccurate results. The use

of equal intervals or ordinal data is another issue. Definitions of the concepts and

their meanings might vary from one respondent to another, causing problems and

distortions.

3.5 SUMMARY

The concept and practice of measurement are two important and also controversial
issues. However, the controversy in this case is not about whether to employ
measurement in social research or not but rather about how and in what way
measurement should be employed. The practice of measurement is well accepted in
social research, regardless of type and nature. Some studies may use nominal
measurement, others may use ordinal and others interval/ratio measurement.

All types of measurement are employed. The notion that one type of research is
better than the other is incorrect. Qualitative researchers may opt for nominal
measurement, but this does not make other types of measurement less effective. In
one and the same research instrument one may find some variables being measured
at the nominal level and others at the ordinal or interval/ratio level. The latter
provides different types of information than the former but it nevertheless produces
equally useful information.

The level of measurement is useful for itself, but more so for further research and
analysis. The level of measurement determines the type of measures that are to
employed in the analysis. As we shall see in Chapters .............., there is a close
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relationship between level of measurement, type of variable and statistical tests. For
this reason, having a clear understanding of the level of measurement is important
for doing research, and for assuring high level of accuracy.

Measurement together with objectivity and ethics on one hand and with validity
and reliability on the other constitute major principles of social research. The latter
are central to any type of research, regardless of its nature and ideological affiliation.
Adherence to reliability and validity is a fundamental requirement which researchers
have to consider seriously when doing research. Reliability and validity are indicators
of consistency, truthfulness and accuracy, and such concepts are structural ingredients
of any type of research.

Measurement, validity and reliability, together with scaling, which was discussed in
the last part of this chapter, are very useful research tools. They help establish the
parameters for producing well-founded and respectable findings.

3.6 GLOSSARY

Scaling makes research work simple by removing the complexities involved im
measurement of data Likert Scale is the most popular Scale.

3.7 ASSIGNMENTS

1. What  do you mean by scaling?

___________________________________________________________________

___________________________________________________________________

__________________________________________________________________

2. Give the reasons , why Scales are used?

______________________________________________________________________

__________________________________________________________________

__________________________________________________________________

3. Explain in detail various types of Scales and steps involved in each scale for
castructing

__________________________________________________________________

_____________________________________________________________________
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3.8 LESSON END EXCERCISE

1. Scale helps primarily in_________

a) Measuring the observation b) collecting data

c)  Simplying the data collection d) All of the above

2. _______________ is the basic features of a good scale.

3. Likert Scale was developed by ___________in _____________

3.9 SUGGESTED READING

1. Naresh Malhotra : Marketing Research.

2. C.R Kothari : Research Design

51
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Unit - I          VALIDITY AND RELIABILITY Semester-III
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4.2 Objectives

4.3 Meaning of Reliability

4.4 Types of Reliability

4.5 Meaning of Validity

4.6 Types of Validity

4.7 Difference between Validity and Reliability

4.8 Summary.

4.9 Glossary

4.10 Assignments

4.11 Lesson end Exercise

4.12 Suggested Readings

4.1 INTRODUCTION

Science depends on accurate and systematic measurement. Because researchers

must demonstrate that they are recording events accurately, scientific instruments are

tested regularly for accuracy. Obviously, instruments that do not give true reading

are not useful. Though dependence on instruments is necessary, for all science,

demonstrating reliability and validity in the social science is often more difficult than

it is in the natural sciences. In the natural sciences e.g., official standards for items

such as weight, temperature or chemical purity are available for testing instruments.
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Social scientists do not have this luxury. Measuring such things as attitude or

intelligence is very difficult because there is no universally accepted ‘official standards’.

The crediability of field studies, naturalistic observations, and archival research

depends on  clear and convincing evidence that recording techniques are acceptable.

Thus investigation must demonstrate that behavioural measures are reliable and

valid. Reliability and validity refers to data collection. That is, they refer to whether

data recording devices are reliable and valid and to whether surveys, tests or

observational systems really addresses what the investegator is studying.

4.2 OBJECTIVES

The main objectives of this unit is to understand

• Meaning and Definitions of Validity and Reliability.

• Types of Validity and Reliability

• Importance of Validity and Reliability in Measurement.

• Difference b/w Validity and Reliability.

4.3 MEANING OF RELIABILITY

Reliability refers to the ability of an instrument to produce consistent or same

results. Since a grocer obtains the true measure of a commodity by a kilogram, a

cloth merchant obtain true length of cloth by a meter, and a tailor by an inch-tape,

these measuring instruments have to be reliable Reliability is the degree to which

measures are free from error so that they give same results when repeat measurements

are made under constant conditions. If there are imperfections in the measuring

process and the respondent misunderstands the question, or understands the question

but does not give a truthful response, it will be the cause of low reliability of

measurement.

4.4 TYPES OF RELIABILITY

There are four types for testing the reliability of an instrument, these are :–

Test-Retest Reliability : This means administering the same scale or measure to

the same respondents at two separate times for stability. It will be reliable if the

reported test administered under conditions similar to the first test obtain similar

results.
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Internal consistency reliability : It refers to the degree of agreement between

various items on the measurement device. While assessing aggression among children

on a playground, one could record many types of behaviour. These could be acts

of physical violence, vocal outbursts, angry gestures of facial expressions etc. One

would record many types of each and then check to see if certain behaviour correlates

with others.

Split half reliability : Here responses, to the items of an instrument are divided and

the scores correlated. The degree of co-relation indicates the degree of reliability of

measurement. The test could alternatively be divided into more parts– thirds, quarters

etc; provided all the items are comparable. The correlation is then corrected to give

the stepped up reliability of the whole test.

Equivalent form reliability :  It is utilized when two alternative instruments are

designed to be as equivalent or possible. Each of the two measurement scales is

administered to the same group of subjects. If there is high correlation between the

two form, the researcher assumes that the scale is reliable.

4.5 MEANING OF VALIDITY

Validity means the ability to produce findings that are in agreement with

conceptual or theoretical values. e.g., an attitude measurement technique may indicate

that 80 percent people are in favour of using family planning measures. But 80

percent people may not actually use these methods. A reliable but invalid instrument

will yield consistently inaccurate results. So, validity refers to the success of the

scale in measuring what is meant to be measured. Many a times, the scale used may

be reliable but it measures something other than what it was designed to measure.

4.6 TYPES OF VALIDITY

Empirical Validation : It tests pragmatic or criterion validity. If an instrument has,

for instance, produced results indicating that students involved in student union

activities do better in their exams, and if this is supported by available data, the

instrument in question has pragmatic validity. Again validity here is assumed if the

findings are supported by already existing empirical evidences. In this case validity

is concurrent validity.

Theoretical Validation : It is employed when empirical confirmation of validity is

difficult or not possible. A measure is taken to have theoretical validity if its findings
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comply with the theoretical principles of the disciplines, that is, if they don’t contradict

already established rules of the discipline.

Face Validity : An instrument has face validity if it seems to measure what it is

expected to measure “on the face of it”. In such a case, it appears to have validity,

e.g., a questionnaire aimed at studying sex discrimination has face validity if its

questions refer to discrimination due to sex. The standard of evidence here is not

based on empirical evidence, as it was in the case of the other types of validation,

but on general theoretical standards and principles, and on the subjective judgements

of the researcher.

Content Validity : A measure is supposed to have content validity if it covers all

possible aspects of the research topic. If a measure of operation, for instance, does

not include normlessness or powerlessness the researcher cannot claim content validity

for this instrument.

Construct Validity :  A measure can claim construct validity if its theoretical construct

is valid. For this reason, validation concentrates on the validity of the theoretical

construct. For example, if discrimination of female students is the research topic, we

proceed as follows : an instrument is constructed to study this topic. Then two

student groups known to differ in their views on basic issues related to the research

question are identified. Next the instrument whose validity is to be checked is

administered to both groups of the results recorded separately for each group. If the

findings obtained from each group differ, the instrument is thought to have construct

validity.

4.7 DIFFERENCE BETWEEN VALIDITY AND RELIABILITY

Zikmund has illustrated the difference between reliability and validity by an

example of an old and a modern rifle. The shots by a marksman from the old rifle

(target A) are considerably scattered but from the new rifle (target B) are closely

clustered, showing thereby that the old rifle is less reliable. In target C, shots with

the modern rifle may be reliable but if his vision is not proper, the marksman may

not be able to hit the bull’s eye.

4.8 SUMMARY

So we can say that research in social sciences involves studying behaviours.
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Accurately recording what subjects are doing is difficult and research is always in

danger of being influenced by the expectations of the researchers. The concept of

validity and reliability are employed to ensure the soundness of consistency of

measurement techniques. Validity refers to whether research actually measures what

it was intended to measure, reliability refers to whether the research produces

consistent results. So, sound measurement must meet the tests of validity and reliability.

4.9 GLOSSARY

-Reliability is the ability of a scale to measure something without any bias.

-An instrument (questionnaire) is said to be valid if it produces some generally

acceptable results fro a given study.

- A good research instruent is that which possess sufficient reliability as well as

Validity

4.10 ASSIGNMENTS

1. What do you mean by Reliability and Validity ?

__________________________________________________________________

__________________________________________________________________

__________________________________________________________________

2. What is the important role played by Reliability and Validity ?

__________________________________________________________________

__________________________________________________________________

__________________________________________________________________

3. Differentiate between Reliability and Validity ?

__________________________________________________________________

__________________________________________________________________

__________________________________________________________________

4.11 LESSON END EXERCISE

1. Tailor uses inch-tape to measure the lenght of suit is an example of___________

2. The degree of agreement betwee various items of an instrument is known as
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a) Content Validity b) Internal consistency

c) Face Validity d) None of these

3. Reliability refers to consistency in the results where as Validity refers to measuring

What is meant to be measured by a scale (True/ Falsa)

4.12  SUGGESTED READING

1. Naresh Malhotra : Marketing Research.

2. C.R. Kothari : Research Design
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5.9 Suggested Readings

5.1  INTRODUCTION

In the Lessons 9 and 10, we have studied the various measures of central tendency

that are used to provide a single representative value of a given set of data. This

value tells us where the centre of the set of data ties but does not tell us how the

data is scattered around this central value. Two sets of data may have the same

average but the items in one set may scatter widely around its average while in the

other case, items may be close to the average. In this way the central value alone
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can not describe the distribution adequately. A further description about the

scatteredness is necessary to get a better description of data. The extent or degree

to which data tend to spread around an average in called the dispersion or variation.

Measures of dispersion help us in studying the extend to which observations are

scattered around the central value. Such measures are helpful in comparing two or

more series with regard to their variability.

A good measure of dispersion should possess, as far as possible, the same properties

as those of a good measure of central tendency as discussed in lesson 9.

5.2 OBJECTIVE

After successful completion of this lesson, you should be able to :

• understand the concept of dispersion,

• know the significance of measuring dispersion,

• know the different types of measures of dispersions,

• distinguish between absolute and relative measures of dispersion,

• know the computational procedure of these measures, and

• understand the various importance of these measures.

5.3 TYPES OF MEASURES OF DISPERSION

Following are same of the well known measures of dispersion which provide a

numerical index of the variability of the given data :

(i) Range (ii)   Semi-Interquartile Range

(iii) Mean Deviation (iv)  Standard Deviation

Further, measures of dispersion are of two types, namely-Absolute measure of

dispersion and Relative Measure of dispersion.

Absolute measures of dispersion are expressed in the same unit in which the

observations are given. These measures are useful for comparing two or more sets

of data where units of measurements is the same. Relative measures of dispersion

are expressed as ratio or percentage or the coefficient of the absolute measures of

dispersion. These measures are pure number, free from unit of measurement and are

generally called coefficient of dispersion. Relative measures are useful for comparing
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variability in two or more sets of data where units of measurement may be different.

Now we shall discuss various measures.

5.3.1Range :

Range is the simplest measure of dispersion. It is defined as the difference between

the highest value and lowest value of the data. In symbols, Range is given by

Range = L – S

where L = largest value, and

S = smallest value.

In case of grouped data, the range is defined as the difference between the

upper limit of the highest class and the lower limit of the smallest class.

Range is the absolute measure of dispersion which is not suitable for

comparison. To overcome this difficulty a relative measure of dispersion, called the

coefficient of Range is calculated by the following formula

Coefficient of Range = 
L S

L+S


Range is not suitable measure of dispersion because it is not based on all

the observations. It is also affected by extreme observations. It does not tell us about

the variation in the observations relative to the average. Despite various limitations,

ranges us a quick and simple measure and it is useful in quality control for analysing

the variations in the quality of the product. It is very useful in weather forecasting.

5.3.2The Inter-Quartile Range or Quartile Deviation :

The quartile deviation, also known as semi-interquartile range, is computed by

taking the average of the difference between third quartile (Q
3
) and the first quartile

(Q
1
). In symbolls, this can be written as

Q.D. = 3 1Q Q

2


As quartile deviation is an absolute measure of dispersion, thus its relative measure

of dispersion called coefficient of quartile deviation, is defined as

Coefficient of Q.D. = 
3 1

3 1

Q Q

Q Q



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It is also not suitable because it is not based on all the items and it is very

much affected by sampling fluctuations. However, it is a good measure of dispersion.

In case of open-end frequency distribution.

Example 1. For the following data, compute quartile deviation and its coefficient.

Weekly Wages (in Rs.) No. of Workers

Below 850 12

850-900 16

900-950 39

950-1000 56

1000-1050 62

1050-1100 75

1100-1150 30

1150 and Above 10

Solution. To compute quartile deviation, we first need the values of Q
1
 and Q

3
 which

can be obtained from the following table :

Weekly Wages (in Rs.) No. of Workers f c.f.

Below 850 12 12

850-900 16 28

900-950 39 67

950-1000 56 123

1000-1050 62 185

1050-1100 75 260

1100-1150 30 290

1150 and Above 10 300

N = 300

Since 
N 300

4 4
  = 75 which falls in the class 950-1000, thus Q

1
 is given by
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  Q
1
 = L + 

. .
4
N

c f
i

f

 

= 950 + 
75 67

56


×50

= 950 + 
50

7
 = 950+7.14

= 957.14

Similarly Q
3
 is

  Q
3
 = 1050 +

225 185

75


 × 50

= 1050 +
2000

75
 = 1050+26.67

= 1076.67

Thus Q.D. = 3 1 1076.76 957.14

2 2

Q Q 

= 
119.53

2
 = 59.765

and Coefficient of Q.D. is

Coefficient of Q.D. = 
3 1

3 1

Q Q

Q +Q



= 
1076.67 957.14

1076.67 957.14



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= 
119.53

2033.81

= 0.0587

= 5.87%

The quartile deviation is superior to range as it is based on two extreme

values i.e. it is based on middle 50% of the observations.

5.3.3 Mean Deviation :

As discussed, the range and quartile deviation are not based on all the observations.

More so, these are not measures of dispersion in strict sense of the term as they do

not measure scatteredness in observations around an average. The mean deviation

is an improvement as it considers all the observations. Mean deviation is defined as

the arithmetic mean of the absolute deviations of observations taken from some

central value, such as mean, median, mode. Here all the deviations are treated as

positive regardless of sign. In symbolls, the mean deviation about mean, median or

mode can be expressed as follows :

Mean Deviation from mean (X )

M.D. (X ) = 
1

X X
N
 

Mean Deviation from median (M
e
) :

M.D. (M
e
) = 

1
X M

N e 
Mean Deviation from Mode (M

0
) :

M.D. (M
0
) : = 0

1
X M

N
 

where N is the number of observations.

In case of grouped data, the above formulae can be expressed as :
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M.D. (X ) = 
1

X X
N

f 

M.D. (M
e
) = 

1
X M

N ef 

M.D. (M
0
) = 0

1
X M

N
f 

where N be the sum of frequencies.

The relative measure corresponding to the mean deviation, called the

coefficient of Mean Deviation, is obtained by dividing the mean deviation by the

particular average used in computing the mean deviation. Thus, if mean deviation

has been computed from mean, the coefficient of mean deviation would be :

Coefficient of Mean Deviation = 
M.D.(X)

X

Although the mean deviation is a good measure of dispersion, its use is

limited.

Example 2. Consider the following data which are relate to the sales of

acompany for 100 days :

Sales (Rs. thousand) No. of days

40-50 10

50-60 15

60-70 25

70-80 30

80-90 12

90-100 8
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Compute mean deviation from mean, median and mode. Also obtain their

coefficient of mean deviation.

Solution : To compute mean deviation from mean,median and mode, first

we compute mean, median and mode. We construct the following table :

Sales No. of days Mid-Point fx X X f X X |X–M
e
|

(Rs. Thousand) f x

40-50 5 45 225 5 26 130 26.67

50-60 15 55 825 20 16 240 16.67

60-70 25 65 1625 45 6 150 6.67

70-80 30 75 2250 75 4 120 3.33

80-90 20 85 1700 95 14 280 13.33

90-100 5 95 475 100 24 120 23.33

Total 100 fx= f |X–X |=

7100 1040

f |X–M
e
| |X–M

0
| f|X–M

0
|

133,35 28.33 141.65

250.05 18.33 274.95

166.75 8.33 208.25

66.60 1.67 50.10

66.65 11.67 233.40

116.65 21.67 108.35

f |X–M
e
| f |X–M

0
|

=800.05 =1016.70
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Here X  = 
X 7100

100

f

N

   = 71.00

M
e
 = L + 

N
. .

2
c f

i
f

 

= 70 + 

100
45

2 10
30

 

= 70 + 
50 45

3



= 70 + 
5

3
 = 71.67

and

M  = L + 
1 0

1 0 22

f f

f f f


   × i

= 70 + 
30 25

2 30 25 20


    × 10

= 70 + 
50

15
 = 73.33

(i) The mean deviation from mean is

M.D. (X ) = 
X- X 1040

N 100

f   = 10.40

and coefficient of mean deviation is
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coefficient of M.D. (X ) = 
M.D. (X)

X

= 
10.40

71.00
 = 0.146478

= 14.65%

(ii) The mean deviation from median

M.D. (M
e
) = 

X M 800.05

N 100
ef  

= 8.0005 ~ 8.00

and its coefficient is

coefficient of M.D. (M
e
) = 

M.D. (M )

M
e

e

= 
8.00

71.67
 =0.11162

= 11.16%

(iii) The mean deviation of mode

M.D. (M
0
) = 

0X M 1016.70

N 100

f  
     = 10.17

and

Coeff. of M. D. (M
0
) = 

0

0

M.D.(M )

M
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  = 
10.17

73.33
 = 0.1387

  ฀  13.87%

Note : You may observe here that the mean deviation from median is 8.00 which

minimum as compared to other mean deviations. It has also been discussed while

discussing median in lesson 10.

5.3.4 Standard Deviation :

Standard deviation is the most popular and important measure of dispersion. It

satisfies most of the properties of a good measure of dispersion. The standard

deviation is defined as the positive square root of the arithmetic mean of the squares

of deviations of the observations taken from the mean. It is also known as “Root

mean square

Deviation” and is generally denoted by the small Greek letter  (called sigma).

Symbolically, for ungrouped data or individual series, the standard deviation () is

defined as

S.D. = =  21
X X

N
 

In case of frequency distribution, the formula becomes

=  21
X X

N
f 

The square of the standard deviation is known as variance. It is denoted by

2 and given by

=  21
X X

N
  , for individual series
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   =  21
X X

N
f  , for continuous series.

Remarks :

1.The S.D. is an absolute measure of dispersion or variability in a distribution. The

greater the amount of dispersion or variability, the greater the standard deviation.

On the other hand, a smaller standard deviation means a higher degree of uniformity

of the observations.

2.Standard deviations of two or more distributions with nearly identical means may

be compared in respect of variability in observation around the mean. The

distribution with the smallest standard deviation has the most representative mean.

3.The S.D. is expressed in the unit of the observations of the series while the

variance is measured in square unit. For example, if the observations are

measured in inches, the S.D. will be in inches while the variance will be in sq.

inches.

Computation of Standard Deviation (S.D.)

(I)Individual Series or Ungrouped data

For ungrouped data, the following two methods are used for computing standard

deviation—

1. Direct Method.

2. Short-cut Method.

Direct Method :

In this procedure, the following formula is used for calculating S.D. ()—

 =  21
x x

n
     ....(1)
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or  = 

22 2
2x x x

x
n n n

                 ....(2)

Remarks : 1. Formula (1) is taken to be appropriate only when the mean

is a whole number.

2. Formula (2) does not involve any deviations and thus, should be recommended

when the observations are not too large.

The following examples will clarify their use.

Example 3. Calculate S.D. from the following set of observations :

x : 10 11 17 25 7 13 21 10 12 14

Computing S.D.

x (x–x ) (x–x )2

10 –4 16

11 –3 9

17 3 9

25 11 121

7 –7 49

13 –1 1

21 7 49

10 –4 16

12 –2 4

14 0 0

x=140 (x–x )2 = 274

Solution :

Here x  = 
140

10

x

n

   = 14
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Using formula (1)

   =  21
x x

n
    

= 
1

274
10
   

= (27.4) = 5.23

Example 4. Use formula (2) to calculate S.D. for the data in example 3.

Calculation of standard deviation

x x2

10 100

11 121

17 289

25 625

7 49

13 169

21 441

10 100

12 144

14 196

x=140 x2=2234

Solution :

Using formula (2) i.e.,
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 = 

22x x

n n

       

= 

2
2234 140

10 10

      
= [223.4–196]

= [27.4]=5.23

Which is the same as that obtained in example 3.

Short-cut-Method

In most of the cases the arithmetic mean of the given distribution happens to be a

fractional value and then the process of taking deviation and equaring them becomes

quite tedious and time consuming in the computation of S.D. To overcome this

difficulty, short-cut method of computation is used which involves deviations from

assumed mean. The short-cut formula for calculating S.D. is—

S.D. =  = ....(3)

Here,   d = deviation from assumed mean, say A ; i.e., d = (x–A)

d = the sum of deviations

d2 = the sum of squares of deviations

  n = the number of observations.

Example 5. Find S.D. from the data in example 3.

Computation of S.D.

x d=x–A d2

10 —2 4

11 —1 1
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17 +5 25

25 +13 169

7 —5 25

13 +1 1

21 +9 81

10 —2 4

12 0 0

14 2 4

n = 10 d=20 d2=314

Solution :

Let A = 12

Using formula (3) i.e.,

    = 

22d d

n n

       

= 

2
314 20

10 10

      
= (31.4–4) = (27.4)

= 5.23

(II) Computation of S.D. in Grouped data

Any of the following three procedures may be applied to find S.D. for grouped

data.

1. Direct Method.

2. Short-Cut Method.

3. Step-Deviation Method.

73



Direct Method :

In direct method of computing S.D., the following formula is used—

S.D. =  =  21

N
f x x

     ....(4)

where symbols have their meaning.

Example 6. Use direct-method to calculate the S.D. of the following discrete

frequency distribution.

Size (x) : 4 5 6 7 8 9 10

Frequency : 6 12 15 28 20 14 5

Solution. Computation of S.D. (Direct-method)

Size Frequency fx (x–x ) (x–x )2 f (x–x )2

x f

4 6 24 –3.06 9.3636 56.1816

5 12 60 –2.06 4.2436 50.9232

6 15 90 –1.06 1.1236 16.8540

7 28 196 –0.06 0.0036 0.1008

8 20 160 +0.94 0.8836 17.6720

9 14 126 +1.94 3.7636 52.6904

10 5 50 +2.94 8.6436 43.2180

N = 100 fx =706 f (x-x )2

= 237.6400

Here, we first  calculate —
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fx
x

N
 = 

706

100
 = 7.06

Using formula 4

S. D. =  =  21
f x x

N
      = 

237.64
100

     =  2.3764 =1.54.

Remark : This method involves deviations from actual mean x . Thus, the

computation procedure becomes difficult when mean is not a whole number.

However, in practitar the procedure is rarely used as arithmetic mean is generally

a fractional value.

Short-Cut-Method :

In the direct method of computing S.D., we face a difficult situation when the

arithme mean is not a whole number. To avoid such difficulties, we consider the

deviations observations from a suitably chosen assumed mean, say A. In short-cut

method of comping the S.D. we make use of the following formula—

S.D. =  = 

22fd fd

N N

              .......(5)

Where d is deviation from assumed mean. The short-cut method of calculating S.D.

involves the following steps—

Example 7. Use short-cut method to find the S.D. of the data in example 6.

Solution.

Computation of S.D. (Short-cut method)

x f d = (x–7) fd d2 fd2

4 6 –3 –18 9 54

5 12 –2 –24 4 48

6 15 –1 –15 1 15

75



7 28 0 0 0 0

8 20 1 +20 1 20

9 14 2 +28 4 56

10 5 3 +15 9 45

N = 100 fd =6 fd2 =238

Using formula 5,

   = 

2 22
238 6

100 100

fd fd

N N

                          
 

=  2.38 0.0036 2.3764 1.54.  
Step–Deviation Method.

In short-cut method of calculation our main aim is to simplify the deviations

so that computations become easier. In grouped data, specially in continous frequency

distributions, we observe that the calculations can be further simplified if deviations

(d) are divided by a common factor, say h, which is usually the size of the class-

interval to get the step-derivations as d. However, such a division is then reflected

in the formula for computing S.D. which now becomes —

= h

2'2 'fd fd

N N

             
 

.....(6)

Steps involved in computing S.D. by using step-deviation method will be clear

from the following example.

Example 8. Use short-cut and step-deviation method for calculating S.D. of the

following distribution.

Age groups (years) : 25–30 30–35 35–40 40–45 45–50 50–55

No. of workers : 10 12 25 40 10 3
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Solution. Using Short-cut method.

Computation of S.D. (Short-cut method)

Age Frequency Mid-value d= (x–42.5) fd2 d2 fd2

f

25–30 10 27.5 –15 –150 225 2250

30–35 12 32.5 –10 –120 100 1200

35–40 25 37.5 –5 –125 25 625

40–45 40 42.5 0 0 0 0

45–50 10 47.5 5 50 25 250

50–55 3 52.5 10 30 100 300

N=100 fd= –315 fd2

= 4625

The assumed mean is taken as A = 42.5. Using formula (22).

    = 

2 22 4625 315

100 100

fd fd

N N

                     
 

=    46.25 9.9225 36.3275  = 6.03 years.

Using Step-derivation Method :

Computation of S.D. (Step-deviation Method)

Age Frequency Mid-value d’ = 
42.5

5

x 
fd’ fd’2

f x

25–30 10 27.5 –3 –30 90

30–35 12 32.5 –2 –24 48
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35–40 25 37.5 –1 –25 25

40–45 40 42.5 0 0 0

45–50 10 47.5 1 10 10

50–55 3 52.5 2 6 12

N =100 fd’ = 63 fd’2

= 185

Here, A = 42.5 and h= 5. Using formula (6), i.e.,

    = h 

22' 'fd fd

N N

        
 

Putting the values from the table,

   = 5

2
185 63

100 100

         =  5 1.85 0.3969  
=  5 1.4531  = 5×1.2054 = 6.03 years.

Which is the same as that obtained by short-cut method.

Remark : In grouped data case, we have demonstrated various methods of

computing the S.D. If is easy to see that step-deviation method is, in general, best for

calculating S.D. of the grouped data.

Merits and Demerits of Standard Deviation :

Merits.

1. It is rigidly defined.

2. Its computation is based on all the observations.

3. It is amenable to further algebric treatment which makes it the most important

and widely used measure of dispersion. For example, the S.D. is used in
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computing skewness, correlation etc. It is an important statistical measure in sampling

theory.

4. Among all the measures of dispersion, it is least affected by sampling fluctuations.

5. S.D. enables us to determine the reliability of means of two or more series

having equal means. In such a situation, a series having

minimum S.D. will have the most representative mean. In other words, a smaller

value of S.D. reflect greater compactness and smaller variability among items.

Demerits :

1. S.D. is comparatively difficult to calculate.

2. It gives greater weight to extreme observations.

3. It is an absolute measure of dispersion and cannot be used for comparing

variability of two or more distributions expressed in different units.

5.4 CO-EFFICIENT OF VARIATION (C.V.)

It is now clear that the standard deviation, as a measures of dispersion, gives

us an idea about the extent to which observations are scattered around their mean.

Thus, two or more distributions having the same mean can be compared directly

for their variability with the help of corresponding standard deviations. Now the

following two situations may arise —

(a) When two or more distributions having unequal means are to be

compared in respect of their variability.

(b) When two or more distributions having observations expressed in

different units of measurements are to be compared in respect of their

scatteredness or variability.

For making comparisions in the above two situations, we use a relative

measure of dispersion, called co-efficient of variation (C.V.). The co-efficient of
variation (C.V.) is defined as —

C.V. =
x


 ×100
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Remarks :

1.Co-efficient of variation is a pure number independent of the units of

measurements.

2.This is useful for making comparisons between two or more distributions in

respect of their variability, homogeneity, uniformity or consistency.

3.The distribution having greater C.V. is considered more variable than the other

and the distribution with lesser C.V. shows greater consistency, homogeneity and

uniformity.

The following example will clarify the use of co-efficient of variation.

Example 9. A sample of 5 items was taken from the output of a factory.

The length and weight of 5 items are given below :

Length (Inches) : 5 6 7 9 12

Weight (Ounces) : 13 15 18 19 20

State which of the two characteristics of the two items is more variable.

Solution. The two characteristics of the items, are length and weight

expressed in inches and ounces respectively. Since the units of the two characteristics

are different, their variability can be compared with the help of co-efficients of

variation which is computed as under —

Computation of co-efficient of variation

Length (Inches) Weight (ounces)

x d
x
= (x–7) dx2 dy d

y
 = (y–18) dy2

5 –2 4 13 –5 25

6 –1 1 15 –3 9

7 0 0 18 0 0

9 2 4 19 1 1

12 5 25 20 2 4

n =5 dx = 4 dx2 = 34 n = 5 dy = –5 dy2 = 39

For Length (x-Series)
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Mean  = 
xd

x A
n

 
 = 7+ 

4

5
 = 7.8 inches.

S.D. = x = 

22
x xd d

n n

        
 

 = 

2
34 4

5 5

       
 =  6.8 0.64  =  6.14

 = 2.48 inches.

For Weight (y-Series)

Mean = 
yd

y A
n

 
= 18+ 

5

5

     = 17.0 ounces.

S.D. = 
y
 = 

22
y yd d

n n

         
 

    = 

2
39 5

5 5

       
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    =  7.8 1  =  6.8

    = 2.61 ounces.

Co-efficient of variation

C.V. = 
x

x


×100 = 

2.48

7.80
×100

      = 31.79%

Co-efficient of variation

C.V. = 
y

y


×100 = 

2.61

17.00
×100

     = 15.35%

on comparing the two C.V.’s we can say that the length characteristic is more

variable than weight.

SUMMARY

The average does not enable us to draw a full picture of a set of observations.

Two sets of observations may have the same averages but the obsrvations in one

may scatter wildly around this average while in the other case, all the observations

may be close to this average. Thus, the measure of sactterednes of observation

around their average is necessary  to ge a better description of data. The extent or

degree to which data tend to spread

around an average is called dispersion or variation. Measures of dispersion may

be absolute or relative. Absolute measures of dispersion are expressed in the unit

of given observations. Such measures are useful for comparing variations in two or

more distributions in which the units of measurement are the same. On the other

hand, relative measures of dispersion, also called co-efficient of dispersion, are

pure unitless numbers useful for comparing the variability in two or more distributions

in which units of measurements are different. We study four important absolute

measures of dispersion, namely—Range, Interquartile range and Quartile
deviation, mean deviation and standard deviation. The Range is defined as the
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difference between two extreme observations. Interquartile range is the difference

between the third and the first quartile. Quartile deviation gives the average amount

by which the two quartiles differ from the median. Range, interquartile range and

quartile deviation are not measures of dispersion in the strict sense of the term as

they do not measure scatteredness in observations around an average and more so,

their computation is not based on all the observations. Mean-deviation is defined

as the arithmetic mean of the absolute deviations of various  items from an average

value, such as mean, median or mode. In the computation of mean-deviation, we

ignore signs of deviations and consider absolute values only. The standard-deviation
is defined as the positive square-root of the arithmetic mean of the squares of

deviations of observations from the arithmetic mean. This is also known as ‘root
mean square deviation.’ The square of standard-deviation is known as variance.
The standard deviation is expressed in the unit of observations in the series while

variance is measured in square units. The standard deviation is the best measure of

dispersion as it satisfies most of the desirable properties.

After defining absolute measures of dispersion, we face with the difficulty

of comparing variability in two or more distributions in which observations are

expressed in different units or the means of the distributions are widely different.

Thus, relative measure of dispersion are defined to overcome such situation. Co-
efficient of Variation (C.V.) is the best measure

of relative dispersion to deal with such situations. C.V. is useful for comparing

distributions in respect of their variability, homogeneity, uniformity or consistency.

The distribution having greater C.V. is considered more variable than the other, and

the distribution with lesser C.V. shows greater consistency, homogeneity and

uniformity.

5.6 GLOSSARY

- Dispersion : It is the variations in all data when we compare it with its mean value

so it can also be called Spread in data

- Range : A simplest measure of dispersion

- Mean Deviation: It measures the average deviation of data from  its central value.

-Standard deviation overcomes the limitations of mean deviation i.e. effect of negative

items.
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5.6 ASSIGNMENTS

1. What do you understand by dispersion? What is the need of studying

dispersion?

2. What is meant by absolute and relative measure of dispersion?

3. Explain briefly the essentials of a good measure of variation.

4. What do you mean by dispersion? Enlist the important measures of dispersion.

5. Define range and quaritle deviation. Also write their merits and demerits as

a measure of dispersion.

6. Define mean deviation with its merits and demerits.

7. Define standard deviation. Explain its uses.

8. State the properties of standard deviation. Why is it called the best measure

of dispersion?

9. What is meant by relative dispersion? When are they used? How are they

measured?

10. Define variance and co-efficient of variance.

11. Discuss some important algebric properites of S.D.

12. In what way measures of variation supplement measures of central tendency?

Explain.

13. What is co-efficient of variation? What purpose does it serve?

14. Distinguish between variance and co-efficient of variation.

15. From the following data, find  range and quartile deviation. Also determine their

co-efficients.

Months : 1 2 3 4 5 6 7 8 9 10 11 12

Sales (Rs.) : 78 80 80 82 82 84 84 86 86 88 88 90

16. Calculate Q.D. and its co-efficient from the following data :

Weight (Kg.)  : 60 61 62 63 65 70 75 80

No. or workers  : 1 3 5 7 10 3 1 1

17. Calculate range and Q.D. for the following data. Also find their co-efficients.

Classes : 0–5 5–10 10–15 15–20 20–25 25–30 30–35 35–40

Frequency : 4 5 6 10 11 9 4 1

18. You are given two variables A and B. Using Q.D., state which is more variable.
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Mid points : 15 20 25 30 35 40 45

Frequency : 15 33 56 103 40 32 10

Mid points : 100 150 200 250 300 350 400 450

Frequency : 340 492 890 1420 620 360 187 140

19. Calculate mean deviation from median of the prices given below :

Prices (Rs.) 210 220 225 225 225 235 240 250 270 280

Also find co-efficient of mean deviation.

20. From the table given below, find mean deviation from the median and also its

coefficient.

Size : 0–10 10–20 20–30 30–40 40–50 50–60 60–70

Frequency : 4 8 11 15 11 7 4

21. Find S.D. and C.V. from the following data :

Marks : 0–10 10–20 20–30 30–40 40–50 50–60 60–70

No.of Student : 10 15 25 25 10 10 5

22. Find mean and S.D. from the following data. Also find C.V.

Age (Less than)  :10 20 30 40 50 60 70 80

No. of persons : 15 30 53 75 100 110 115 125

[Hint. Change the data into a simple frequency distribution]

5.8 LESSON END EXERCISE

1. The formula for computing Range is _________

2. ___________deviation is not affected by the negative values in data.

3.  ___________ is the statistical tool that can be used to compare the degree of

deviations in two different data sets.

 SUGGESTIVE READINGS

1. Clark, T.C. and E.W. Jordan (1985). Introduction to Business and Economic

Statistics, South-Western Publishing Co.

2. Enns, P.G. (1985) Business Statistics.

3. Gupta, S.P. Statistical Methods.
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Course No. : SOC-C-302 Lesson No. 6

Unit - II     CORRELATION ANALYSIS Semester-III

 STRUCTURE

6.1 Introduction

6.2 Objectives

6.3 Meaning of Correlation

6.4 Methods of Studying Correlation

6.5 Scatter Diagram Method

6.6 Karl Pearson’s Coefficient of Correlation and its Computation

6.7 Spearman’s Coefficient of Rank Correlation

6.8 Summary

6.9 Glossary

  6.10 Assignments

  6.11 Lesson End Excercise

  6.12 Suggested Readings

6.1 INTRODUCTION

In the previous lessons we have confined our discussions with the distributions

of the data involving only one variable. Such a distribution is called univariate

distribution. However, in practice, we come across situations where more than

one variable are involved. For example, demand and supply of a commodity,

volume and temperature of a gas, heights and weight of student in a class etc.

In such situations, our aim is to determine whether there exists a relationship

between two variables. If such a relationship can be expressed by a mathematical

formula, then we shall be able to use it for an analysis of data. Correlation is

the method that deals with the analysis of such relationships between two
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variables.

6.2 OBJECTIVES

After successful completion of this lesson, the students will be able to :

• understand the concept of correlation,

• draw a scatter diagram and have an idea about types of correlation,

• compute and interpret correlation, and

• know the limitations of correlation coefficient

• calculate Karl Pearson’s Coefficient of Correlation by different methods,

• learn some important properties of Coefficient of Correlation,

• understand the probable error and its application, and

• know about Coefficient of Determination and its use.

• to understand the meaning of ranks and rank correlation.

• to learn the computational procedure of rank correlation.

• to know the merits and demerits of rank correlation, and

6.3 MEANING OF CORRELATION

If for every value of a variable, X, we have a corresponding value of another

variable Y, the resulting series of pairs of values of two variables is known as

bivariate population and its distribution is known as bivariate distribution.

In a bivariate distribution if the change in one variable appears to be accompanied

by a change in other variable and vice-versa, then the two variables are said to be

correlated and this relationship is called correlation or co-variation. In other words,

the tendency of simultaneous variation of the two variables is called correlation.

Then correlation studies the degree of inter-dependence between two variables.

•The correlation is of the following types :

Positive and Negative Correlation : As a first step, the correlation may be classified

according to the direction of change in the two variables. When the increase (or

decrease) in one variable results in a corresponding increase (or decrease) in the
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other, the correlation is said to be positive. Thus positive correlation means change

in both variables in the same direction. For example, increase in amount spent on

advertisement and sales. However, if the two variables deviate in opposite direction,

they are said to be negatively correlated. In other words, if the increase (or decrease)

in one variable creates a decrease (or increase) in the other variable, then the

correlation between two variables is said to be negative.

Further the correlation is perfectly positive if the change in two variables is in

the same direction and same ratio. However, it is perfectly negative if the change in

two variables is in opposite direction but in same ratio.

6.4 METHODS OF STUDYING CORRELATION

The following methods may be used for studying the correlation between two

variables ( For ungrouped data) :

(i) Scatter Diagram Method (ii) Karl Pearson’s Coefficient of Correlation (iii)

Spearman’s Coefficient of Rank Correlation.

The first two methods are discussed in the present lesson while Spearman’s Coefficient

of rank correlation will be discussed in Lesson 13.

6.5 SCATTER DIAGRAM METHOD

A graphical representation of a set of pairs of values of two variables X and

Y in a coordinate system is called a scatter diagram or simply dot

diagram. By means of scatter diagram one can quickly judge the type of correlation

between the variables. Scatter diagrams, as an example, showing various degrees

of correlation are shown in the given figures
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In figure (a) all the dots are lying on a straight line of positive slope, thus

we have a perfect positive correlation between two variables and the value of

correlation coefficient will be +1. Similarly, in fig. (b) all the dots in the diagram

are lying on a straight line of negative slope and this situation shows perfect negative

correlation between two variables. Here its value will be –1. In fig. (c), the dots lie

close to a straight line of positive slope and this shows a high degree positive

correlation. Similarly, in fig (d), the dots lie close to a straight line of negative slope

which indicates that the negative correlation of high degree exists between two

variables. Finally, if the dots do not follow a pattern alongwith a straight line as in

fig. (e), we have no correlation or zero correlation and we may conclude that no

linear relationship exists between the variables X and Y. In view of the above

discussion, it is clear that the greater the scatter of dots from the straight line on the

graph, the lesser the correlation.

This method has the following drawbacks :

(i) It gives only a rough idea that how the two variables are related.

(ii) It gives an idea about the direction and also whether is high or low.

(iii) It does not indicate the degree or extent of relationship existing between

the two variables.

In the following section we will discuss Karl Pearson’s Coefficient of Correlation

which measures the correlation numerically.

6.6KARL PEARSON’S COEFFICIENT OF CORRELATION

To determine the degree or extent of the linear correlation between two variables,

Karl Pearson, defined a numerical measure called Correlation Coefficient denoted

by r, and given by

r = 
    

Cov X,Y

V X V Y  = 
 

X Y

Cov X,Y

 
where Cov (X, Y) is the covariance between X and Y, and 

X
 and 

Y
 are the

standard deviations of X and Y respectively. It is also known as Product Moment

Correlation Coefficient or simply Coefficient of Correlation.

If (X
i
, Y

i
), i = 1, 2, 3, ...., n be the set of values of size n from a bivariate population
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of (X, Y). Let X  and Y  be the means of X and Y respectively, then correlation

coefficient is given by

r = 
  

   2 2

1
X X Y Y

n
1 1

X X Y Y
n n

  
   

= 
2 2 2 2

XY XY

X X Y Y

n

n n

 
    .......(1)

It can also be expressed as

r = 
  

   2 22 2

XY X Y

X X Y Y

n

n n

   
      .......(2)

The study of the correlation is of immense use in practical life where most of the

variables show some kind of relationship. With the help of correlation coefficient

we can measure the degree of relationship existing between variables.

The value of the coefficient of correlation (r) always lies between—1 and +1.

Where r = –1 or +1, the correlation is said to be perfectly negative or positive. An

intermediate value of r between –1 and +1 indicates the degree of linear relationship

between two variables X and Y whereas its sign tells about the direction of

relationship. r = 0 means no linear relationship between two variables. However,

if covariance is zero then the variables are said to be independent and r = 0.

The correlation coefficient is a pure number, independent of the unit of measurement.

Limitations of Correlation Coefficient

The correlation coefficient is a measure of the relationship between two variables,

say X and Y. While it generally, serves as a useful statistical tool, we should also

be aware of its limitations. The correlation coefficient is a measure of statistical

relationship, and not of casual relationship, between the two variables. This means

that the value of r tells us whether, and with what regularity, y increases or decreases

as X increase. But it cannot tell us whether that increase or decrease is due to any

91



casual or cause-effect relationship between two variables. Further, the correlation

coefficient is a measure of linear statistical relationship only, and may fail to be a

proper index of statistical relationship in case it is non-linear.

Calculation of Correlation Coefficient

For ungrouped data, Karl Pearson’s Coefficient of Correlation can be obtained by

using any of the following three methods :

Actual Mean Method : In this method, we make use of the following formula to

determine the coefficient of correlation :

r = 
  
   2 2

X X Y Y

X X Y Y

  
    .........(1)

This method is suitable in cases where the man values X  and Y  are not fractions.

Example 1. Calculate the correlation coefficient between the height of father and

height of son from the given data :

Height (in inches)

Father  : 70, 69, 68, 67, 66, 65, 64

Son    : 72, 68, 70, 68, 65, 67, 66

Solution : In this example X  and Y  are not fractional values as

X  = 
469

7
 = 67 and Y  = 

476

7
 = 68, so actual mean method will be suitable.

Height of Height of X–X (X–X )2 (Y–Y ) (Y–Y )2 (X–X ) (Y–Y )

Father (X) Son (Y)

70 72 3 9 4 16 12

69 68 2 4 0 0 0

68 70 1 1 2 4 2

67 68 0 0 0 0 0

66 65 –1 1 –3 9 3

65 67 –2 4 –1 1 2
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64 66 –3 9 –2 4 6

X = 469 Y = 476 28 34 25

Thus

r = 
  
   2 2

X X Y Y

X X Y Y

  
   

= 
25

28 34

= 
25

30.86
 = 0.81

III Short-cut Method :  When mean values of X and Y i.e.X  and Y  are

in fractions and the values of paired observations is also large, then computation of

the coefficient of correlation can be further simplified by using deviations of the

observations from some suitable chosen values (called assumed means). The formula

for computing correlation coefficient based on deviations is

r =
  

   2 22 2

x yn d d dx dy

n dx dx n dy dy

   
     

where

dx = X–A, the deviations taken from assumed mean A.

dy = Y–B, the deviations taken from assumed mean B.

dx = Sum of deviations of X.

dy = Sum of deviations of Y.

dx2 = Sum of squares of deviations of X.

dy2 = Sum of squares of deviations of Y.

dxdy = Sum of products of the deviations of X and Y.
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The computational procedure will be more clear from the following example

:

Example 3. Obtain the coefficient of correlation between X and Y from the following

data :

X : 47 44 40 38 42 43 45 42 44 40 46 44

Y : 19 26 30 31 29 29 27 27 19 18 19 31

Solution :

X Y dx = X–42 dy = Y–29 dx2 dy2 dxdy

47 19 5 –10 25 100 –50

44 26 2 –3 4 9 –6

40 30 –2 1 4 1 –2

38 31 –4 2 16 4 –8

42 29 0 0 0 0 0

43 29 1 0 1 0 0

45 27 3 –2 9 4 –6

42 27 0 –2 0 4 0

44 19 2 –10 4 100 –20

40 18 –2 –11 4 121 22

46 19 4 –10 16 100 –40

44 31 2 2 4 4 4

Total 11 –43 87 447 –108

 r = 

= 
    
   2 2

12 108 11 43

12 87 11 12 447 43

   
    
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= 
823

923 3515



= 
823

1801.21



= –0.457

NOTE :- All the methods provide same value of coefficient of correlation.

Some Properties of Correlation Coefficient

The following are the main properties of the coefficient of correlation :

(i)The correlation coefficient between two variables is symmetric, i.e. correlation coefficient

between X and Y (r
xy
) is same as correlation coefficient between Y and X (r

yx
), i.e. r

xy

= r
yx
.

(ii)The coefficient of correlation, r , lies between –1 and +1, i.e.

–  r + 1.

(iii)The coefficient of correlation is independent of charge of origin and scale.

Here charge in origin means adding or subtracting some constant value from given

observations on the variable X and Y and change in scale means multiplying or dividing

the observations on X and Y by same constant value. Suppose we want to obtain

correlation coefficient between X and Y. Now to determine r
xy
, let the constants ‘a’ and

‘b’ be subtracted from X and Y respectively. The resulting values of X and Y be further

divided by ‘h’ and ‘k’. Let us denote the new values by U and V respectively, i.e.,

U = 
X a

h


 and V = 

Y b

k


Then according to this property the correlation coefficient between X and Y will be

same as that of between U and V. Thus instead of finding coefficient of correlation

between X and Y, we first define U and V and then find out coefficient of correlation

between U and V. Thus property is very useful for reducing computational work

involved in the coefficient of correlation.

NOTE :-  If we take h = k = 1, then this property reduced to short-cut method of
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determining coefficient of correlation. The computational procedure will be more clear

from the following example.

Example 4. Find the coefficient of correlation between X and Y from the following

data:

Capital Invested ('000 Rs.) : 100  90  80  70  60  50  40  30  20  10

Profit ('000 Rs.) :               85  75  65  55  45  35  25  15   5   5

Solution : First we define U and V as

U = 
X 60

10


 and V = 

Y 45

10



X Y U V U 2 V 2 UV

100 85 4 4 16 16 16

90 75 3 3 9 9 9

80 65 2 2 4 4 4

70 55 1 1 1 1 1

60 45 0 0 0 0 0

50 35 –1 –1 1 1 1

40 25 –2 –2 4 4 4

30 15 –3 –3 9 9 9

20 5 –4 –4 16 16 16

10 5 –5 –4 25 16 20

Total –5 –4 85 76 80

_ r = 
  

   2 22 2

UV U V

U U V V

n

n n

   
     
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  = 
  

   2 2

10 80 5 4

10 85 5 10 76 4

   
     

= 
780

825 744

= 
780

783.45
 = 0.9956

This means a very high degree positive correlation between capital invested and

profit earned.

Coefficient of Determination

The coefficient of determination is a simple and useful way of interpreting the

value of correlation coefficient. It indicates the percentage variation in the

dependent variable. In other words, it explains the production of variation in

the dependent variable which is explained by a change in the independent

variable. The coefficient of determination, denoted by R, is defined as

R = r2

Also R = 
Explained Variation

Total Variation

If r = 0.80, then R will be 0.64 and it means that 64% variation in the dependent

variable has been explained by the independent variable.

6.7 SPEARMAN’S COEFFICIENT OF RANK CORRELATION

We have discussed Karl Pearson’s Coefficient of Correlation, studied the degree

of covariability of linear relationship between two variables for which the observations

are definitely measured. But often we come across situations when definite

measurements on the variables are not possible. For example, if a group of n

students is arranged in order of merit or proficiency in Business Statistics and

Economics without any attempt to asses numerically assigning to each student

a number which indicates his position in that group; the students are then said
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to be ranked and the number of a particular student is his rank. In such type of

situations Spearman’s Coefficient of rank correlation is determined.

Spearman suggested that the relationship between two ranks may be studied by

calculating the Pearson’s Coefficient of Correlation for numerical values that happens

to rank. The Spearman’s Ccoefficient of Rank Correlation, denoted by a Greek

letter  (rho), is given by

 = 1–  2

2

6 D

1n n




where

D = difference between paired ranks, i.e.

Di = R
xi
–R

yi

R
xi
 = rank of ith individual of variable X

R
yi
 = rank of ith individual of variable Y

n = the number of items ranked

Remarks :

1. In fact, the coefficient of rank correlation, is nothing but Karl Pearson’s

coefficient of correlation between two sets of ranks.

2. In view of remark 1, its value lies between –1 and +1.

3. The value  = +1 stands for a perfect positive agreement between two sets

of ranks, while  = –1 implies a perfect negative relationship.

4. The basic assumption in this correlation is that no two individuals be equal

in either classification so that no ties in ranks exists.

Example 5. In a beauty contest two judges rank the 10 entries as follows :

Contestant : A B C D E F G H I J

Judge I    : 1 2 3 4 5 6 7 8 9 10

Judge II   : 2 3 1 6 4 5 8 7 10 9

Find the degree of agreement between ranks given by two judges.

Solution : In order to find the degree of agreement between ranks, we find the
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coefficient of rank correlation.

Computation of Rank Correlation

Contestant Rank by Rank by D = R
1
–R

2
D2

Judge I Judge II

A 1 2 –1 1

B 2 3 –1 1

C 3 1 2 4

D 4 6 –2 4

E 5 4 1 1

F 6 5 1 1

G 7 8 –1 1

H 8 7 1 1

I 9 10 –1 1

J 10 9 1 1

Total 16

Thus, rank correlation is given by

 = 1–  2

2

6 D

1n n


  = 1–  6 16

10 100 1




= 1–
96

990
 = 

894

990
 = 0.903

Thus,  = 0.903 shows a high degree of agreement between ranks given by

two judges.

Example 6. Calculate rank correlation coefficient from the following marks given

out of 200 by two judges X and Y in a music competition to 8 participants :
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Participant No        : 1, 2, 3, 4, 5, 6, 7, 8

Marks awarded by X : 74, 98, 110, 70, 65, 85, 88, 59

Marks awarded by Y : 121, 133, 170, 102, 90, 152, 160, 85

Solution : To determine rank correlation we first assign ranks to marks awarded

by judge X and Y by allotting the first rank to the highest marks, second rank to

next highest marks, and so on. The ranks so obtained for the two judges are given

in the following table :

Participant Marks Marks Rank for Rank for D = R
1
–R

2
D2

No. by X by Y Marks X Marks Y

R
1

R
2

1 74 121 5 5 0 0

2 98 133 2 4 –2 4

3 110 170 1 1 0 0

4 70 102 6 6 0 0

5 65 90 7 7 0 0

6 85 152 4 3 1 1

7 88 160 3 2 1 1

8 59 85 8 8 0 0

Total 6

Thus, Rank correlation is

 = 1–  2

2

6 D

1n n


  = 1–  6 6

8 64 1



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= 1–
36

504
 = 

468

504
 = 0.929

which shows a high degree of positive correlation between the marks awarded by

the two judges.

Rank Correlation For Tied Ranks

In the previous section we have assumed that no two values in either series were

equal (means no tie) while discussing rank correlation. However, in some cases, we

may have two or more equal observations in either of the two series or in both the

series. In such cases, we assign average (mean) ranks to the set of tied observations.

For example, in assigning ranks to 10 observations we may note that the third

largest observation is repeating three times. These three observations (3rd, 4th and

5th) are therefore tied and each is assigned average rank 
1

3
 (3+4+5) = 4. The next

individual assigned the rank 6. If we find again a tie of two observations, we assign

the rank 
7 8

2


 = 7.5 each and the next individual is assigned rank 9.

Obviously the formula

 = 1–  2

2

6 D

1n n


 ..........(1)

cannot be used if there are ties in either one or both series. The Spearman’s

Coefficient of Rank Correlation is then corrected for these tied ranks and now given

as follows :

 = 1–
  

2 2

2

6 D 1 2

1

m m

n n

     
 .........(2)

where m be the number of tied observations with common ranks.

NOTE :- The adjustment consists of adding m(m2–1)/12 to the value D2. If

there are more than one set of tied observations, the correction factor m(m2–1)/12
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is to be added each time to the value of D2 for every value of m. This tendency

of correction has been represented by m(m2–1)/12 in formula (2).

Example 7. Calculate the coefficient of rank correlation from the following data :

Marks by

Judge I : 48 33 40 09 16 16 65 24 16 57

Judge II : 13 13 24 06 15 04 20 09 06 19

Solution :

Judge I Judge II Rank Rank D = R
1
–R

2
D2

 (X)  (Y) R
1

R
2

48 13 3 5.5 –2.5 6.25

33 13 5 5.5 –0.5 0.25

40 24 4 1 –3.0 9.00

09 06 10 8.5 1.5 2.25

16 15 8 4 4 16.00

16 04 8 10 –2 4.00

65 20 1 2 –1 1.00

24 09 6 7 –1 1.00

16 06 8 8.5 –0.5 0.25

57 19 2 3 –1 1.00

Total 41

While ranking observations of judge I i.e. X, three observations of 16 are tied at

rank 7 and, as such they are each marked the average rank of (7+8+9)/3 = 8.

Similarly the observation of Judge II i.e. Y, two observations of values 13 and 6 are

tied at rank 5th and 8th respectively. Therefore, these observations are assigned rank

(5+6)/2 = 5.5 and (8+9)/2 = 8.5 respectively. Thus, in all there are 3 tied ranks for

observation 16 of Judge I. Similarly, there are 2 tied ranks for observation 13
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and 2 for observation 6 of Judge II i.e. Y. Thus, we ha three sets of tied ranks with

m = 3, 2 and 2 respectively. Therefore, on using formula (2), Spearman’s Coefficient

of rank correlation is given by

 = 1–
  

2 2

2

6 D 1 12

1

m m

n n

     


= 1–
  6 41 3(9 1) /12 2(4 1) /12 2(4 1) /12

10 100 1

       

= 1–

1 1
6 41 2

2 2
10 99

       = 1–
258

990
 = 

732

990

= 0.739

6.8 SUMMARY

The three different method of calculating coefficient of correlation have
been discussed in this lesson. The formula for coefficient of correlation under
different methods are

r = 
  
   2 2

X X Y Y

X X Y Y

  
    (Actual Mean Method)

= 
  

   2 22 2

XY X Y

X X Y Y

n

n n

   
      (Direct Method)

= 
  

   2 22 2

n dxdy dx dy

n dx dx n dy dy

   
      (Shortcut Method)

Spearman’s Coefficient of rank correlation is given by

(a) For Untied Ranks :
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 = 1–  2

2

6 D

1n n




(b) For Tied Ranks :

 = 1–
 

 
2 2

2

1
6 D · 1

12

1

m m

n n

      


6.9 GLOSSARY

 - The relationship between two variables is explained by correlation.

 -  Correlation may be simple (between two variables) multiple ( between many

variables) or partial ( between many ariables where the effect of other Variables is

neutralised and in absence the relationship of two variables is observed).

- Scatter Diagram is a graphical method to observe correlation between variables.

- The value of correlation varies between +1to -1.

6.10 ASSIGNMENTS

1. What do you understand by the terms :

(i) Bivariate distribution

(ii) Correlation

(iii) Dot diagram

2. Discuss the meaning of correlation and distinguish between positive

and negative correlations.

3. What do you mean by scatter diagram? How is scatter diagram used

to determine correlation?

4. Define Karl Pearson’s coefficient of correlation. What is it intend to

measure?

5. Give some examples of positive and negative correlations.

6. What will be your interpretation if
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(i) r = 0 (ii) r = +1 (iii) r = –1

7. Determine the correlation coefficient from the following data on using

different method. Also find P.E., S.E., and coefficient of determination.

Comment on your results.

X  : 280, 290, 290, 310, 300, 320, 330, 340

Y  : 150, 160, 150, 180, 190, 210, 200, 220

8. What is rank correlation? Discuss its merits and demerits.

9. Write short note on Spearman’s rank correlation coefficient.

10. The rank correlation coefficient between marks obtained by some

students in two subjects is 0.80. If the sum of squares of difference of

ranks is 33, then find the number of student.

11. Compute the rank correlation coefficient from the following data :

X  : 115, 109, 112, 87, 98, 87, 109, 108

Y  : 75, 74, 80, 76, 74, 70, 68, 70

12. Ten competitions in a beauty contest are ranked by three judges in the

following order.

Judge

A : 1, 6, 5, 10, 3, 2, 4, 9, 7, 8

B : 3, 5, 8, 4, 7, 10, 2, 1, 6, 9

C : 6, 4, 9, 8, 1, 2, 3, 10, 5, 7

Use Spearman’s Rank Correlation to determine which pair of judges has the

nearest approach to common tastes in beauty.

6.11 LESSON END EXERCISE

 1. Correlation is used to measure the qualitative relationship between variables.

(True / Falsa)

 2.  We call it perfectly positive correlation when the value of correlation is

a) +1 b)-1 c) 0 d) between 0 and 1

 3.  When one need to check the correlation among ranking , which technique
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     used

a)  Scatter diagram b) Karlpearson’s cofficient of correlation

c)  Spearman’s method d) Standard deviation

6.12 SUGGESTED READING

1. S.P Gupta Statistical Method

2. S.P Gupta Statistical Method

106



Course No. : SOC-C-302 Lesson No. 7

Unit - II     REGRESSION ANALYSIS—I Semester-III

 STRUCTURE

7.1 Introduction

   7.2  Objectives

7.3 Difference between Correlation and Regression

7.4 Regression Analysis and Lines of Regression

7.5 Fitting of Regression Line of Y on X

7.6 Fitting of Regression Line of X on Y

7.7 Some Properties Regression Coefficients and Lines

7.8 Standard Error of Estimates

7.9 Summary

7.10 Glossary

7.11 Assignments

7.12 Lesson End Exercise

7.1 INTRODUCTION

In the pervious lesson, we have seen that the data giving the corresponding

value of two variables can be graphically represented by a scatter diagram and

a method of finding the relationship between these two variables in terms of
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correlation coefficient were also introduced. Very often, in the study of relationship

of two variables, we come across situations where one of the two variables

depends on the other. In other words, what is the possible value of the dependent

variable when the value of the independent variable is known. In such situations,

where one of the variable is dependent and other is independent, we can find a

method of estimating the numerical relationship between two variables so that

given a value of the independent variable, we can forecast the average value of

the dependent variable. Regression analysis serves this purpose.

7.2 OBJECTIVES

The main objectives of this lesson are :–

• to introduce the concept of regression analysis and distinguish it with correlatin

coefficient

• to explain the two lines of regression

• to provide the computational procedure for determing the constants of regression

line of Y on X and X on Y.

• to explain the various important properties and applications of regression

coefficients, and

• to give an idea of standard error of estimates.

7.3 DIFFERENCE BETWEEN CORRELATION AND REGRESSION
ANALYSIS

Although the two analysis are complementary to one another, yet the choice

of one or the other depends upon the purpose of statistical enquiry. The following

are the main differences between correlation and regression analysis :

(i) The coefficient of correlation is used to measure the degree of covariation

between the two variables, while the regression analysis provides the average

relationship between these variables.

(ii) Correlation does not necessarily establishes causes and effect relationship.

However, in regression analysis, there is a clear indication of cause and effect

relationship. Here the independent variable is the cause and dependent variable

is the effect.

(iii) Whereas correlation analysis is confined only to the study of linear relationship

between two variables, the regression analysis deals with linear and non-linear
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relationships.

(iv) In correlation analysis, r
xy
 measures the linear relationship between the

variables X and Y. Here r
xy
 = r

yx
, i.e., it is immaterial which of the two

variables is taken as dependent or independent. However, in regression analysis,

the identity of variables, i.e., which is dependent and which one is independent,

is important.

7.4 REGRESSION ANALYSIS AND LINES OF REGRESSION

The word regression was first introduced by Sir Francis Galton in the study of

heredity in connection with the study of height of parents and their offsprings.

He found that the offspring of tall or short parents tend to regress to the average

height. In other words though tall fathers do tend to have tall sons, yet the

average height of sons of a group of tall feathers is less than their father’s height

and the average height of short fathers is less than the average height of their

sons. Galton termed the line describing the average relationship between the two

variables as the line of regression. Thus, by regression we mean the average

relationship between two variables which can be used for estimating the value of

one variable from the given values of other variable. However, the dictionary

meaning of regression is “Stepping Back”, but nowadays it is stand for some sort

of functional relationship between two or more variables. Here the variable whose

value is to be predicted is called dependent or explained variable and the variable

used for prediction is called independent or explanatory variable.

Lines of Regression

If the variables in a bivariate frequency distribution are correlated, we observe that

the points in a scatter diagram cluster around a straight

line, called the line of regression. In a bivariate study, we have two lines of regression,

namely, regression of Y on X and regression of X on Y.

The line of regression of Y on X is used to predict or estimate or forecast the value

of Y for the given value of the variable X. Thus, Y is the dependent variable and

X is the independent variable. The regression line of Y on X is of the form :

Y = a+bX

where a and b are unknown constants to be determined by observed data on the

two variables X and Y.
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Similarly the regression line of X on Y is used to predict the value of X for the

given value of the variable Y. Here X is dependent variable and Y is independent.

The regression line of X on Y is of the from :

X = a+bY

where a and b are unknown constants to be determined by observed data on the

two variables X and Y.

7.5 FITTING OF REGRESSION LINE OF Y ON X

Suppose the regression line of Y on X is

Y = a+bX ....(1)

where a and b are unknown constants to be determined by observed data on the

two variables X and Y.

The regression line of Y on X, given by (1) can be fitted by the Method of Least

Squares. That is, we choose the constant a and b in the regression line Y = a+bX

in such a way that 2ˆY Yi i  ....(2)

is a minimum, where ̂Yi  be the estimated value of Y for X = X
i
 i.e. Ŷi  =

a+bX
i
. Here the quantity given by (2) is called sum of squares of the residuals E

i
,

E
i
 = y

i
–Ŷi

For obtaining a and b, we minimize

E
i
2 =  2Ŷi iy 

=  2Xi iy a b    .....(3)

with respect to a and b. By using the Principle of Maxima and Minima, i.e.,

equating to zero the partial derivatives of E
i
2 w.r.t. a and b, we get

Y
i
  = na+bX

i
.....(4)

X
i
y

i
 
 
= aX

i
+bX

i
2 .....(5)

Here these two equations i.e. (4) and (5) are called normal equations. Solving these

equations simultaneously for a and b, we obtain.
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b = 
2 2

1
X Y XY

1
X X

i i

i

n

n

 
 

= 2 2

X Y XY

X X
i i

i

n

n

 
  .....(6)

and

a = Y –bX .....(7)

The values of b and a given by (6) and (7) can also be expressed in terms of

correlation coefficient. As we know that

r = 
 

X Y

Cov X,Y

· 

= 
2 2 2 2

1
X Y XY

1 1
X X Y Y

n

i i

i i

n

n

 
   

.....(8)

Thus from (6) and 8, we have

b = r
Y

X


 .....(9)

and

a = Y –r
y

x

·X

 .....(10)

Hence, on putting the values of b and a from equations (9) and (10) in regression

line of Y on X given by equation (2), we obtain the following equation of regression

line of Y on X :

111



Y = y –r



y

x

· x +r·



y

x

·x

= y +r



y

x
 X X

or

y–y  = r



y

x

·  x x .....(11)

The quantity r·



y

x

 is called the regression coefficient of Y on X and, in

general, is denoted by b
yx
. Thus

b
yx 

= r·



y

x

.

Remark

(i) We may ignore the lower suffix i from X
i
 and Y

i
 in the formula of a and

b. Thus, we may write

b = 2 2

XY XY

X X

n

n

 
  , and

a = Y Xb
(ii) If X and Y are measured from their respective means i.e.

let x = X–X  and y = Y–Y , then b is given by

b = 2

xy

x




(iii) To find the Y , X  and b
YX

 we can also use step deviation method, i.e., if

we assume that d
x
 = X–A and d

y
 = Y–B, where A and B are assumed mean

of X and Y respectively, then we have
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X  = A+
1

n
dx

Y  = B+
1

n
dy

and

b
YX

 = 
  
 22

n dxdy dx dy

n dx dx

  
  

(iv) The regression line of Y on X given by equation (1) is used to estimate

or predict the best value of Y for a given value of the variable X.

Example 1. Find the regression equation of Y on X from the following data :

X : 7 4 8 6 5

Y : 6 5 9 8 2

Also estimate the value of Y when the value of X = 12.

Solution : Let the regression line of Y on X is

Y = a+bX .....(1)

X Y XY X 2

7 6 42 49

4 5 20 16

9 8 72 64

6 8 48 36

5 2 10 25

30 30 192 190

Here X  = 
X

n


 = 

30

5
 = 6, Y  = 

30

5
 = 6,

XY = 192, and X2 = 190, thus
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b( = b
yx
) = 

2 2

1
XY XY

1
X X

n

n

 
 

=  2
192

6 6
5

190
6

5

 
  = 

2.4

2
 = 1.20

and

a = Y –bX  = 6–1.20×6

= –1.20
Thus regression equation of Y on X becomes

Y = –1.20+1.20X
and the estimated value of Y for X = 12 is

Y = –1.20+1.20×12
= –1.20+14.40
= 13.20

Example 2. Consider the following data on heights and weights of 10 adults :
Height (cm) : 178 176 170 174 165 162 178 165 174 172
Weight (kg) : 80 75 72 74 68 64 76 66 72 70

Predict the weight of an adult whose height is 185cm.
Solution : Let Y = Weight & X = Height. First we find the regression line of Y
on X

Sr. No. X Y dx = X–174 dy = Y–70 dxdy d
x
2

1 178 80 4 10 40 16
2 176 75 2 5 10 4

3 170 72 –4 2 –8 16

4 174 74 0 4 0 0

5 165 68 –9 –2 18 81

6 162 64 –12 –6 72 144
7 178 76 4 6 24 16

8 165 66 –9 –4 36 81

114



9 174 72 0 2 0 0

10 172 70 –2 0 0 4

Total –26 17 192 362

Here X  = A+
dx

n


  = 174–

26

10
 = 171.40

Y  = A+
dy

n


 = 70+

17

10
 = 71.70

b ( = b
yx
) = 

  
 22

n dxdy dx dy

n dx dx

   
  

= 
  
 2

10 192 26 17

10 362 26

  
  

= 
2362

2944
 = 0.802

Thus, regression line of Y on X is

Y–Y  = b
yx
  X X

or Y–71.70 = 0.802 (X–171.40)

Y = 0.802X–137.463+71.70

Y = –66.06+0.802X

Hence the weight (Y) of an adult, whose height (X) is 185, is given by

Y = –66.06+0.802×185 = 82.31

Example 3. Fit the equation of regression line of Y on X for the following data :
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X : 57 58 59 60 61 62 64

Y : 77 78 75 82 82 79 81

Solution :

Sr. No. X Y x = X–X y = Y–Y  2X X  X X  Y Y
= x2  = xy

1 57 77 –4 –2 16 8

2 58 78 –3 1 9 –3

3 59 75 –2 –4 4 8

4 60 81 –1 2 1 –2

5 62 82 1 3 1 3

6 65 79 4 0 16 0

7 66 81 5 2 25 10

Total 427 553 0 0 72 24

Here X  = 
X

n


 = 

427

7
 = 61, Y  = 

Y

n


 = 

553

7
 = 79

Thus

b
yx

= 2

xy

x


  = 

24

72
 = 0.333

Hence, the regression line of Y on X is

Y–Y  = b
YX  X X

or Y–79 = 0.333(X–61)

_ Y = 58.687+0.333X

7.6 FITTING OF REGRESSION LINE OF X ON Y
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 As we have discussed in section 13.4 that the regression line of X on Y

is used to estimate or predict or forecaste the value of X for a given value of the

variable Y. In this case X is called dependent variable and Y is the independent

variable. The standard form of regression line of X on Y is

X = a+ by ..... (1)

where a and b are unknown constants which are determined from the giving set of

data on X and Y.

On using the procedure of least squares method similar to that of Section 14.6,

Lesson 14, we obtained the following two normal equations :

 X = na + by ....... (2)

XY = ay + by2 ....... (3)

Simplifying the equations (2) and (3) for a and b, we obtain

22 22

1
XY XY XY XY

= =
1 Y YY Y

nnb
n

n

 


  ....... (4)

and

 =X Ya b ....... (5)

The value of b, given by (4), generally denoted by b
XY

, is called regression coefficient
of X on Y. It can also be expressed in terms of correlation coefficient (r) as

XY
XY 22

XY
= =

Y Y

x

y

n
b r

n








Hence, the regression equation of X on Y becomes

 X = X Y + Yxy xyb b
or
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 X X = Y Yxyb 
 X X = r Y Yx

y

 
 ....... (6)

Remarks :

(i) Assuming that X and Y each are measured about their means, then

2
=

xy
bxy

y
 , where =X X and =Y Yx y  .

(ii) If X and Y are each measured about their assumed mean, then

   XY 22
=

n dx dy dx dy
b

n dy dy




   
where dx= X–A, dy = Y–B, A and B are assumed means of X and Y.

7.7 SOME PROPERTIES OF REGRESSION COEFFICIENTS AND LINES

As we know that the regression line of Y on X and X on Y are  YX

XY

Y Y= X X , and

X X= Y Y ,

b

b

 
 

where Y X
YX XY

X Y

. and .b =r b =r
 
   are the regression coefficients of Y on X and

X on Y respectively. Keeping in view these lines and regression coefficients, we

now, present some following properties which are very helpful in understanding the

regression lines more clearly and to obtain some other measures.

(i) The regression lines of Y on X and X on Y both pass through the point X,Y . That is, they intersect each other at the point  X,Y .

This property help us in determining X  and Y  if regression lines are given.

(ii) If correlation coefficient, r, is zero then two regression lines are Y=Y  and
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X= X , i.e., the two regression lines are perpendicular to each other..

(iii) If r= , i.e., in case of perfect correlation, we have only one regression line

which is

Y X

Y Y X X
=± 

          
(iv) The sign of both the regression coefficients must be same.

(v) If one regression coefficient is greater than one, then other must be less than

one. That is, if b
YX
1, then b

XY
1 or if b

XY
1, then b

YX
1. However, both

may be less than one.

(vi) The geometric mean of the regression coefficients is equal to correlation

coefficient (r). That is

r = YX XYb b , but the sign of correlation coefficient is the same as that of

two regression coefficients.

(vii) The arithmetic mean of the regression coefficients must be greater than the

correlation coefficient.

(viii) Regression coefficients are not symmetrical functions in X and Y as correlation

coefficient. That is b
YX 
 b

XY
 as r

XY
 = r

YX
.

(ix) Regression lines are not mutually reversible. That is, we cannot estimate

the value of Y from the regression line of X on Y and vice-versa.

(x) Regression coefficients are independent of change of origin but not  of

scale. Symbolically if 
X A

U=
h


 and 

Y B
V= ,

k


 then

UV XY
h

b = b
k

 and VU YX
k

b = b
h

.

If h=k then b
UV

=b
XY

 and b
VU

=b
YX

.

7.8 STANDARD ERROR OF ESTIMATE

As discussed, the regression lines define an average relationship between two

(or more) variables which can be used for estimating or forecasting the value of the

dependent variable from the given values of independent variable (s). The regression
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lines are fitted to observed data by using the method of least squares. Although these

lines are used for prediction, but it is not possible to have a perfect prediction of the

values by using these lines. Thus, we need a quantitative measure which may be used

to indicate how precise the prediction. The standard error of estimate provide us a

measure of the scatter of the observations about an average line. For two regression

lines, we have two the following two standard error of estimates.

(i) If the regression line of Y on X is given by Y= a+bx, then the standard error

of estimate, denoted by S
y.x

 is given by

 
n

2

Y.X
1 ˆS = Y Y

where Ŷ  is the estimated value of Y..

S
Y.X

 can also be expressed as

S
Y.X

 = 2
Y 1 r 

(ii) If the regression line of X on Y is X = a+bY, then the standard error of

estimate, denoted by S
X.Y

, is given by 2X.Y
1 ˆS = X X
n


where X̂  is the estimated value of X.

The standard error of estimate S
X.Y

 may also be expressed in the form

2
X.Y XS = 1 r 

Example 4. The following table gives the respective weights of a sample of 12
fathers and their sons :

Weight of Fathers (ks) : 65, 63, 67, 64, 68, 62, 70, 66, 68, 67, 69, 71

Weight of Sons (ks)     : 68, 66, 68, 65, 69, 66, 68, 65, 71, 67, 68, 70

Obtain the two regression lines and the corresponding standard error. Also

find correlation coefficient.

Solution : Let X = Weight of Fathers

Y = Weight of Sons
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X Y d
X
 = X–68 d

Y
=Y–68 dx2 dy2 dxdy

65 68 –3 0 9 0 0

63 66 –5 –2 25 4 10

67 68 –1 0 1 0 0

64 65 –4 –3 16 9 12

68 69 0 1 0 1 0

62 66 –6 –2 36 4 12

70 68 2 0 4 0 0

66 65 –2 –3 4 9 6

68 71 0 3 0 9 0

67 67 –1 –1 1 1 1

69 68 1 0 1 0 0

71 70 3 2 9 4 6

Total –16 –5 106 41 47

Here 
16

X=A+ =68 =66.67
12

dx

n


5
Y=A+ =68 =67.58

12

dy

n


2 2
2

Y
1 41 5

= = =3.24
12 12

dy
dy

n n
          


 3.2431 1.80

2 2
2

X
1 106 16

= = = 7.5
12 12

dx
dx

n n
          


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= 2.7386

   YX 22
=

n dxdy dx dy
b

n dx dx




   
= 

  
 

 
  2

12× 47 16 5

12×106 16

= 
484

1016
 = 0.4764

and
   XY 22

=
n dx dy dx dy

b
n dy dy




   
  
 

  
  2

12 × 47 16 5
=

12× 41 5

= 
484

467
 = 1.0364

Thus, the regression line of Y on X is  YXY Y = X Xb 
or Y–67.58 = 0.4764 (X–66.67)

or Y = 67.58–(0.4764) (66.67) + 0.4764X

or Y = 35.818+0.4764X

Regression line of X on Y is XYX X= Y Yb 
122



or X–66.67 = 1.0364 (Y–67.58)

or X = –3.369+1.0364Y

The correlation coefficient (r) between X and Y is

YX XY = 0.4764 ×1.0364r= b .b  = 0.7027

Hence the standard error of estimates are

 22
Y.X YS = 1 =1.80 1 0.7027 =1.281r  

and  22
X.Y XS = 1 =2.7386 1 0.7027 =1.948r  

Example 2. Regression lines of two variables X and Y are

4X–5Y+33 = 0 .......(1)

20X–9Y–107 = 0 .......(2)

and variance of X is 9.

Find (i) mean values of X and Y (ii) the regression line of Y on X and X

on Y (iii) the correlation coefficient between X and Y (iv) standard deviation

of Y (v) standard error of the estimate.

Solution :

Mean of X and Y : As we know that  X, Y  is the intersecting point of the two

lines of regression, therefore it will satisfy the two lines and thus

4X 5Y = 33  .......(3)

20X 9Y =107 .......(4)

Multiplying the equation (3) by 5 and then substractors from equation (4),

we get

20X 9Y 107 
20X–25Y = –165

– +      +
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272
16Y 272 Y 17

16
   

Thus from (3)

4X 5Y 33 5 17 33 52     
or 

52
X 13

4
 

Hence X 13,andY 17 
ii Regression lines : Let the equations (1)  be the regression line of Y on X and

(2) be the X on Y. Therefore

4X–5Y+33 = 0   5Y = 33+4X

or 
33 4 4

Y X 6.5 X
5 5 5

    .....(5)

and 20X–9Y–107 = 0   20X = 107 + 9Y

or
9 107 9

X Y 5.35 Y
20 20 20

    .....(6)

Thus Here we observe that the values of b
YX

 and b
XY

 satisfy

the properties of regression coefficients explained in Section 15.4 of this

lesson. Thus equation (5) is the regression line of Y on X and (6) is the

regression line of X on Y.

Coefficient of correlation

YX XY
4 9

.
5 20

r b b 
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 0.36 = 0.60 = 0.60

Positive sign retained as both the regression coefficient are positive.

(v) As we know that

Y
YX X

X

. 3b r
   

_
4 6 6 4 3 10

. 6 4
5 10 3 5 6y

y     
(v) Standard Error of Estimates :

Standard error of estimate of Y :

2
Y.X YS 6 1 r 

 4 1 0.36

= 4×0.80

= 3.2

and, standard error of estimate of X :

S
x.y

= 6
X
 21 r

= 3×0.80

= 2.40

7.9 SUMMARY

In this lesson we have discussed the regression line of X on Y, some

properties of regression coefficients and standard error of estimates.  Some of the

important relations are :

(i) The regression line of X on Y is given by

 XYX X Y Yb  
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where
X

XY
Y

.b r



2 2

1
XY XY

1
X X

n

n







(ii) The regression on line of Y on X is given by YXY Y X Xb  
where Y

YX
X

.b r 


     22

1
XY XY

1
Y Y

n

n







(iii) The standard error of estimates.

If Y = a+bx is the line of Y on X.

2
Y.X YS 1 r 

and, if X = a+bY is the line of X on Y.

2
X.Y XS 1 r 

(iv) Relation between correlation coefficient and regression coefficients

YX XY.r b b 

and YX XY

2

b b
r

 
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7.10 GLOSSARY

- Regression is one of the most popular technique in statistics which is used tp

predict the Value of one or more Variables if the Value of other one variable is

given.

- X on Y : It means ‘X’ variable is dependent on ‘Y’ Variable

- Y on X:  It means ‘Y’ variable is dependant on ‘X’ variable

- Linear regresson is used to find the value of one dependant variable from one

independent Variable

- Multiple regressio is used to predict the value of one dependant Variable from

many independant Variables.

- Regression Cofficient shows the predicting power of independent Variables.

- Standard error of estimates denotes the amount of value that a regression model

fail to predict

7.11 ASSIGNMENTS

1. Explain the concept of regression and point out its importance in business

forecasting.

2. What do you mean by standard error of estimate? Also mention its uses.

3. Explain the regression line of X on Y. Also describe its constants  and how

would you obtain these constants.

4. For 10 observations on price (X) and supply (Y), the following data is given

2X 130, Y 220, X 2288    
2Y 5506and XY 3467  

Obtain the line of regression of Y on X and estimate the supply when the

price is 16 unit. Also find the correlation coefficient.

5. Explain the regression line of Y on X. Also describe its constants and how

would you obtain these constants.

6. From the following data on yield and rainfall, estimate the yield when the

rainfall is 22cm.
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Yield Rainfall

Mean 508.40 26.70

S.D. 36.80 4.60

Coefficient of Correlation is 0.52

7. Giving the following data

X : 20, 24, 32, 38, 45, 48, 52

Y : 17, 21, 24, 25, 28, 30, 32

Find (i)   two regression lines

(ii)   the correlation coefficient

(iii) standard errors of the estimates.

8. From the following regression lines

4x–y–35 = 0 and 9x–4–135 = 0 obtain the following :

(i) M ean values of X and Y.

(ii) Regression lines of Y on X and X on Y.

(iii) Correlation coefficient between X and Y.

(iv) Standard error of estimates.

(v) Variance of X if S.D. (Y) = 3.

7.12 LESSON END EXERCISE

1. Standard error denotes_________________

2. Dependent Variable is also called Predictor   (True/ False)

3. Independ Variable helps to predict the value of dependent Variable (True/ False)

4. In regression , there is always a cause and effect relationship (True/False)

5. _____________ is the father of  regression technique.
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Course No. : SOC-C-302 Lesson No. 8

Unit - II  ASSOCIATION OF ATTRIBUTES Semester-III

 STRUCTURE
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8.3 Notation and Terminology

8.4 Class Frequencies

8.5 Contingency Table

8.6 Relation Between Class Frequencies
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8.9 Association of Attributes

8.10 Coefficient of Association

8.11 Summary

8.12 Glossary

8.13 Assessments

8.14 Lesson End Exercise

8.11 Suggested Readings

8.1 INTRODUCTION

Literally, an attribute means a quality or characteristic. This lesson deals with

qualitative characteristics which are not amenable to quantitative measurements and

hence need slightly different statistical treatment from that of the variables. Examples

of attributes are drinking, moking, blindness, health, honesty, etc. An attribute may be

marked by its presence (possession) or absence (dispossession) in a member of given

population. That is, the qualitative characteristics such as Deafness, Blindness,

Employment, Beauty, Hair Colour, Sex etc., of an individual of universe or population
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are termed as Attributes. The attributes are not orderable into series from least to most

or vice-versa. If we observe any attribute in the population then the whole group is

divided into two complementary classes. One class contains the members who

possess the attribute and another class contains the members who do not possess the

attributes. For example, according to the attribute ‘‘Blindness’’ the people of a

particular city may be classified into two classes :

(i) The class of Blind people.

(ii) The class of non-blind people.

The classification which divides a group into two classes according to one attribute

is called classification by Dichotomy or Simple Classification. The classification

which divides a group into more than two classes according to one attribute is called

manifold classification. For example, according to the attribute ‘‘Hair-Colour’’ the

population of a city may be divided into different following classes :

(i) Fair-Haired People

(ii) Red-Haired People

(iii) Brown-Haired People

(iv) Black-Haired People

If several (more than two) attributes are noted, the process of classification may

however, be continued indefinitely. Such type classification may be called

classification as a series of dichotomies. For example, consider the two attributes

namely ‘‘Blindness and Deafness’’. The people of a particular city may be first

divided into two classes according to the attribute ‘‘Blindness’’ and then each of

these two classes may further be classified according to the attribute ‘‘Deafness’’.

And therefore, ultimately we have following four classes :

(i) The class of blind and deaf people.

(ii) The class of blind and non-deaf people.

(iii) The class of non-blind and deaf people.

(iv) The class of non-blind and non-deaf people.

8.2 OBJECTIVES

On completion of this lesson, the students will be able :

• to understand the concept of attributes,
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• to familiar with the class frequency, ultimate class frequency,

• to develop relationship between class frequencies,

• to understand the concept of consistency of data,

• to learn about independence and association of attributes, and

• to know about coefficient of association.

8.3 NOTATION AND TERMINOLOGY

For the sake of simplicity and convenience its is imperative to use certain symbols

to represent different classes and their frequencies. It is customary to use capital

letters A and B to represent the presence of the attributes and the Greek letters ()

and () to represent absence of the attributes. Thus = not A and = not B. For

example, If A represents males, then () would represent females. Similarly, if B

represents literates then would denote illiterates. The combination of the different

attributes is denoted by (AB), (A), (B) and (). Thus in this example, (AB)

would mean number of literate males and () illiterate females. The number of

observations in different classes is called, ‘‘class frequencies’’. Thus if the number

of literate male is 50, the frequency of class (AB) is 50. Class frequencies are

denoted by enclosing class notation in brackets like (AB), () etc. Thus (A)

denotes number of individuals possessing attribute A.

(AB) denotes the number of individuals possessing attributes A and B.

() denotes number of individuals, possessing attributed   and .

Any letter or combination of letters like A, AB, etc., by means of which we

specify the characters of the members of a class, may be termed as class symbol.

8.4 CLASS FREQUENCIES AND ULTIMATE CLASS FREQUENCIES

Class Frequencies : The number of observations assigned to any class is

termed for the sake of brevity the frequency of the class or the ‘‘class frequency’’.

Class frequencies are denoted by enclosing the corresponding class symbols in

brackets. Thus (B) denotes the number of B’s i.e., objects possessing attribute B.

(A) the number of A’s i.e., objects possessing attribute A but not B, and so on

for any number of attributes.

The order of a class depends upon the number of attributes specified. A
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class having one attribute is known as the class of the first order, a class having two

attributes as class of the second order, and so on. The total number of observations

denoted by the symbol N is called the frequency of the Zero order since no attributes

are specified. Thus we have

N : frequency of the zero order

(A) (B) : frequency of the first order
() ()

(AB) (B) : frequency of the second order
(A ) ()

In general, the following rules are used to determine the class frequencies:

1. with n attributes there are in all 2n positive classes.

2. with n attributes the number of classes is 3n. i.e. for one attribute, the

frequencies are 31 = 3 and for two attributes, the total frequencies are

32 = 9. They are in the order 1+4+4 = 9.

Ultimate Class Frequencies

It is cleared from above that every class frequency can be expressed in terms of

the frequencies of the highest order, i.e., of order n. Any frequency can be

analysed into highest frequencies and the process need stop only when we have

reached the frequencies of the highest order. For example, with two attributes,

(A) = (AB) + (A)
ultimate class frequnencies

() = (B) + ()

The classes specified by n attributes, i.e., those of the highest order, are termed the

ultimate class frequencies. A given data can be completely specified if only the

ultimate class frequencies are given.

The total number of classes of ultimate order is determined by the formulas 2n when

n stands for the number of attributes studied. If two attributes are studied then the

number of classes of ultimate order shall be 22 = 4.  In case three attributes are

studied then there would be 23 = 8 classes of the ultimate order.

The frequencies of the positive, negative and ultimate classes can be known from

}
}

}
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the following table which is known as contingency table.

From this table certain relationships can be described :

A 
B (AB) (B) (B)

 (A) () ()

(A) () N

(A) = (AB)+(A)

() = (B)+()

(B) = (AB)+()

() = (A)+()

N = (A)+() or N = (B) + ()

Or N = (AB)+(A)+(B)+()

From these relationships if we know any of the ultimate class frequencies and any

other three values, we an find out the frequencies of the remaining classes.

8.5 CONTINGENCY TABLE

A table which represents the classification according to the distinct classes of

two characteristics A and B is called a two-way contingency table.

Suppose the att r ibute A has m distinct classes denoted by A
1
, A

2
,......, A

m

and the attribute B has n distinct classes denoted by B
1
, B

2
, ......, B

n
. Then

there are in all m×n distinct classes (called cells) in the contingency table.

In the contingency table, the totals of various rows A
1
, A

2
....... etc. and totals

of various columns B
1
, B

2
.......... etc., give the first order frequencies and

cells have the frequencies of second order. The grand total of all frequencies

gives the total number of observations i.e. N. The contingency table can be

written as :
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Characteristic B

B
1

B
2

........... B
j

........... B
n

Total

A
1

(A
1
B

1
) (A

1
B

2
) ........... (A

1
B

j
) ........... (A

1
B

n
) (A

1
)

A
2

(A
2
B

1
) (A

2
B

2
) ........... (A

2
B

j
) ........... (A

2
B

n
) (A

2
)

     

     

A
i

(A
i
B

1
) (A

i
B

2
) ........... (A

i
B

j
) ........... (A

i
B

n
) (A

i
)

     

     

     

A
m

(A
m
B

1
) (A

m
B

2
) ........... (A

m
B

j
) ........... (A

m
B

n
) (A

m
)

Total (B
1
) (B

2
) ........... (B

j
) ........... (B

n
) N

The classification by dichotomies with two attributes A and B is generally

known as two by two contingency table. Such as with the help of 2×2

contingency table, we can find the ultimate class frequency from the positive

class frequencies with two attributes. For illustration consider the following

examples :

Attribute B  Total

A (AB) (A ) (A)

 (B) () ()

Total (B) () N

Example 1. Given

N = 300, (A) = 100, (B) = 120, (AB) =40 find the ultimate class frequencies.

Solution : Filling the given values in the table, the others are assumed by mere

addition or subtraction.

C
h

a
ra

c
te

rs
ti

c
s 

 A
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A 
B (AB) (B) (B)

40 80 120

 (A) () ()

60 120 180

(A) () N

100 200 300

Example 2. From the following data find out the missing frequencies :

(AB) = 100, (A) = 300, (N) = 1,000, (B) = 600

Solution. Putting these values in the contingency table missing frequencies

are (A)

A 
B (AB) (B) (B)

100 500 600

 (A) () ()

200 200 400

(A) () N

300 700 1,000

(B), (), () and () i.e.

(A) = (A)–(AB) = 300–100 = 200

(B) = (B)–(AB) = 600–100 = 500

() = N–(B) = 1000–600 = 400

() = ()–(A) = 400–200 = 200

() = N–(A) = 1000–300 = 700

8.6 RELATION BETWEEN CLASS FREQUENCIES

If the population is classified into two classes A and according to the

attribute A, the number of all the individuals must be equal to the number of A’s

plus number of ’s i.e.
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 N = (A)+() or () = N–(A) or (A) = N–()

Obviously, it is true for any attribute B, C etc. i.e.

 N = (B)+()

= (C)+() = .................

Similarly, the number of A’s should equal to the number of A’s that are B plus the

number of A’s that are B i.e.,

(A) = (AB)+(A)

Similarly, we have

() = (B)+()

 N = (AB)+(A)+(B)+()

In the same way, we have

(AB) = (ABC)+(AB  )

(A) = (AC)+(A  )

(B) = (BC)+(B  )

() = (C)+(  )

Hence N=(ABC)+(AB )+(AC)+(A  )+(BC)+(B  )+(C)+(  )

Such relations exists for any order of class frequencies and thus we conclude that

the class frequencies of order zero can be expressed in terms of class frequencies

of order one, of order one in terms of order two and so on unless ultimate classes

are used. It means that any class frequency can be expressed in terms of higher class

frequency or every possible class frequency can be expressed as the sum of the

ultimate class frequencies.

Example 3. Express non-positive class frequencies in terms of positive class

frequencies in case of two attributes.

Solution : Writing

(A) = N.A and

() = .N
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We have (A)+() = AN+N

or N = (A+)N

or A+ = 1 or = 1–A

or A = 1–
Obviously, it is also true for any other attribute.

(i)Now let us consider two attributes A and B, then we have

(A) = AN = A(1–B)N = AN–ABN

= (A)–(AB)

(B) = NB

= (1–A)BN = NB–ABN = (B)–(AB)

() = N

= (1–A)(1–B)N

= (1–A–B+AB)N = 1·N–A·N–B·N+AB·N

= N–(A)–(B)+(AB)

Example 4. From the following data find out missing frequencies :

N=1500,   (A)=383,   ()=1140  and  ()=792

Solution. Putting these values in the following contingency table; the

A  Total

B (AB)= (B)= (B)=

35 325 360

 (A)= ()= ()=

348 792 1140

Total (A)= ()= N=

383 1117 1500

Others are :

() = N–()=1500–1140=360
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() = N–(A)=1500–383=1117

(AB) = ()–() = 1140–792=348

(A) = (A)–(A)=383–348=35

() = ()–()=1117–792=325

8.7 CONSISTENCY OF DATA

In order to find out whether the given data are consistent or not we have to apply

a very simple test. The test is to find out whether any one

or more of the ultimate class frequencies is negative or not. If none of the class-

frequencies is negative we can safely calculate that the given data are consistent (i.e.,

the frequencies do not conflict in any way with each other). On the other hand, if

any of the ultimate class frequencies comes out to be negative the given data are

inconsistent. Thus   the necessary and sufficient condition for the consistency of a set

of independent class frequencies is that no ultimate class frequency is negative.

Example 6. From the following two cases find out whether the data are consistent

or not

Case–I : (A) = 100, (B) = 150, (AB) = 60, N = 500

Case–II : (A) = 100, (B) = 150 (AB) = 140, N = 500

Solution : Case – I A 
B (AB) (B) (B)

60 150

 (A) () ()

(A) () N

100 500

We are given

(A) = 100, (B) = 150, (AB) = 60, N = 500

Substitute all these values in the table, then from the table

(A) = (A)–(AB) = 100–60 = 40

(B) = (B)–(AB) = 150–60 = 90

() = ()–(B) = 400–90 = 310
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Since all the ultimate class frequencies are positive we conclude that the

given data are consistent.

Case–II :

Given values are

(A) = 100, (B) = 150, (AB) = 140, (N) = 500

By putting these values in the nine-square table we can determine the missing

value :

A 
B (AB) (B) (B)

140 10 150

 (A) () ()

–40 390 350

(A) () N

100 400 500

From the table

(A) = (A)–(AB)

= 100–140 = –40

(B) = (B)–(AB)

= 150–140 = 10

() = ()–(B)

= 400–10 = 390

Thus one of the ultimate class frequencies i.e., (A) is negative and hence

the given data are inconsistent.

8.8 INDEPENDENCE OF ATTRIBUTES

Two attributes A and B are said to be Independent if there exists no relationship

of any kind between them and we may except to find the same proportion of A’s

among B’s as amongst ’s i.e.,
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..... (1)

(AB) 
= 

 (A)
..... (1)

 (B)   ()

For example

(i) If A denotes ‘‘proficiency in Statistics’’ and  denotes ‘‘proficiency in

cooking’’ then we naturally expect that proportion of ‘‘cooks among A and

should be equal i.e.,

(AB) 
= 

 ()

 (A)   ()

(ii) If we consider that there is no relationship between sex of the newly

born child and the waxing of the moon, we may anticipate that the

proportion of male births (A) amongst the total births when the moon

is waxing (B) should be equal to the proportion of male-births amongst

the total births when the moon is not waxing ().

(iii) Suppose  N = 100, (A) = 60, (B) = 40 and (AB) = 24 where A denotes

‘intelligence’ and B denotes ‘richness’ then proportion of intelligent people

amongst the rich is equal to

AB

B
 24

40

3

5

and proportion of intelligent people amongst the non-rich is

A (A) AB

N B


  

  
  60 24

100 40

36

60

3

5

Hence we note that the two proportions are equal which indicates that

intelligence does not have any relation with richness and the two qualities

are independent.

(iv) Similarly if blindness and deafness has nothing to do with one another, the

proportion  of blind people amongst the deafs and amongst the non-deafs

must be equal.
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8.9 ASSOCIATION OF ATTRIBUTES

If the criterion of Independence 
AB

B

A 
  holds true then the following criterion

:

(i)The proportion of ’s is the same in B’s as in ,

i.e.
 


B

B
 ..... (1)

(ii)The proportion of B’s is the same in A’s as in ’s

i.e.
AB

A

B 
 ..... (2)

(iii)The proportion of ’s is the same in A’s as in ’s

i.e.
A

A

 
 ..... (3)

(iv)The proportion of A’s is the same in B’s as in N

i.e.
A B

B

A

N
 ..... (4)

This relation may also be expressed in any of the following forms :

A B

A

B

N
 ..... (5)

or (AB) = ..... (6)

or
(AB)

N
 (A)

N
X

(B)

N
  ..... (7)

(v)The proportion of A’s is the same in ’s as in the population at large

i.e.
(A (A)

N

)

  ..... (8)

(vi)The proportion of ’s is the same in ’s as in N
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i.e.
( )
( )

( )
N

..... (9)

(vii)The proportion of ’s is the same in B’s as in N

( )B)

(B) N
 ..... (10)

(viii) (AB)( ) = (B)(A) ..... (11)

or
(A   ) B

B)

(A  )

(


( ) 
which means, in words, the ratio of A’s to ’s amongst B’s is equal

to the ratio of A’s to ’s amongst the ’s

Similarly 
(A  ) B B

( )  ( )
( )   means the ratio of B’s to ’s amongst A’s is equal

to the ratio of B’s to ’s amongst the ’s.

These relations may be understood easily with the help of the following 2×2

contingency table.

Attribute A 
B (AB) (B) (B)

 (A) () ()

(A) () N

When comparison of observed and expected frequencies method is applied, the actual

observation is compared with the expectation. If the actual observation is equal to the

expectation the attributes are said to be independent. If the actual observation is

more than the expectation, the attributes are said to be positively associated and if

the actual observation is less than the expectation, the attributes are said to be

negatively associated.

Total

Total
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Symbolically, Attributes A and B are :

(i)Independent if E(AB) = 
(A) (B)

N



(ii)Positively associated if E(AB) > 
(A) (B)

N



(iii)Negatively associated if E(AB) < 
(A) (B)

N



The same is true for attributes  and B;  and  and A and . Thus,

attributes and shall be called

(i)Independent, if () = 
( ) ( )

N

(ii)Positively associated, if ()>
( ) ( )

N
( )

and (iii) Negatively associated, if ()<
( ) ( )

N

Example 7. As from the following data find out whether attributes (i) (AB), (ii)

(A), (iii) (B) and (iv) () are independent, associated or disassociated

N = 100, (A) = 40, (B) = 80 and (AB) = 30

Solution : (i) Apply the criterion of Independence, i.e. attribute (AB) shall be

called independent if

(AB) = 
(A) (B)

N



Positively associated if (AB)>
(A) (B)

N


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and Negatively associated if (AB)<
(A) (B)

N



Expectation of (AB) = 
(A) (B)

N



Here (A) = 40, (B) = 80, N = 100

Expectation of (AB) = 
40 80

100


 = 32

A 
B (AB) (B) (B)

30 50 80

 (A) () ()

10 10 20

(A) () N

40 60 100

The actual observations [i.e., the given value of (AB), i.e. 30] is less than the

expectation and hence the attributes are disassociated or Negatively associated.

(ii)From the above table

(A) = 10, (B) = 50, () = 10, () = 60, () = 20

Attributes A and  shall be independent if

(A) = 
(A)

N

 ( )

Expectation of (A) = 
40 20

100


 = 8

Thus the actual observation [i.e., (A) = 10] is more than expectation and hence

the attributes A and are positively associated.
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(iii) Attributes and B shall be called independent if

(B) = 
( )  (B)

N

Expectation of (B) = 
( )  (B)

N
where () = 60, (B) = 80 and N = 100

= 
60 80

100


 = 48

Thus actual observation [(B) = 50] is more than the expectation and hence the
attributes are positively associated.

(iv) Attributes and  shall be called independent if

   () = 
( ) ( )

N

Expectation of () = 
( ) ( )

N
 , where () = 60, () = 20, N = 100

= 
60 20

100


 = 12

Thus actual observation [() = 10] is less then the expectation. Hence the attributes

are disassociated.

8.10 COEFFICIENT OF ASSOCIATION

The most popular method of studying association is the Yule’s Coefficient because

here not only we can determine the nature of association i.e., whether the attributes

are positively associated, negatively associated or independent, but also the degree

or extent to which the two attributes are associated. The Yule’s coefficient is denoted

by the symbol Q and is obtained by applying the following formulae :

Q = 
(AB) (A  ) B

(AB) (A  ) B

( )  ( )
( )  ( )




The value of this coefficient lies between 1. when the value of Q=+1 there is
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perfect positive association between the attributes, when Q=–1 there is perfect

negative association (or perfect disassociation) between the attributes and when the

value of Q is zero then the two attributes are independent.

The coefficients of association can be used to compare the intensity of association

between two attributes with the intensity of association between two other attributes.

Example 8. Investigate the association between eye colour of husbands and eye

colour of wives from the data given below :

Husbands with light eyes and wives with light eyes = 309

Husbands with light eyes and wives with not light eyes = 214

Husbands with not light eyes and wives with light eyes = 132

Husbands with not light eyes and wives with not light eyes = 119

Solution. Since we have to find out the association between eye colour

of husband and that of wife, one attribute we would take as A and other as B,

Let A denote husbands with light eyes

 would denote husbands with not light eyes.

Let B denote wives with light eyes.

 denote wives with not light eyes.

 the given data in terms of these symbols are :

(AB) = 309, (A) = 214, (B) = 132 and () = 119

Applying the Yule’s method :

Q= 
(AB) (A  ) B

(AB) (A  ) B

( )  ( )
( )  ( )




Substituting the above values in the formula we have

Q = 
(309)(119) (214)(132)

(309)(119) (214)(132)


  = 0.131

Thus, there is a very little association between the eye colour of husband and wife.
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Example 9. Eighty-Eight residents of an Indian City, who were interviewed

during a sample survey, are classified below according to their smoking and tea

drinking habits. Calculate the Yule’s Coefficient of association and comment on

its value.

Smokers Non-Smokers

Tea drinkers 40 33

Non-tea drinkers 3 12

Solution : Let A denote smokers

 would denote non-smokers

Let B denote tea-drinkers

 would denote non-tea drinkers.

The given  data in terms of these symbols are

(AB) i.e. Number of Smokers and tea drinkers = 40

(A) i.e. Number of smokers and non-tea drinkers = 3

(B) i.e. Number of non-smokers and tea drinkers = 33

() i.e. Number of non-smokers and non tea drinkers = 12

 Applying Yule’s method :

Q = 
(AB) (A  ) B

(AB) (A  ) B

( ) ( )
( ) ( )




Substituting the values of (AB), (A), (B) and () in the formula

Q = 
(40 12) (3 33)

(40 12) (333)

  
    = 0.658

This shows that the attributes tea drinking and smoking are positively associated.

Example 10. Prepare a 2×2 table from the following information, calculate

Yule’s Coefficient of Association and interpret the result
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N = 1500, () = 1117, (B) = 360 (AB) = 35

Solution : A 
B (AB) (B) (B)

35 325 360

 (A) () ()

348 792 1140

(A) () N

383 1117 1500

By putting the known values in the contingency table, we can find out the unknown

values.

Thus      (A) = N–() = 1500–1117 = 383

   (A) = (A)–(AB) = 383–35 = 348

Yule’s coefficient of Association

Q = 
(AB) (A  ) B

(AB) (A  ) B

( ) ( )
( ) ( )


  = 

(35 792) (348 325)

(35 792) (348325)

  
  

 Q = –0.606

Example 11. Find the association between literacy and unemployment from the

following figures :

Total adults : 10,000

Literates : 1,290

Unemployed : 1,390

Literate Unemployed : 820

Comment on the results.

Solution :

A 
B (AB) (B) (B)
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820 570 1390

 (A) () ()

470 8140 8610

(A) () N

1290 8710 10,000

Let A denotes literates

 denotes illiterates

Let B denotes Unemployed

  will denote employed

We are given

(A) = 1290, (B) = 1390

(AB) = 820, N = 10,000

Putting these value in the 2×2 contingency table and find missing frequencies.

    Q = 
(AB) (A  ) B

(AB) (A  ) B

( ) ( )
( ) ( )




= 
(820 8140) (470 570)

(820 8140) (470 570)

  
    = 0.923

There is a high degree of positive association between literacy and unemployment.

8.11 SUMMARY

In this lesson we have discussed :

Attributes : Qualitative characteristic are termed

as attributes.

Positive Attributes : The presence of attributes is called

positive attributes. Positive attributes

are denoted by the capital letters.

Such as A, B, C etc.

Negative Attributes : The absence of a particular attribute
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is called negative attribute. These

attributes are denoted by , , 
etc.

Class Frequency : The number of observations assigned

to any class is called class frequency.

Written by enclosing the class-symbols

in brackets. Such as (A), (AB) etc.

Frequency of rth order : A class specified by r attributes is

called the class of rth order and its

frequency is called rth order frequency.

Ultimate Class Frequency : The class specified by n attributes

i.e. those of the highest order, are

ultimate class frequency.

Consistency : A set of class frequencies is said to

be consistent if all its class frequencies

confirm with one another and do not

have any mutual contradiction.

Inconsistency : A set of class frequencies in which

the given class frequencies do not

confirm with another but provide

contradictory statement of any form

is called inconsistent.

Independence of Attributes :

(i) Independent if (AB) = 
(A) (B)

N



(ii) Positively associated if (AB)>
(A) (B)

N



(iii) Negatively associated if (AB)<
(A) (B)

N


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(iv) Yules Coefficient of association is

Q= 
(AB) (A  ) B

(AB) (A  ) B

( ) ( )
( ) ( )




8.12 GLOSSARY

- Attribute is a term used to indicate those items observation/data/ which is not quantified

but qualitive in nature.

- There are many features of population that need this technique rather than correlation

or regression analysis.

-Attributes usually measured as ‘present’ or ‘absent’ from the population.

- In case of attributes all capital letters of english are used as presence of attributes

where as greek letters denote the absence of an attribute e.g. A for blind   for

not blind B for female and  for non-female etc.

8.13 ASSIGNMENTS

1. Given the following ultimate class frequencies, find the frequencies of the +ve

and –ve classes and total number of observations.

(AB) = 250, (A) = 120, (B) = 200, () = 70

2. Is there any inconsistency in the data given below :

(a) N = 1000, (A) = 150, (B) = 300, (AB) = 200

(b) N = 100, (A) = 50, (B) = 60, (AB) = 20

3. Find if A and B are independent, positively associated or negatively associated

from the data given below :

(A) = 470, (B) = 620, (AB) = 320, N = 1000

4. A teacher examined 280 students in Economics and Auditing and found that

160 failed in Economics, 140 failed in Auditing and 80 failed in both the

subjects. Is there any association between failure in Economics and Auditing?

5. Show by Short cut method whether there is disassociation or positive or

negative association in the following attributes A and B.

(i) (A) = 470, (B) = 620, (AB) = 320
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(ii) (AB) = 294, () = 570, () = 380

(iii) (B) = 768, (A) = 480, (B) = 145

6. In a group of 800 students, the number of married is 320. But of 240 students

who failed, 96 belonged to the married group. Find out whether the attributes

marriage and failure are independent.

7. The male population of U.P is 250 lakhs. The number of literate males is 20

lakhs and the  total number of criminals is 26 thousand. The number of literate

male criminals is 2 thousand. Do you find any association between literacy

and criminality.

8.14 LESSON END EXERCISE

 1.  if A denotes blind then  denotes ___________

 2. Association Attributes is qualitative technique to find the presence or absence

of qualities in data (True/ Falsa)

3.   Ultimate class frequencies are:-

   a)  Highest order class frequencies.

   b) Maximum number of frequencies

   c) Minimum nuber of class frequencies

   d) None of the these

4. The table that shows various possible combinations of two attributes is known

as ________________  table.

5. A=

a)  (AB)+(A) b) ( ) +(AB)

c) (A+B) d) (AB) (A
8.15 SUGGESTED READING

1. S.P. Gupta :Statistical Methods

2. S.C. Gupta : Fundamental of statistics
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9.1 INTRODUCTION

In the last few chapters various quantitative and qualitative techniques of statistics

has been discussed. In this chapter we will discuss the concept of sampling and

various techniques of sampling. Sampling is backbone of any statistical research

study. Because the quality of information in handle purely depends upon the
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appropriate sampling tevhnique. Besides sampling , census is also a data collection

technique but this technique looks little impossible to apply in all kind of reaearch

works due to various constraints.

9.2 OBJECTIVES

After going throughly this chapter . you should to able to:-

- Understand the meaning of Sampling

- Need of Sampling

- Principles of sampling

- Methods of sampling

- Limitation of Non probability Sampling

- Understand Sample size.

-

9.1 MEANING OF SAMPLING

While conducting a survey, a question is usually asked : “Should all people

be studied or only a limited number of persons drawn from the total population be

studied and then extend our findings about the sample to the entire population?

‘Population’ refers to, all those people with the characteristics which the researcher

wants to study within the context of a particular research problem.” A population

could be all students in the college, all patients in the hospital, all prisoners in the

prison, all customers in a big departmental store, all users of a particular model of

car, all households in the village, all workers in the factory, all cultivators using the

water of a particular canal in the settlement area for irrigational purposes, all victims

of a natural disaster in a particular area and so on. When the population is relatively

large and is physically not accessible, researchers survey only a sample

A sample is a portion of people drawn from a larger population. I t will be

representative of the population only if it has same basic characteristics of the

population from which it is drawn. Thus our concern in sampling is not about what

types of units (persons) will be interviewed/observed but with how many units of

what particular description and by what method should be chosen. Suppose a large

number of thefts are reported in one week in one area three kilometers long in a

city. The area consists of seven sectors, each sector consisting seven lanes,’ each
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lane having 15 houses on the front side and  15 on the back side. Thus, the city

will have 1500 households. It is planned to find out if all households in this area

will support a community watch programme in which each household would take

the responsibility for deputing one male member for performing the night-watch

duty. Have all 1500 households to be included in finding out whether the scheme

will be acceptable to the people, or only a sample of people from each of the seven

sectors will be enough to get the idea? The answer to this question, whether all

people or just a sample need to be studied in a survey depends on five factors :-

1. How quickly are data needed?

2. What type of survey is planned? Will it be a telephone survey, or a self-

administered questionnaire sent by post or through an investigator or will it

be a schedule in which answers to questions one to be filled in by the

investigator himself?

3. What one the available resources? Is there money to appoint an investigator

and to get the questionnaire printed/cyclostyted? Do all people have telephone?

4. How credible will the findings be? In the above example, even if 70 to 80%

households agreed to participate in the sentative of the neighbourhood. If

only 30 to 40% wanted to participate, it would be preferable to scrap such

survey.

5. How familiar is the researcher with sampling methods?

According to Manheim, “a sample is a part of the population which is studied in

order to make inferences about the whole population.” In defining population, from

which the sample is taken, it is necessary to identify ‘target population’ and ‘Sampling

frame’. The target population is one which includes all the units for which the

information is required e.g. drug abuser students in one university, or voters in one

village/constituency and so on. In defining the population, the criteria need to be

specified for explaining cases which are included or excluded. For example, for

studying the level of awareness of rights among women in one village community,

the target population is defined as all women—married and unmarried—in the age

group of 18-50 yrs. If the unit is an institution (say a university) than the type of

its structure size as measured by the number of students in school section, college

section and in professional courses, the number of teachers and employees needs
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to be specified.

For making the target population operational, the sampling frame needs to be

constructed. This denotes the set of all cases from which the sample is actually

selected. It should be noted that sampling frame is not a sample; rather it is the

operational definition of the population that provides the basis for sampling. For

example in the above example of university, if students studying in school upto 12th

and in college upto M.A./MSc. are excluded only students of professional courses

are left out from which the sample is to be drawn. Thus, the sample frame reduces

the number of total population and gives us the target population.

Bailey has said that the experienced researcher’s always start from the top

(population and work down to bottom (sample) i.e., they get a clear picture of the

population before selecting the sample. The novice researchers, on the other hand,

often work from the bottom up. Instead of making the population, they wish to

study explicit, they select a predetermined number of conveniently available cases

and assume that the sample corresponds to the population under study. For example,

in exit polls, seeking randomly the opinion of the voters as to whom they voted,

soon after their casting the votes in a few selected constituencies in selected cities

and villages cannot be representatives of all voters. No wonder, the predictions of

such exit polls do not come true.

9.4 PURPOSES OF SAMPLING

A large population cannot be studied in its entirety for reasons of size, time,

cost or inaccessibility. Limited time, lack of large amount of funds and population

scattered in a very wide geographical area often make sampling necessary. Sarantakos

has pointed out the following purposes of sampling :-

1. Population in many cases may be so large and scattered that a complete

coverage may not be possible. Suppose, the Maruti Udyog Co. wished to find

out the reactions of purchasers of five-seater and eight-seater Maruti vans.

For this thousands of van purchasers would have to be contacted in different

cities. Some of these would even be inaccessible and it would be impossible to

contact all the van purchasers within a short time.

2. It offers a high degree of accuracy because it deals with a small number of
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persons. Most of us have had blood samples taken, sometimes from the

fingers and sometimes from the arm or another part of the body. The

assumption is that the blood is sufficiently similar throughout the body and

the characteristics of the blood are determined on the basis of sample.

Singleton and Straits have also said that studying all cases will describe

population less accurately than a small sample.

3. In a short period of time valid and comparable results can be obtained. A

lengthy period of data collection generally renders some data obsolete by

the time the information is completely in hands.

For example, collecting information on the attitudes of the military personnels

about non-availability of vehicles to be used in a very cold areas during the

Kargil War, or Voter’s performances during election period, or demanding

action against police persons in a lockup blind. Besides, opinions expressed

at the time of incidence and those expressed after a few months are bound

to be different. The findings are thus bound to be influenced if long period

is involved in data collection i.e., not taking a small sample but studying the

entire population.

4. Sampling is less demanding in terms of requirements of investigators since

it requires a small portion of the target population.

5. It is economical since it contains fewer people. Large population would

involve employing a large number of interviewers which will increase the

total cost of the survey.

6. Many research projects, particularly those is quality control testing require

the destruction of the items being tested. If the manufacturer of electric bulbs

wishes to find out whether each bulb met a specific standard, there would

be no product left after the testing.

One important objective of sampling is to draw inference about the universe

which is unknown from the unit which is observed or measured. Such inferring

generalisation made in Sociology is called ‘Sociological inference’ while one made

in Statistics is called ‘statistical inference’. Generalisations based on statistical inference

always are probability statements and are never statements of absolute certainty.

Sociological inference may be either valid or invalid. It may involve either deduction
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or induction. Induction is generalisation from individual or specific instance to

general principle. Deduction is generalisation from general principles to specific or

particular instances. In this process, the generalisation is from sample to universe.

Two other purposes of sampling may also be specified here :-

(a)seeking representativeness and thereby studying a small population instead of

very large population.

(b)analysing data where (i) cross-tabulation is required (ii) certain variables are to

be controlled and (iii) phenomenon is to be observed under certain specific conditions.

9.5 PRINCIPLES OF SAMPLING

The main principle behind sampling is that we seek knowledge about the

total units (population) by observing a few units (sample) and extend our inferrence

about the sample to the entire population. For purchasing a bad of wheat, if we take

out a small sample from the middle of the bag with a cutter, it will give us the

inferrence whether the wheat in the bag is good or not. But it is not necessary that

study of sample will always give us the correct picture of the total population. If

in a class of 100 students we take out any five students at random and per chance

find that all the 5 students are third divisioners, it would not mean that all remaining

students in the class will be third divisioners. If few people in a village are found

in favour of family planning, it would not mean that all people in the village will

necessarily have the same opinion. The opinion may vary in terms of religion,

educational level, age, economic status and such other factors. The wrong inferrence

is drawn or generalisation is made from the study of few persons because they

constitute inadequate sample of the total population.

The study of sample becomes necessary because study of a very large population

would require a long period of time, a large number of interviewers, a large amount

of money, and doubtful accuracy of data collected by numerous investigators. The

planning of observation/study with a sample is more manageable.

The important principles of sampling are :-

1.Sample units must be chosen in a systematic and objective manner.

2.Sample units must be independent of each other.

3.Sample units must be clearly defined and easily identifiable.
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4. Same units of sample should be used throughout the study.

5. The selection process should be based on sound criteria and should avoid

errors, bias and distortions.

Advantages of Sampling. The advantages of sampling are :-

1. It is not possible to study large number of people scattered in wide geographical

area. Sampling will reduce their number.

2. It saves time and money.

3. If saves destruction of units.

4. It increases accuracy of data (having control on the small number of subjects).

5. It achieves greater response rate.

6. It achieves greater cooperation from respondents.

7. It is easy to supervise few interviewers in the sample but difficult to supervise

a very large number of interviewers in the study of total population.

8. The researcher can keep a low profile.

9.6 METHOD OF SAMPLING

There are basically two types of sampling.

Probability sampling and Non-probability sampling. Probability sampling

is one in which every unit of the population has an equal probability of

being selected for the sample. It offers a high degree of representativeness.

However, this method is expensive, time consuming and relatively complicated

since it requires a large sample size and the units selected are usually widely

scattered. Non-probability sampling makes no claim for representativeness,

as every unit does not get the chance of being selected. It is the researcher

who decides which sample units should be chosen.

9.6.1 Probability Sampling

Probability sampling today remains the primary method for selecting large,

representative samples for social science and business researches. According to

Black and Champion, the probability sampling requires following conditions to be

satisfied :
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1. Complete list of subjects to be studied is available;

2. Size of the universe must be known;

3. Desired sample size must be specified, and

4. Each element must have an equal chance of being selected.

The six forms of probability sampling are :

Simple random, Stratified random, Systematic (or interval), Cluster, Multi-

Stage and Multi-phase.

9.4.2 Non-Probability Sampling :

In many research situations, partunlarly those where there is no list of persons

to be studied (e.g., wife battering, widows, Maruti car owners, consumers of a

particular type of detergent powder, alcoholics, students and teachers who cut classes

frequently, migrant workers and so on), probability sampling is difficult and

inappropriate to use. In such researches, non-probability sampling is the most

appropriate one.

Non-probability sampling procedures do not employ the rules of probability

theory, do not claim representativeness and are usually for qualitative exploratory

analysis. The five types of non-probability sampling are : convenience, purposive,

quota, snowball and volunteer.

Sampling

Probability Non-Probability

Simple random

Stratified random

Systematic (Interval)

Cluster

Multistage

Multiphase

Convenience

Purposive

Quota

Snowball

Volunteer
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9.4.3 Different types of Probability Sampling

I.  Simple Random Sampling :

In this sampling, the sample units are selected by means of a number

of methods like lottery method, pricking blind foldedly, Tappet’s tables, computer,

personal identification (PIN) or by first letter.

(a) Lottery Method :

This method involves three steps. First step is constructing the sampling

frame, i.e. a list of the units of the target population, e.g. students’ list, the electoral

role in alphabetical order and numbered accordingly second step is writing numbers

listed in the sampling frame on small pieces of paper and placing these papers in

some vessel/jar etc. Third step is mixing all papers well and taking out one piece

of paper from the jar. This process is continued until the required number of

respondents is reached. For example, 100 houses are to be allotted to applicants out

of 2,500 houses constructed. Here 2,500 pieces of papers numbered from 1 to

2,500 are put in a drum and mixed and some eminent person or some child is

invited to take out 100 slips from the drum. If the number on the piece of paper is

535, the name on the list that corresponds to that number is identified and recorded.

Thus, 100 numbers selected will be allottees of houses.

(b)Tippet’s table or random numbers method :

Tippet has prepared a table of random numbers (of one to five digits each).

These numbers are available in various forms, sizes and number combinations in

the appendix of the texts on statistics. To understand this lets take an example—

Two hundred teachers employed by seven English medium pre-primary schools in

the city apply for attending a two day seminar. The sponsors, however, only had

money to pay for 30 participants. The seminar director, therefore, assigned each

applicant a number from 001 to 200,

using a table of random number that he found  in  a statistics text-book. He selected

30 names by moving down columns of 3 digit random numbers and taking the first

30 numbers within the range of 001 to 200. The director decided that this method

was easier than picking up number from the urn.

The advantages of Simple Random Sampling are :-
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1. All elements have equal chance of being included.

2. It is the simptest of all sampling methods and easiest to conduct.

3. This method can be used in conjunction with other methods in probability

sampling.

4. Researcher does not need to know the composition of the population before

hand i.e. he requires minimum knowledge of population in advance.

5. Degree of sampling error is low.

6. Most statistical text books have easy to use tables for drawing a random

sample.

The disadvantages of Simple Random Sampling are :-

1.It does not make use of knowledge of  population which researcher may have.

2.It produces greater errors in the results than do other sampling methods.

3.It cannot be used if the researcher wants to break respondents into sub-groups or

strata for comparison purpose.

(b)Stratified Random Sampling :

This is the form of sampling in which the population is divided into a number of

strata or sub-groups and a sample is drawn from each stratum. These sub-samples

make up the final sample of the study. It is defined as “the method involving

dividing the population in homogeneous strata and then selecting simple random

samples from each of the stratum.” The division of the population into homo-

geneous strata is based on one or more criteria, e.g. sex, age, class,  educational

level, residential background, family type, religion, occupation and so on. Stratification

does not involve ranking.

There are two types of stratified sampling (i) proportionate and (ii) dispropostionate.

The former is one in which the sample unit is proportionate to the size of the

sampling unit, while the latter is one in which the sample unit is not related to the

units of the target population. Here is an example : Suppose population of 1,000

persons is stratified in five groups on the basis of religion and each group consists

of the following number of persons : Hindu– 500, Jain-200, Sikh–150, Muslim–

100 and others–50.
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Proportionate sample would be :

5 –4 –3             2   –       1

1 2 3 4 10 =   20

Disproportionate sample would be :

5 – 4 – 3 – 2 – 1

4 4 4 4 4 =   20
As a general rule, it is wise to use proportionate stratified sample.

The advantages of stratified random sampling are :

• Sample chosen can represent various groups and patterns of characteristics
in the desired proportions.

• It can be used for comparing sub-categories.

• It can be more precise than simple random sampling.

The disadvantages of stratified random sampling are :-

• It requires more efforts than simple random sampling.

• It needs a larger sample size than simple random sample to produce statistically
meaningful results because each strata must have at least 20 persons
to make statistical comparisons meaningful.

(c)Systematic (or Interval) Sampling :

This sampling is obtaining a collection of elements by drawing every nth

person from a pre-determined list of persons. In simple words, it is randomly
selecting the first respondent and then every nth person after that, ‘n’ is a number
termed as sampling interval.

When the sampling fraction method is employed, samples one drawn from a sampling

frame on the basis of the sampling fraction that is equal to N
n

 , where N is the

member of units in the target population and ‘n’ the number of units of the sample.

Systematic sampling differs from simple random sampling in that in the

latter, the selections are independent of each other; in the former the selection of
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sample units in dependent on the selection of a previous one.

The advantages of systematic sampling are :-

• It is easy and simple to use  :

• It is rapid method and eliminates several steps otherwise taken in probability

        sampling, and

• Mistakes in drawing elements are relatively unimportant.

The disadvantages of this sampling are :-

• I t ignores all persons between two nth number with the result that the

possibility of over representation and under representation of several groups

is greater.

• Since each element has no chance of being selected, it is not probability

random sampling as has been pointed out by Black and Champion.

(d) Cluster Sampling :

This sampling implies dividing population into clusters and drawing  random

sample either from all clusters or selected clusters. This method is used when

(a) cluster criteria are significant for the study, and

(b) economic considerations are significant. Initial dusters are called primary

sampling units; dusters within the primary clusters are called secondary sampling

units; and clusters with in the secondary clusters are called multi-stage clusters.

When clusters are geographic units, it is called area sampling. For example, dividing

one city into various wards, each ward into areas, each area into each neighbourhoods

and each neighbourhood into lanes.

We can take an example of a hospital. The issue is to ascertain the problems faced

by doctors, patients and visitors in different units and to introduce some reformative

programmes. Administratively, it will not be viable to call all doctors from all units

nor a large number of patients admitted in different units like cardiology, neurology,

orthopaedic and so on. Treating each unit as a cluster, randomly selected doctors

and patients— say two doctors and three patients or about 50 people all together—

from all units may be invited for discussions.

The advantages of cluster sampling are :-

• it is much easier to apply this sample when large populations are

164



studied on when large geographical area is studied.

• Cost in this method is much less than in other methods of sampling.

• Respondents can be readily substituted for other respondents.

• Flexibility is possible.

• Characteristics of clusters can be estimated.

• It is administratively simple since no identification of individuals is

necessary, and

• It can be used when it is inconvenient or unethical to randomly select

individuals.

Thus disadvantages of this sampling are :-

• Each cluster is not of equal size in selection of one district from one

state, or one village from one block. The district or the village can be

small, intermediate or large sized.

• Sampling error is greater

• Same individual can belong to two clusters and studied twice.

• It lacks representation; and

• There could be homogeneity in one cluster but heterogeneity in other.
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(e) Multi-Stage Sampling :–

In this method, sampling is selected in various stages but only the last

sample of subjects is studied. For example, for studying the Panchayat system in

villages, India is divided into zones (four zones), one state is selected from each

zone, one district is selected from each state, one block is selected from each district

and three villages are selected from each block. This will help in comparing the

functioning of Panchayats in different parts of India. Sampling in each stage will

be random but it can also be deliberate or purposive. Thus, multi stage sampling

according to Ackoff can be combination of (i) simple+simple sampling (ii)

simple+systematic (interval) sampling, and (iii) systematic+Systematic sampling.

Let us take an example. Suppose bank employees are to be studied in one

city for assessing their views on introducing reforms in banks, including use of

computers. The names of all managers, accountants and senior clerks in all banks

will be typed in the first stage. Suppose these names are typed in 100 pages, each

page containing 20 names alphabetically. Out of 2,000 bank personnel, we have to

take out a sample of 50 persons. We can do this first by taking out every tenth page

(out of 100 pages) i.e., 10 pages, and from each page, we take out every fourth

name (i.e., five bank employees from one page). This will be the example of

systematic plus systematic sample. The alternative is : take first 10 pages and select

any one page at random. In this way, select 10 pages out of 100 pages. From each

page select any five names at random. This will be simple plus simple random

sampling. The main advantage in this sampling will be that it will be more
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representative. other advantage is that in all cases, complete listing of population is

not necessary. This saves cost.

(e) Multi-Phase Sampling :

The process in this type of sampling is same as in multi-stage sampling i.e.,

primary selection, secondary selection and so on. However, in a multiphaSe sampling

procedure, each sample is adequately studied before another sample is drawn from

it. Consequently, while in multi-stage sampling, only the final sample is studied, in

multi-phase sampling, all samples are researched. This offers an advantage over

other methods because the information gartered at each phase helps the researcher

to choose a more relevant and more representative sample. We can take an example.

We are interested in studying MBA students in one city. Suppose there are five

institutions imparting MBA education and in each institution there are 30 students.

Thus, firstly the sampling frame of MBA students in five institutions will be

constructed. These respondents will be studied with regard to their academic

background, whether they are first or second divisioners. Of these 150 students, 50

will be selected randomly : After selecting these 50 students, 25 girls and 25 boys

will be chosen. This sample will be the final sample for the study.

9.4.4  TYPES OF NON-PROBABILITY SAMPLING :

As stated in the earlier lesson, sampling is mainly of two types— Probability

and Non-Probability Sampling. We have already understood probability sampling

and its types in detail. In this chapter, we will make an attempt to understand Non-

probability sampling and its various forms. The five types of non-probability sampling

include : convenience, purposive, quota, showball and volunteer.

PURPOSIVE 

SNOWBALL
NON-PROBA 
BILITY 
SAMPLING

QUOTA

CONVENIENCE 

V
O
L
U
N
T
E
E
R
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(a)Convenience Sampling :

This is also known as ‘accidental’ or ‘haphazard’ sampling. In this sampling, the

researcher studies all those persons who are most conveniently available or who

accidentally come in his contact during a certain period of time in the research. For

example, the research engaged in the study of university student might visit the

university canteen, library, some departments, playgrounds, verandahs and interview

certain number of students. Another example is of election study. During election

times, media personnel often present man-on-the street interviews that are presumed

to reflect public opinion. In such sampling, representativeness is not significant.

The most obvious advantage of convenience sample is that it is quick and economical.

But it may be a very biased sample. The possible source of bias could  be

1.The respondents may have a vested interest to serve in cooperating   with the

  interviews, and

2. The respondents may be those who are vocal and want to brag

Convenience samples are best utlilised for exploratory research when additional

research will subsequently be conducted with a probability sample.

(b)  Purposive Sampling

In this sampling, which is also known as judgemental sampling, the researcher

purposely chooses persons who, in his judgement about same appropriate

characteristic required of the sample members, are thought to be relevant to the

research topic and are easily available to him. For example, the researcher wants to

study beggars. He knows the three areas in the city where the beggars are found

in abundance. He will visit only these three areas and interview beggars of his

choice and convenience. The manufacturers (of cosmetics, oils garments, etc) select

test market cities because they are viewed as typical cities with demographic profiles

closely matching the national profile. Popular journals conduct surveys in selected

impetration cities to assess the popularity of politicians and political parties or to

forcost election results. Thus, in this technique, some variables  are given importance

and it represnts the unvense but the selection of units is delibesate and based on

prior judgement.
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(c)Quota Sampling

This is a version stratified sampling with the difference that instead of dividing the

population into strata and randomly choosing the respondents, it works on quotas

fixed  by the researcher. In the example of studying 50 MBA students from 150

students in five institutions, the researcher fixes the quota of 10 students from each

institution, out of which five will be boys and five girls. The choice of the respondents

is left to the interviewer. Determining quotas depends on a number of factors related

to the nature and type of research. For  instance, the researcher might decide  to

interview three boys out of five boys from final year and two from previous year,

or two studying the morning course and three studying the evening course.

Quota can also be fixed according to their  proportion in the entire population.

For instance, for studying the attitudes of persons towards use of loudspeakers in

religious places in one educational institution with 100 males and 50 females

belonging to different  religions, quota can be fixed in the ratio of one female for

every two males.

Further quota may be fixed on the basis  of number of persons in each of

the three religious groups.

Males Females

Hindu Muslim Others Hindu Muslim Others

80 10 10 35 10 5

16 2 2 7 2 1

————————— —————————

 
20 10

The advantages of quota sampling are :

1.It is less costly than other techniques.

2.It does not require sampling frames.

3.It is relatively effective.

4.It can be completed in a very short period of time.

It disadvantages are :
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1.It is not representative.

2.It has interviewer’s bias in the selection.

3.Estimating sampling error is not possible.

4.Strict control of fieldwork is difficult (instead of 25 only 20 respondents may

be available.)

(b)Snowball Sampling :

In this technique, the researcher begins the research with the few respondents who

are known and are available to him. Subsequently, these respondents give other

names who meet the criteria of research, who in turn give more new names. This

process is continued until, adequate, number of persons and interviewed a until no

more respondents are discovered. For instance, in studying wife battering, the

researcher may first interview those cases when he knows, who may later on give

additional names, and who in turn may give still more names. This method is

employed when the target population is unknown or when it is difficult to approach

the respondents in any other way. Reduced sample sizes and costs are a clear

advantage of snowball sampling. Bias enters because a person known to someone

has a higher probability of being similar to first person. If there are major differences

between those who are widely known by others and those who are not, there may

be serious problems with snowball sampling.

(e)Volunteer Sampling :

This is the technique in which the respondent himself volunteers to give information

he holds.

9.7 BIAS IN SELECTING INFORMANTS IN NON-PROBABILITY
SAMPLING

The success of the research is dependent on the ‘rich’ information given by

the respondents. Many a time, the leading informants selected by the researchers are

those who do not have much and appropriate information on the topic  under study

and who are unwilling to cooperate and respond. The researcher’s bias in selecting

the leading subjects is evident in the following cases :

1. The researcher has no knowledge or little knowledge of the social setting
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of the  research. For example, the researcher who wants to study informal social

networks in a village or a factory or a university etc., has to locate individuals

who could  understand what he was looking for and help him in finding it.

With little or no knowledge of the situation/location of research, the researcher

cannot find such potential informants who have a wider range of interactions.

2. The informants do not represent the population i.e., they do not have the

aggregate characteristics in the population.

3. They are not ‘typical’ in the sense that  their observations and operations

may be misleading. The atypical  or marginal informants within their group

will not provide adequate information.

4. They are unwilling to be helpful and cooperative.

5. They are activists in  a ‘particular’ group because of which they do not

present the viewpoints of ‘other groups’.

6. They belong to the community  under investigation only marginally and this

marginality is bound to bias their views.

7. Selecting informants  who are convenient for study.

8. Personal leanings of the researchers of being prejudiced against certain

types  of persons, say, untouchables, men—Hindus, shabily dressed persons,

too fashionable women, and so forth.

9.8 SAMPLE SIZE

Considerations in Sample Size

A question is often asked : how many persons should be included in the

sample, i.e., how large or small must the sample be to be representative? Some

people say, the most common size is one tenth of the total population. Some other

say that  a minimum of 100 subjects is required to allow statistical inferences.

However, these estimates are not always correct. The sample size has to be based

on the following  considerations:-

1. The size of the population, i.e, whether the total population to be studied

is very large, large or small.

2.Nature of population. i.e., whether the population is homogenous. In the former,
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a small sample may suffice but in the latter, a larger sample is required.

3. Purpose of study i.e., whether the study is descriptive, exploratory or

explanatory.

4. Whether the study is qualitative or quantitative. In qualitative studies

sampling does not resort to numerical boundaries  to determine the size of

sample. Similarly, when purposive or accidental sampling are employed; the

researcher himself, can decide the ‘sufficient’ number of respondents. In

such cases; generalisations are concerned with quality rather than with quality.

5. Accessibility of the elements : Many a time it is difficult to contact

respondents at time and place convenience to the researchers.

6. Cost of obtaining elements : With more resources, an adequate number of

investigators can be appointed and a large sample may be considered.

7. Variability required : Sometimes the respondents  require to have persons

of different groups e.g., of different age, different income, different educational

background, different occupations and so on.

8. Desired accuracy or confidence level : For high degree of accuracy, a

large sample need to be drawn. One has to think of the level at which one

will be confident that his sample is representative.

9. Sampling error or desired risk level : The minimum sample error, maximum

will be the sample’s representatives.

10. Stratification i.e, how many times the sample has to be divided during the

data analysis. This is to ensure an adequate size for each sub-division.

9.9 SUMMARY

After completely studing this lesson it is clear that sampling is the important

part of any research work as it allows us to choose represetatives items from

population to study its characteristics and then generalize it.

Now it is also clear that there are two methods of sampling i.e. probability sampling

and non probability sampling . Further the probability sampling is regareded as best
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amplig the data is baisless and every component of population has equal chance to

be selected in study sample , Further , aproper care must be taken while determining

a sample size as it must be adequate

9.10 GLOSSARY

 - Sampling is an economical way of collecting data where time , effort and money

are the constraints.

- Probability sampling is preferrable sampling technique as compared to non

probability sampling

- Sometimes mixed Sampling be also used which means using multiple methods of

probability or non probability sampling together

- A adequate sample sze must be set when Sampling technique to be applied taking

into consideration various condition.

9.11 ASSIGNMENTS

1. What is Sampling and why it is important ?

Ans________________________________________________________________

__________________________________________________________________

__________________________________________________________________

2. What are various principles of Sampling?

Ans________________________________________________________________

__________________________________________________________________

__________________________________________________________________

3. Explian various method of Sampling ? Differentiate between probability and

non probability Sampling?

Ans________________________________________________________________

__________________________________________________________________

__________________________________________________________________

4. What are various pre -requisities of determining a good sample size?
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Ans________________________________________________________________

__________________________________________________________________

__________________________________________________________________

9.12 LESSON END EXERCISE

1. Census is costly and time consuming method of data collection ( True / Falsa)

2. Snowball Sampling technique i.e.___________________technique

3. Multi phase Sampling include _______________sampling techniques

9.13 SUGGESTED READING

1. S.P Gupta : Statistical Methods

2. S.C Gupta Fundamentals of Statistics

3. Naresh Malhotra : Merketing Research
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Course  No. : 302 Procedure of Testing a Hypothesis,     Lesson No. 10

Unit - III Semester-III

 STRUCTURE

10.1 Introduction

10.2 Objectives

 10.3 Testing of Hypothesis

10.4 Procedure of Testing of Hypothesis

10.5 Summary

10.6 Glossary

10.7 Assignments

10.8 Lesson End Exercise

10.9 Suggested Readings

10.1 INTRODUCTION

In any research  Study after reviewing the existing literature, the next step is to

frame the research questions from available literature. These questions need to be

answered through a successful research study , For Supporting the Study , hypothesis

are framed which are actually suppositions need to be proved.

10.2 OBJECTIVES

After successful completion of this lesson, the students will be able to

• understand the concept of testing of hypothesis.

• learn about null hypothesis and alternative hypothesis,

• formulate the hypothesis,
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• know about the main steps in testing of hypothesis.

• know about the concept of confidence level.

10.3  TESTING OF HYPOTHESIS

Suppose we wish to infer about population mean () on the basis of sample

mean. Then there will always exist a difference between the population mean ()

and sample mean ( x ). Now the question arises whether the difference between two

means is significant or insignificant. In case, the difference is significant, we may

conclude  that the sample is not a true representative of the population and on the

contrary, insignificant difference speaks about the representativeness of the sample.

Investigations of such problems come within the scope  of testing of hypothesis.

The tests used to ascertain whether the differences are significant or non-significant

are called tests of significance or testing of hypothesis. Before discussing the certain

tests of significance let us explain the following terms which are generally use in

testing of hypothesis :

(i) Statistical Hypothesis : It may be defined as a statement about one or more

populations, i.e., statistical is a statement about one or more parameters.

(ii) Null Hypothesis : Null hypothesis is the hypothesis which is tested for

possible rejection under the assumption that it is true. Since this hypothesis states

that these is not significance defference between two values, we call it null

hypothesis. It is denoted by H
0
 (read as H not).

(iii) Alternative Hypothesis : Any hypothesis which complementary to the null

hypothesis is called an alternative hypothesis. It is denoted by H
1
. (read as H

one).

(iv) Errors in Hypothesis Testing : Two type of errors may be committeed in

accepting or rejecting Hypothesis H
0
; namely type I error and type II error

Type I error = Reject H
0
 when it is true

Type II error = Accept H
0
 when it is false.

(v) Level of Significance : Probability of rejecting H
0
 when it is true is called

the level of significance or confidence level. It is denoted by  (read as alfa).

It is also known as the size of rejection region or critical level.
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10.4 PROCEDURE OF TESTING OF HYPOTHESIS

The procedure of testing of hypothesis involve the following steps :

Step–I : Formulation of H
0
 and H

1
 : The very first step in hypothesis testing is

to formulate the null and alternative hypothesis i.e., H
0
 and H

1
.

Step–II : Selection of Test Statistic : The next step is to choose an appropriate

test criterion and its sampling distribution. Which is to be used.

Step–III : Compution of Test Statistic : In third step, we compute the value of

test statistic (as selected in Step–II) from the sample observations i.e. from the given

data under the assumption of null hypothesis. This value is called calculated or

observed value of the test statistic.

Step–IV : Selection of Suitable level of Significance : After setting H
0
 and H

1
 and

computing value of test statistic from the given sample values, our next step is test

the validity of H
0
 and H

1
 at ascertain level of significance.   The confidence with

which we reject or accept a hypothesis depends upon the significance level adopted.

The significance level is expressed as percentage (such as 1 percent 5 percent, 10

percent). I t is generary denoted by .

Step V : Choose the Critical Region : Find the rejection region at the  percent

level of signficance (it is also called tabulated value of test statistic).

Step VI : Decision Rule : Finally, we may draw condusions and take decisions.

A statistical decision is a decision either to reject H
0
 or to accept H

0
. The decision

will depend on whether the calculated value of the test statistic, as calculated in

Step-III, falls in the critical region i.e. in the rejection region. We accept our H
0
 if

the value of computed test statistic is less than or equal to tabulated value of test

statistic at a  percent level of significance. Otherwise reject H
0
.

10.5 SUMMARY

After completing the lesson successfully it is understood that hypothesis  is a

supposition needed to be proved. Statistical hypothesis is of two types namely null

hypothesis and alternative hypothesis. These are various steps involved afterchoosing

one of the types of hypothesis to come at decision rule i.e. draw some conclusion.
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10.6 GLOSSARY

- Hypotheses is a statistical suppositio need to be proved right or wrong.

- Null hypotheses assumes  no difference in actual value and assumed value or what

ever the subject may be.

- Alternative hypotheis assumes difference in  two values.

10.7 ASSIGNMENTS

1. What do you mean by hypothesis ? What are its various types.

Ans________________________________________________________________

__________________________________________________________________

__________________________________________________________________

2. What are the steps for testing hypothesis?

Ans________________________________________________________________

__________________________________________________________________

__________________________________________________________________

10.8 LESSON END EXERCISE

1. Null hypothesis is denoted by__________

2. Alternative hypothes is denoted by___________

3. Conclusions are drawn only when hypothesis proved right or wrong (True/

Falsa)

10.9 SUGGESTED READING

1. S.P Gupta : Statistical Methods

2. S.C Gupta Fundamentals of Statistics
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Course No. : SOC-C-302     Lesson No. 11

Unit - III           Tests of Significance-Student’s t-Test Semester-III

 STRUCTURE

11.1 Introduction

11.2 objectives

11.3 Test of significance

 11.4 Students T-Test

11.5 Summary

11.6 Glossary

11.7 Assignments

11.8 Lesson End Exercise

11.9 Suggested Readings

11.1 INTRODUCTION

In previous lesson we discussed the concept of hpothesis . We aslo studied the

procedure of testing hypothesis. Now in this lesson we will discuss about students

t- test which is one of the method of testing hyopthesis.

11.2 OBJECTIVES

After successful completion of this lesson you shall be able to know

-Tests of Signifiance

- Students T- test.

- Application of T- test.

11.3 TESTS OF SIGNIFICANCE

Various tests of significance can broadly be classified into following three
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heads:

(a) Test of significance for attributes.

(b) Test of significance for large samples, and

(c) Test of significance for small samples or exact tests.

11.4 STUDENT’S T–TEST
Some of the testing procedures can be used only when the samples are large. A
sample of size 30 or more is generally considered to be a large sample. When
samples are small, i.e., less than 30, the large sample results do not hold good for
small samples. That is the assumption of approximate normality of the distribution
is not true; in fact another distribution (exact distribution) of the test statistic is to
be used and the result modified accordingly. Generally the student’s. t–test, Z –test,

2 test and F test are the exact tests or small tests of interest. The present lesson
deals with student’s t–test. Student’s t–test is used to test the significance of mean,
significance of difference of two mean and significance of correlation coefficient

Z –test is also used to test the significance of correlation coefficient. We will discuss

these tests in following sections.

These tests (based on t–test) are performed under the following assumptions/

conditions:

(i)The observations must be drawn from normal population (s)

(ii)The observations must be independent.

(iii) The sample size should be small, usually not more than 30.

(iv) The parent population (s) must have the same but unknown variance.

The Student’s t–test has the following applications :

Testing the Significance of mean :

Suppose we wish to test the hypothesis regarding the mean of a population on the
basis of a random sample of size n(<30) from a population with unknown standard
deviation. In this case we set up the null hypothesis against different alternatives as

H
0
 : =

0
 against any one of H

1

H
1
 : 

0
 (two sided alternative) or

H
1
 : >

0
 (right-tailed alternative) or

H
1
 : <

0
 (left-tailed alternative)
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The test statistic for testing H
0
 is

 t =
 x¯   - µ

0
     

=
  x¯   - µ

0

         
S.E. ( x¯   )       s/n

where x  is the sample mean and s2 is an unbiased estimator of the unknown

population variance 2, which is given by

s2 =
1

1

1

1
2 2 2

n
x x

n
x nx     ( ) [ ]

The distribution of t under H
0
 is t–distribution with (n–1) degree of freedom. After

calculating t-statistic, the decision about the acceptance or rejection of H
0
 is taken

in the following manner :
(a)In case of testing H

0
 : =

0
 against H

1
 : 

0
 (two sided alternative) at  percent

level of significance, we accept H
0
 if |t|  t

n–1
(/2), otherwise reject H

0
.

(b)For testing H
0
 :=

0
 against one sided alternative at  percent level of significance

accept H
0
 if |t|t

n–1
(), otherwise, reject H

0
,

Here t
n–1

() is the critical value of t– statistic at  percent level of significance for

(n–1) degrees of freedom. These critical values are given in Table–1 of the Appendix

given at the end of the study material.

Example 1. A random sample of 10 independent observations from a normal

population provided the following results :

165, 160, 161, 170, 172, 160, 165, 175, 164, 168

(a) Test the hypothesis that the population mean is 170 against the alternative

that it is not 170 at 10 percent level of significance.

(b) Find the 90 percent confidence limits of the population mean.

Solution: We want to test the hypothesis

H
0
 : =170 against H

1
: 170

To test H
0
, we make the use of t–test

t  =
    x -      =  x - t

n-1S.E. ( x )             s/ n
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X X 2

165 27225

160 25600

161 25921

170 28900

172 29584

160 25600

165 27225

175 30625

164 26896

168 28224

Total 1660 275800

x  1660

10
166

s
n

x nx2 2 21

1
  
  1

9
275800 10(166)2

 1

9
275800 275560

= 26·67

 t     
   

166 170 4 0

1 633
2 45

26 67
10

 |t| = 2·45

For n–1=9, the tabulated value of t at 10 percent level of Significance is
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t
9 

0 10

2


=t

9
(0·05)=1·833.  Since the observed value of |t| is greater than the

tabulated value of t (1·833), hence we reject H
0
, which means that the mean of

population can not be regarded equal to 170.

(b) 95% confidence limits for mean are

x SE(X) t or x SE tn   . . . . .1 92
(005 )


(X)

or 166±1·633×1·833

or 166±2·99

or (163·01 and 168·99)

Example 2. A T.V. manufacturing company is marketing a particular type of brand
through a large number of retail shops. Before a heavy advertising campaign, the
average sales per shop per month was 120 T.V. After the compaign, a sample of
24 shops was taken and the average sales was found to be 130 with S.D. 12. Can
you consider the advertisement compaign effective at 5 percent level of significance?

Solution : Here we are given that n=24, x =130 and s=12

We wish to test

H
0
: m=120 against H

1
: m¹120

The test statistic is

t
x
s

n
   0 130 120

12
24

=4·082

For n=24, a=0·05, the critical value of t
n–1 

2
; i.e., t

23
(0·025) is 2·069. Since the

calculated value of t (4·082) is greater than the tabulated value of t(2·069) at 5
percent level of significance with 23 degrees of freedom, so we reject H

0
. Thus we

may conclude that advertisement is effective for increasing the sales of T.V.
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b ) Testing the Significance of Difference Between Two means (Independent
Samples)

Let two independent random samples of sizes n
1
 and n

2
 are drawn from two normal

populations with means m
1
 and m

2
 and unknown but equal variances i.e. s

1
2=s

2
2(=s2)

respectively. Here we may be interested in testing  the hypothesis that both the
samples come from the same normal population, i.e.,

H
0
 : m

1
=m

2
 against any one of the following alternatives

H
1
 : m

1
¹m

2
 (two sided alternative)

H
1
 : 

1
>

2
 (right-sided alternative)

H
1
 : 

1
<

2
 (left-sided alternative)

To test H
0
, the test statistic is

t
x x

n n

t

s

n n 
  1 2

1 2

2
1 1 1 2

~

where x1 and x2  are the means of first and second samples and s is given

by

s
(n s (n s

n n
   

 1 1

2

2 2

2

1 2

1) 1)

2

   
 

 (X X ) (X X )

n n
1 1

2 2
2

2

1 2 2

The decision rule about the acceptance or rejection of H
0
 is same as in previous

section.

Example 3. Two horses A and B were tested according to the time (in seconds)

to run a particular track with the following results :

Horse A : 28 30 32 33 33 29 34
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Horse B : 29 30 30 24 27 29

Test whether can you discriminate between the two horses at 5 percent level of

significance.

Solution : Let the time (in seconds), X
1
, to run a particular track by horse A is

N(
1
,

2
) and X

2
 that of horse B is N(

2
,2) where 2 is unknown. We wish to test

the hyhothesis that there is no significance difference between the performance of

two horses, i.e.,

H
0
 : 

1
=

2
 against H

1
 : 

1


2

The test statistic is

t
x x

n n

t

s

n n 
  1 2

1 2

2
1 1 1 2

~

where

x
x

n1
1 219

7
 

 = 31·286

x
x

n2
2 169

6
 

 = 28·167

x
1

x
2

x
1
2 x

2
2

28 29 784 841

30 30 900 900

32 30 1024 900

33 24 1089 576

33 27 1089 729

29 29 841 841

34 1156

Total 219 169 6883 4787
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(n
1
–1)s

1
2  =  x

1
2–n

1 x1
2 =6883–7×(31·286)2

= 6883–6851·697

= 31·30

and

(n
2
–1) s

2
2  =  x

2
2–n2 x2

2 =4787–6×(28·167)2

  = 4787–4760·279

  = 26·721

  s
(n s (n s

n n
   

 1 1

2

2 2

2

1 2 2
s

s s

n n
   

 1 1

2

2 2

2

1 2

1) 1)

2
    

 
31 30 26 721

7 6 2

 5 275 = 2·297

Thus

t  


   
 

 


x x

s
n n

1 2

1 2

1 1

31 286 28 167

2 297
1
7

1
6

3 119

1 278
 =  2·441

The tabulated value of tn n1 2 2 2    , i.e., t (0·025) is 2·201. Since the value of t

(2·441) is greater than the tabulated value of t at 5 percent level of significance with

11 degrees of freedom, so we reject H
0
. This means we can discriminate between

the two horses.

Example 4. The mean life of sample of 10 electric bulbs was found to be 14500

hours with standard deviation 420 hours. A second sample of 15 bulbs chosen from

a different batch showed a mean life of 14175 hours with S.D. of 380 hours. Is

there a significance difference between the mean life of two batches of bulbs?

Solution : Let us formulate the hypothesis

H
0
 : There is no significance between the mean life of two batches of bulbs. That
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is

H
0
 : 

1
=

2
 against H

1
 : 

1


2

The test statistic is

t = 

x x

n n
s

1 2

1 2

1 1




where (given) x1=15500, x2 =14175, s
1
=420, s

2
=380, n

1
=10 and n

2
=15

Thus

s
n s n s

n n
   

 1 1

2

2 2

2

1 2

1 1

2

( () )

  
   9 420 14380

10 15 2
156921739

2 2( ) )(

= 396·134

Hence

t  
 

 
14500 14175

396 134
1

10
1
15

325

161 721
 = 2.01

Here n
1
+n

2
–2=23 and =0·05 so  2 =0·025, thus the tabulated value of t

23
(0·025)

is 2·069. Since the observed value of t (2.01) is less than t
23

(0·025) thus we accept

H
0
. This means there is no significant difference between the mean life of two

batches of bulbs.

(c) Testing the Difference Between Two Means (Dependent Samples or
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Paired Observations)

In section 19·4, we assumed that the samples have been drawn from two normal

populations and they are independent. However, in situations where two samples

are not independent, we use paired t–test. Here the observations in the two samples

occur in pairs so that the two observations are related in respect of some characteristic.

For example, if we wish to test a new diet using on some individuals, then the

weight of the individuals recorded before and after completion of test will form two

samples in which observations will be paired. Here our hypothesis is that there is

no significance difference between the performance of before and after some test.

The test statistic is

t
d

s
n

tn ~ 1

where d  = the mean of difference of observations of two samples

s  = standard deviation of the difference of observations.

The decision whether to accept H
0
 or reject H

0
 remain same as in previous sections.

Example 5. Ten college students were given a test in Business Statistics. They
were given a month’s coaching and a second test was held at the end of coaching.
The marks recorded in both tests are :

Students : 1 2 3 4 5 6 7 8 9 10

Marks in 46 42 63 54 34 46 72 43 69 74

Test–I

Marks in 55 40 71 59 48 41 75 50 75 76

Test–II

Do the marks give evidence that the coaching is effective?

Solution :

  Marks
Students I Test II Test d=X

1
–X

2
d2

(X
1
) (X

2
)

1 46 55 –9 81
2 42 40 2 4
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3 63 71 –8 64
4 54 59 –5 25
5 34 48 –14 196
6 46 41 5 25
7 72 75 –3 9
8 43 50 –7 49
9 69 75 –6 36
10 74 76 –2 4

Total –47 493

d
d

n
    47

10
–4·70

s
n

d nd  1

1
2 2

    1

9
493 10 4 70

2( )

 30 233 = 5·498

Now let us formulate the hypothesis

H
0
 : There is no significance between the marks of students before and after

the coaching.

That is

H
0
 : 

1
=

2
 or H

0
 : 

1
–

2
=0 or

H
0
 : 

d
=0 against H

1
 : 

1
<

2
 or H

1
 : 

d
<0.

The test statistic is

t
d

s
n

    4 70
5 4981

10
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=   

4 70

1 739
 = –2·703

 |t| = 2·703

The tabulated value of t
n–1

(%), i.e. t
9
(0·05), (if =0·05) is 1·833. Since the observed

value of t (2·703) is greater than the tabulated value of t
9
 (0·05), thus we reject H

0
.

Hence, we may conclude that there is a significance difference in the marks of

students. Thus the coaching is effective.

Example 6. A certain drug was given to 12 patients and the increments in their

blood pressure were recorded to be

5, 2, 8, –1, 3, 0, –2, 1, 5, 0, 4, and 6

Is it reasonable to believe that the drug has no effect on change of blood pressure?

Solution : Suppose that increase, d, in blood pressure has a normal distribution

with mean 
d
 and unknown S.D. 

d
. Here

 H
0
 : 

d
=0 against H

1
 : 

d
<0

Patient d d2

1 5 25

2 2 4

3 8 64

4 –1 1

5 3 9

6 0 0

7 –2 4

8 1 1

9 5 25

10 0 0

11 4 16

12 6 36
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Total 31 185

Here n=12,

d
d

n
  31

12
=2·583

s
n

d nd  1

1
2 2

126    1

11
185 12 2 583

2( )

 9 54= 3.089

Hence

t
d

s
n

  2 583
3089

12
  


2 583

0 892
=2·896

The tabulated value of t
11

 (0·05), if =0·05, is 1·796. Since the observed

value of |t| is greater than the tabulated value of t
11

(0·05), so we reject H
0
. This

means the drug seems to have increase the blood pressure.

(d) Testing the Significance of an Observed Correlation Coefficient

Suppose   denote the population correlation coefficient and r denote the

observed correlation coefficient from the sample values. Then to test the hypothesis

H
0
 : =0 against H

1
 : 0, the test statistic used is

t
r

r
n tn    

1
2

2 2~

The decision rule remain same as in previous sections.

Example 7. A random sample of 11 observations from a bivariate population gave

a correlation coefficient 0·239. Could the observed value have arisen from an
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uncorrelated population?

Solution : Let us formulate the hypothesis

H
0
 : =0 against H

1
 : 0

Test statistic is

t
r n

r
 


2

1 2

where r=0·239, n=11, thus

 t    
   


0 239 11 2

1 0 239

0 717

0 9712( )  = 0·738

If =0·05, then tabulated value of tn2 2
  , i.e. t

9
(0·025) is 2·262. Since

observed value of t(0·738) is less than the tabulated value of t at 5 percent level of

significance with 9 degrees of freedom, thus we accept H
0
. This means observed

value of r might have obtained from an uncorrelated population.

Example 8. How many pairs of observations must be included in a sample in order

that an observed correlation coefficient of value 0·48 shall have a calculated value

of t greater than 2·72?

Solution : We have given the value of r, and t and we have to find the value of

n. As we know that

t
r n

r
 


2

1 2

It is given that

t > 2·72

or
r n

r




2

1 2 >2·72
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or n
r

r
     

2
72 1 2

or n–2>
2 72 1

2 2

2

   r

r

( ) ( )

or n>
2 72 1

2 2

2

   r

r

( ) ( )
+2

or     


2 72 1 048

0 48

2 2

2

( ) ( ) 

( ) 
+2

 
 5 6938

0 2304
2

= 24·713+2 = 26·713~27

Hence we should include atleast 27 observations.

11.5 SUMMARY

In the present lesson we have discussed the student t-test. This test has the following

applications.

(i) Testing of the mean of a normal distribution with unknown standard
deviation

The test statistic is

t
x

s
n

  0
~ t

n–1

where s is the sample standard deviation which is given by

s
x nx

n
 


 2 2

1
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(II) Testing the equality of means of two normal population

The test statistic is

t
x x

s
n n

t n nn
 

  1 2

1 2

2
1 1 2

~

where

s
n s n s

n n
   

 1 1

2

2 2

2

1 2

1 1

2

( ) ( ) 

s
1
2 and s

2
2 are the sample variances of the first and second sample respectively.

(iii) Testing the equality of means of two populations when samples are
dependent or paired samples.

The test statistic is

t
d

s
n

 ~ t
n–1

where d  is the mean of difference of observations and

s = 
( )d d

n




2

1

(iv)  Testing the significance of observed correlation coefficient

The test statistic is

t
r n

r
t n 

 
2

1 2 2~
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where r is the sample correlation coefficient

(v) Z - test is used to test whether an observed correlation coefficient differs

significantly from some hypothetical value or whether two samples values of

r differ significantly.

11.6 GLOSSARY

 - Test of significance are used to test the power of hypothesis.

 - Test is applicable when the sample size is small

 - A small sample means the strenght of data in samplemust be less than or equal

to 30 only.

- T- test is applicable when comparison is made between two populations not more

than two.

11.7 ASSESSMENT

1. Distinguish between large sample and small sample tests

2. A certain food processing plant has prepared a product with an average water

content of 37·5 percent. A sample of 10 units taking after a change in cooking

procedure, shows an average water content of 39·2 percent and standard

deviation of 3·4 percent. Had the procedure made a significant change in

percentage of water contents?

3. Two different models are available for the same machine. The number of units

produced per hour of these two models are given below :

Days : 1 2 3 4 5 6 7

Model A : 180 176 184 181 190 137 –

Model B : 195 194 190 192 187 185 187

Will you conclude that model A and model B have the same productivity.

4. A certain drug administered to each of 10 patients resulted in the following

additional hours of sleep :

0·7, –1·10, –0·20, 1·20, 0·1, 3·4, 3·7, 0·8, 1·8, 2·0

Test whether these data justify the claim that drug does not produce additional

sleep.
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5. A random sample of 16 observations from a bivariate population gave a

correlation coefficient 0·42. Could the observed value have arisen from an

uncorrelated population?

6. From a sample of 20 pairs of observations the correlation is 0·56 and the

corresponding population correlation is 0·42. Is the difference significant?

11.8 LESSON END EXERCISE

1. X  is used for _________ mean whereas u is used for denoting ________.

2. T-test work on only______________samples.

3. T-test can also be used to compare assumed results and actual results ( True/

Falsa)

11.9 SUGGESTED READINGS

1. Gupta, S.P. (2001) : Statistical Methods.

2. Levin, R.I. : Statistics for management.

3. Srivastava, U.K. G.V. Shenoy and S.C. Sharma : Quantitative Techniques for

Managerial Decision Making.

----------
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Course No. : SOC-C-302     Lesson No. 12

Unit - III CHI SQUARE ( ) TEST Semester-III

12.1 Objectives

12.2 Introduction

12.3 Chi-square Statistic and its Assumptions.

12.4 Application of Chi-Square Test.

12.5 Summary

12.6 Assignments

 12.7 Further Suggested Readings

12.1 OBJECTIVES

After successful completion of this lesson, students will be able to :

• know about chi-squre distribution and chi-square statistic,

• understand the role of chi-square distribution in testing of hypothesis,

• perform test regarding the variance of a normal distribution, and

• understand and conductory tests of goodness of fit and testing the

independence of categorised data.

12.2 INTRODUCTION

In the previous lessons (17, 18 and 19) we have discussed the meaning of

testing of hypothesis, various tests of hyposises and also how some of these tests

concerning the means, proportions, correlation coefficient of one or two populations

could be designed and conducted. But in real life, one is not always concerned with

the mean and the proportions alone-nor is one always interested in only one or two

populations. A business manager may want to test if there is any significant difference

in the proportion of high income households where his products is preferred in

different regions. In such situations the business manager is interested in testing the

197



quality of proportion among different regions (populations). In many of our earlier

tests, we had assumed that the population distribution was normal. It should be

possible for us to test if the population distribution is really normal, based on the

evidence provided by a sample. Similarly, in other situations it should be possible

for us to test whether the population distribution is Poisson, Binomial or any other

known distribution. The methods, (based on Chi-square) that we are going to

discuss in the subsequent sections of this lesson will help us in the kind of situations

mentioned above as well as in many others types of situations. Before discussing

these testing problems in detail first we know about chi-square distribution and its

assumptions.

12.3 CHI-SQUARE DISTRIBUTION AND STATISTIC

If X is a random variable having a standard normal distribution, then X2 will have

a Chi-square distribution with one degree of freedom. Further if X
1
, X

2
, ...., X

n
 be

a random sample of size n from N (, 2) then,  





x x


2

will have a Chi-square

(in notation 2) distribution with n–1 degree of freedom. That is

X X
n

  
2

1
2~

or  
( )

~
n

n



1 2

1
2 s

2 
In fitting of distributions, under the assumption that two sets of frequencies are

not significantly different, the Chi-square statistic is used which is defined as

 (O – E)2/E  ~  2
n

where O referes to the observed frequencies and E refers to the expected frequencies.

However, there are certain conditions for the validity of this 2–test. These are :

(i) The sample observations should be independent and normally distributed.

(ii) No estimated or theoretical cell frequency should be less than 5.

(iii) The total frequency should be reasonably large, say, more than 50

(iv) Constraints imposed upon the observations, if any, should be linear.
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12.4 APPLICATION OF CHI-SQUARE TEST

As we have discussed the applications of chi-square test in section 15.1, now

we will explain their procedure in the following sections :

Testing of Population Variance

Many times, we are interested in knowing if the variance of a population is

different from a known value. That is, we want to test the hypothesis H
0
: 2 = 2

0

against a suitable alternative. The test statistic is( ) ( )
~

X X n s
n

   2

0
2

2

0
2

21
1  

1
1

2

n
X X  ( )where s2

By comparing the observed value of  2 with tabulated value of  2 with (n–1)

degree of freedom at appropriate level of significance we may accept or reject H
0
.

The tabulated values of 2 are given in Table 2 of Appendix.

Example 1. A random sample of size 24 from a normal population with standard

deviation 12 gave the standard deviation 8·5. Is there any significance difference

between populat ion and sample standard deviation?

Solution : Here n = 24, s = 8·5 and we want to test the hypothesis :

H
0
 : 2 = 12·0

The test statistic is

  2
2

0
2 1

21  ( )
~

n s
n

 

 L  ( ) ( . )

.

24 1 8 5

120

2 

 23 72 25
144

.

= 11·54
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If , = 0·05, then tabulated value of 2  with n–1 = 24 d.f. at 5 percent level of

significance is 36·415. Since the calculated value of 2 is less than that of tabulated

value, so we accept H
0
. Hence, we may say that population standard deviation is 12·0.

Example 2. Packages made be a standard method for a long time indicate that 
0
 = 11·75

for the variation of weight. A less expensive and less time consuming new  method is tried

and it shows standard deviation 12·261 on the basis of a sample of size 20. Test whether

the new method results in an increase of the variability of the quality of packages in terms

of their weights.

Solution : Here we wish to test the hypothesis

H
0
 : 

1 
= 

0
 = 11·75   against

H
1
 : > 

0
 = 11·75

We have n = 20, s = 12·261 and n–1 = 19

The test statistic is

 
2

2

0
2

2

2

1 19 12 261

11 75
    


( ) ( )

( )

n s
= 20·69

The tabulated value of 2 for 19 d.f. at 5% level of significance is 30·14. Since

the calculated 2 is less than tabulated 2, so we accept H
0
, that the variability in terms

of weight of the packages has not increased.

(II) Chi-square Test for Goodness of Fit :

Some time we are interested in knowing if it is reasonable to assume that the

population is normal, Poison, Binomial or any other known distribution. In thissection

we describe the procedure to test how close is the fit between observed data and

distribution assumed. These tests are based on Chi-square statistic.

For explaining the goodness of fit test, let us consider a population which may

be partitioned into k-classes, and let p
i
 be the probability that an observation belongs

to the ith class (i = 1, 2, .... , k) with pi
i

k

1
 = 1. Further let a random  sample of size

n be drawn from the population. Suppose O
i
 is the number of sample observations

belonging to ith class such that O ni
i

k 
1

. Further let E
i
 be the expected frequency
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of the ith class. Thus, under H
0
, expected frequency E

i
 = np

i
 (i = 1, 2, ... , k) and

obviously E ni
i

k 



1
.

Now, a goodness of fit test between observed and expected frequencies is  used

based on the statistic

2

1
 i

k
(O

i
–E

i
)2/E

i 
 or  simply

=  (O – E)2/E

If the total frequency n is sufficiently large and the expected frequency in none of the

class is too small, 2 – statistic follows 2 distribution with , degrees of freedom

where = k–r–1 and r is the number of independent parameters estimated from the

sample observations. The calculated value of

2 is compared with the table value of 2  for given . As 2 measures the discrepancy

between the observed data and fitted distribution, the large value of 2  would lead to

rejection of H
0
. Thus, for goodness of test, the rejection region is always the right tail.

Before calculating the value of 2  statistic if we observe that expected frequencies in

any class is less than 5, than such frequencies are “pooled or combined with adjacent

classes. Consequently, the corresponding observed frequencies too are pooled or

combined with adjacent classes and in the process, the number of classes is also

reduced.

Example 3. A die is thrown 90 times and the number of faces shown are as

indicated below :

Face (i) : 1 2 3 4 5 6

Frequency (n
i
) : 18 14 13 15 14 16

Test whether the die is fair.

Solution : Let p
i
 be the probability of showing the face i, i = 1, 2,..., 6.

Here we want to test the hypothesis

H
0
 : p

1
 = p

2
 . . ., = p

6
 = 1/6

We have E
i
 = n p

i
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 90
1
6

 
(for all classes)

= 15

Hence

2 =(O–E)2/E       ( ) ( ) ( )18 15

15

14 15

15

13 15

15

2 2 2

    ( ) ( ) ( )15 15

15

14 15

15

16 15

15

2 2 2

     9

15

1

15

4

15
0

1

15

1

15

  16

15
1 07

If  = 5%, then the tabulate value of 2 with k–1, i.e., 5 d.f. at 5 percent level

is 11·10 which is greater than calculates value of 2. Hence there is no reason to

reject the H
0
 or that the die is fair.

Example 4. Following is the frequency distribution of the number of arrivals per unit

of time of patients at the OPD of a hospital. Verify whether the arrivals follows a

Poisson distribution.

Number of arrivals (X
i
) : 0 1 2 3 4 5 6 7

(per ten minutes)

Observed frequency (O
i
) : 10 30 40 50 35 20 10 5

Solution : We want to test the hypothesis

H
0
 : The number of arrivals per unit of time has a Poisson distribution.

To test this H
0
, we use  2 test of goodness of fit.

To compute the expected frequencies (E
i
), we first estimate the parameter ()

of the Poisson distribution from the given data as
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    x
fx
f

595
200= 2·975

The Poisson probabilities p(x
i
) can be calculated by the following relation

p x
x

p x( ) ( )  1
1


, x = 0, 1, 2, . . .

since p (0) = e– = e–2·975 = 0·0508

Thus

p (1) =  p (0) = 0·1524

p (2) =  

2

p (1) = 0·2286

p (3) = 

3

p (2) = 0·2286

p (4) = 

4

p (3) = 0·1714

p (5) = 

5

p (4) = 0·1028

p (6) = 

6

p (5) = 0·0514

p (7) = 

7

p (6) = 0·022

Now we compute the expected frequencies (E
i
) by the relation E

i
 = n p (x

i
),

for i = 0, 1, 2, .... 7 and present the calculation in the following table.
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No. of arrivals   Observed Frequency fx p(x) E = n p(x)   (O–E)2

x 0 or f

0 10 0 0·0508 10·16 ~ 10 0 0

1 30 30 0·1524 30·48 ~ 30 0 0

2 40 80 0·2286 45·72 ~ 46 36 0·90

3 50 150 0·2286 45·72 ~ 46 16 0·32

4 35 140 0·1714 34·28 ~ 34 1 0·0286

5 20 100 0·1028 20·46 ~ 20 0 0

6 10 60 0·0514 10·28 ~ 10 0 0

7 5 35 0·022 4·4    ~ 4 1 0·25

    Total 200 595 1·00 200 1·449

The calculated value of chi-square is given by

 22 O E
1.449

Ecal
   

The degree of freedom = v = k – r – 1 = 8 – 1 – 1 = 6. For  = 0·05, the tabulated

value of 2 with 6 d.f. is 12·59 which is greater than calculated value of 2, hence

we accept H
0
. Thus we may conclude that number of arrivals follow Poisson

distribution.

Remark : To fit the binomial distribution we first estimate the parameter p through

p
x
n

 , where x
fx
f

   and then compute p(x
i
) through p x

n x
x

p
q

p x( ) ( )  
1

1
The other procedure remains unchanged.

(III) Chi-square Test For Independence

Some times it is required to find out whether two characteristics or attributes

manifest themselves independently or in some related way. For testing the independence

of two attributes, we first formulate a contingency table as discussed in section 6.5

( )O E

E

 2

204



of lesson 6. Suppose we have two attributes A and B. Further let attribute A has r

mutually exclusive categories A
1
, A

2
, . . . A

r
 and B has c such categories denoted by

B
1
, B

2
, . . . B

C
. A random sample of size n is drawn from the population and is

classified into following (r×c) contingency table with respect to attributes A and B :

Contingency Table

B

 A B
1

B
2

. . . B
C

Total

A
1

O
11

O
12

. . . O
1C

O
1
.

A
2

O
21

O
22

. . . O
2C

O
2
.

. . . . . . . .

. . . . . . . .

. . . . . . . .

A
r

O
r1

O
r2

. . . O
rC

O
r
.

Total O
.1

O
.2

. . . O
.C

n

To test the hypothesis of independence of two attributes, we use the  2 test statistic

 2 = ( )O E Eij ij ij 2 , i = 1, 2,.... r and j = 1, 2, ..., c. or simply

2 2 ( )O E E

where E
ij
 = 

O O

n
i j. .

 for all i and j.

The degree of freedom would be  = (r–1) (c–1).

If r = c = 2, the above contingency table reduced to 2×2 contingency table.

If following is a 2×2

. A
B 1 2 Total

1 a b a+b

2 c d c+d

Total a+c b+d n

cont ingency

table.
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where n = a + b + c + d. Thus to test the independence, we use following  2 -

statistic

 2
2

1
2 

   
n ad bc

a b c d a c b d
( )

( )( )( )( )
~

Further if any cell frequency is less than 5 and total (n) is less than 50, then

we use corrected (Yates correction) 2 - statistic which is given by

2

2

2
 

   
n ad bc

n

a b c d a c b d( )( )( )( )

Example 5. The following contingency table gives the results of the survey

conducting by market researcher with respect to the performance of four competing

brands of tooth paste among the users :

Brand

Performance A B C D Total

No cavities 5 9 13 7 34

1-5 cavities 59 66 81 78 284

More than 24 33 44 33 134

5 cavities

Total 88 108 138 118 452

Test the hypothesis that incidences of cavities is independent of the brand of the

toothpaste used.

Solution : Here we wish to test the hypothesis

H
0
 : The incidence of cavities is independent of the brand of the toothpaste.

against the suitable alternative hypothesis.

Now we compute E
ij
 as
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E
11

88 34
452

 
= 6·62 ~  7, E12

108 34
452

 
 = 8·12 ~ 8

E13

138 34
452

 
 = 10·38 ~ 10, E14

118 34
452

 
= 8·87 ~ 9

E21

88 284
452

 
= 55·29 ~ 55, E22

108 284
452

 
 = 67·85 ~ 68

E23

138 284
452

 
= 86·71 ~ 87, E24

118 284
452

 
= 74·14 ~ 74

E31

88 134
452

 
 = 26·08 ~ 26 E32

108 134
452

 
 = 32·01 ~ 32

E33
138 134

452
 

= 40.91 ~ 41, E34
118 134

452
 

= 34.98 ~ 35

Therefore

2
2 2 2 2 25 7

7

9 8

8

13 10

10

7 9

9

59 55

55
         ( ) ( ) ( ) ( ) ( )

+ 
( ) ( ) ( ) ( )66 68

68

81 87

87

78 74

74

24 26

26

2 2 2 2      

     ( ) ( ) ( )33 32

32

44 41

41

33 35

35

2 2 2

           4

7

1

8

9

10

4

9

16

55

4

68

36

87

16

74

4

26

1

32

9

41

1

35

= 1·857
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Here r = 3, c = 4, so v = (r–1) (c–1) = 6

For = 0·05, 2
6
 = 12·59 which is greater than calculated value of 2. Hence

we accept H
0
, that is cavities is independent of brand of toothpaste.

Example 6. In an experiment on the immunization of goats from anthrax, the

following results were obtained. Comment on the efficiency of the vaccine..

Died Survived Total

Immunized 2 10 12

Not immunised 6 6 12

Total 8 16 24

    Solution : Here we wish to test the null hypothesis that vaccine is not effective

in controlling the anthrax. Since one cell frequency is less 5 and total (n) < 50, so

we use Yates corrected –statistic

2

2

2
 

   
n ad bc

n

a b b d a c c d( )( )( )( )


 

  
24 12 60

24
2

12 12 8 16

2

 
  
24 36

12 12 8 16

2( )

= 1·687

If = 0·05, then 1
2= 3·84 which is more than calculated 2. Hence we
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accept H
0
. That is immunization of vaccine is effective.

Example 7. The following table gives the number of accounting clerks committing

errors and not committing errors among trained and untrained clerks working in a

company.

Clerks Number of clerks

Committing Not Committing Total

error error

Trained 80 540 620

Untrained 165 755 920

Total 245 1295 1540

Test whether the training is effective in preventing errors.

Solution : We wish to test the H
0
;

H
0
 : Training and committing errors are independent against suitable alternative

The test statistic is

2
2 

   
n ad bc

a b b c a c b d

( )

( ) ( ) ( ) ( )

   
  

1540 755 540 165

620 920 245 1295

2(80 )

= 7·01

If = 0·05, then 1
2  = 3·84, which is less than 2  calculated (7·01), so we

reject H
0
. Hence we may conclude that training is effective in preventing the errors.

12.5 SUMMARY

(i) To test the population variance,. i.e., H
o
 : 2 = 

0
2

The test statistic is
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 2
2

0
2 1

21

6
 


( )

~
n s

n

(ii) To test the goodness of fit the test statistic is

 2 2
1

2    ( ) ~O E E k r

where O = observed frequency

E = expected frequency

K = number of classes

r = number of parameters to be estimated.

(iii) To test the independent of two attributes in a r × c  contingency table,

the test statistic is

2
2  (O )E

E
 ~ 2 

(r–1) (c–1)

12.6 GLOSSARY

- Chi- square  is a test in statistics used to measure the difference between

observed and expected data.

- ‘O’ denotes observed frequencies.

- ‘E’ denotes expected frequencies.

- ‘’ Square works on a large samples only.

12.7 ASSIGNMENTS

1. The number of defects per unit in a sample of 340 units of a manufactured

product was found as follows :

No. of defects : 0 1 2 3 4

No. of units : 210 95 24 6 5

Fit a poisson distribution to the data and test the goodness of fit.

2. If 4 coins are tossed 150 times and following results were obtained.

No. of heads : 0 1 2 3 4
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Observed freq : 6 48 60 28 8

Fit the binomial distribution and test the goodness of bit.

3. An automobile company conducted a survey about liking or disliking a

model of new car. The following data is obtained :

Age group
Persons Below Between Between Between

20 20-30 30-40 40-50

Liked the model 160 70 50 70

Disliked model 80 20 60 80

Analyse the data and give your comments.

4. A random sample of 10 students has the marks : 60, 70, 50, 40, 80, 70,

60, 90, 100 and 50. Do these data support the assumption at 5 % level

that the variance of normal population is 187?

5. From the data given below about the treatment of 250 patients suffering

from a disease, state whether the new treatment is superior to the

conventional treatment.
No. of Patients

Favourable Not Favourable Total
New 140 30 170
Conventional 60 50 80
Total 200 50 250

6. In a survey of 240 boys, of which 80 were intelligent, 50 had skilled
fathers; while 85 of unintelligent boys had unskilled fathers. Do these
figures suppose the hypothesis that skilled fathers have intelligence boys?

12.8 LESSON END EXERCISE
1. The formula for calculating   square is 
 No estimated or therotical cell frequency must be less than 5  (True/ Falsa)

 Chi- square test is also known as test of Goodman of fit (True/ Falsa)

12.9 SUGGESTED READINGS
1. Gupta, S.P. (2001) : Statistical Methods Sultan Chand & Sons, New

Delhi.
2. Levin, R.I. (1987). Statistics for Management
3. Srivastava, U.K, G.V. Shenoy and S.C. Sharma. Quantitative Techniques

for Managerial Decision Making. Wiley Eastern United, New Delhi.
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Course No. : SOC-C-302 Lesson No. 13

Unit - II F–TEST Semester-III

STRUCTURE

13.1 Objectives

13.2 Introduction

13.3 Test of Equality of two variances

13.4 Analysis of Variance

13.5 Summary

13.6 Glossary

13.7 Assignments

13.8 Lesson End Exercise

13.9 Suggested Readings

13.1 OBJECTIVES

After successful completion of this lesson, the students will be to :

• understand the assumptions and applications of F-test,

• find out whether the two population variances differ significantly or not, and

• perform the technique of analysis of variance.

13.2 INTRODUCTION

While applying student’s t-test for testing equality of means, the basic assumption

was that the population variances must be same. Thus F-test is used to find out

whether the two independent estimates of population variance differ significantly,

or whether the two samples may be drawn from the normal populations having the

equal variance.

F-test can also be used to test the equality of several population means

through analysis of variance (ANOVA) technique and significance of multiple

correlation coefficient. Testing of equality of two variances is discussed in the
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following sections.

13.3 TEST OF EQUALITY OF TWO POPULATION VARIANCES

Suppose we have two independent random samples of sizes n
1
 and n

2
 from

normal populations and null hypothesis to be tested is that the population variances

are same. Under the null hypothesis H
0
 : 2

1
 = 2

2
, the test statistic would be

F
s

s
s s 1

2

2
2 1

2
2
2;

where s
1
2 = 

1

11
1 1n

x x  ( )     and s
2
2 = 

1

12
1 2

2

n
x x  ( ) 

The distribution of F is F with n
1
–1 and n

2
–1 degrees of freedom.

I f calculated value of F exceeds the tabulated value with n
1
–1 and n

2
–1 df at 

percent level of significance, we reject H
0
. The table views of F are given in Table

No. at the end.

Since F-test is based on the ratio of two variances, thus it is also called the

Variance Ratio Test. The ratio of two variances follows, F-distribution, named after

the famous statistician R.A. Fisher.

F-test is also based on, as other tests, the following assumptions :–

1.Normality : The observations in each group must be normacy distributed.

2.Homogeneity : The variance within each group should be equal for all groups.

This assumption is needed in order to combine or poor the variances within the

groups into a single ‘within groups’ source of variation.

3.Independent of Error : The error, variation of each value around its own group

mean, should be indepedent for each value.

Now we shall illustrate F-test by taking some examples :–

Example 1. Two samples are drawn from two normal populations. From

the following data test whether the two samples have been drawn from the

populations with same variances at 5 percent level of significance.
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Sample I : 3 5 4 7 6 5

Sample II : 4 6 7 6 8 5 3 9

Solution : Let us formulate the hypothesis

H
0
 : 

1
2 = 

2
2 against H

1
 : 

1
2  

2
2

Here n
1
 = 6, n

2
 = 8, x1

30

6
5   and x2

48

8
6 

so that s
n

x x1
2

1
1 1

2 2 2 21

1

1

5
3 5 5 5 4 5          ( ) ( ) ( )( ) 

(7 ) (6 ) (5 )     5 5 52 2 2

       4 0 1 4 1 0

5

10

5
2

and s
n

x x2
2

2
2 2

21

1
   ( ) 

         1

7
4 6 6 6 7 6 6 6 8 62 2 2 2 2( ) ( ) ( ) ( ) ( )

(5 ) (3 ) (9 )    6 6 62 2 2

         4 0 1 0 4 1 9 9

7

28

7
4

Since s
2
2 > s

1
2, so our test statistic is

F
s

s
  2

2

1
2

4

2
2

Since = 0·05, n
1
–1 = 5 and n

2
–1 = 7, so tabulated value of F with 7 and 5 d.f. at 5

percent level is 4·9 which is greater than calculated value of F (2), so we accept H
0
.

Thus we may conclude that population variances are equal.
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Example 2. A sample of 18 observations gives the sum of square of deviations

from mean 96· 48. Another sample of 12 observat ions gives the

sum of square of deviations from mean 110·80. Test whether the samples are drawn

from normal populations with equal variances.

Solution : We wish to test the hypothesis

H
0
 : 

1
2 = 

2
2 against H

1
 : 

1
2   2

2

Here n
1
 = 18, n

2
 = 12

   x x1 1

2
96 48 and    x x2 2

2
11080

s1
2 96 48

17
 

 = 5·68  and   s2
2 110 48

11
 

= 10.07

since s
2
2 > s

1
2, hence

 = 1·77

Since = 0·05, n
1
–1 = 17 and n

2
–1 = 11, thus tabulated value of F with 11 and

17 d.f. at  = 0·05 is 2·68 which is greater than F calculated (1·77), thus we accept
H

0.
That is population variances are same.

Example 3. The following figures relate to the number of limits produced per
shift by two workers A and B for a number of days :

A : 19 22 24 27 24 18 20 19 and 25

B : 26 37 40 35 30 30 40 26 30 35 and 45

Can it be inferred that A is more stable worker compared to B? Answer using
F-test at 5% level of significance.

Solution. As we know that a series having lesser variance is treated as more

stable. Thus, for drawing the needed inference, we test the equality of the variance

of the populations from whcih samples are observed. Let 2A
  and 2B

  the

population variances of the number of units produced by workers A and B

respectively.

Thus, we wish to test H
0
 : 2A
  = 2B

  against H
t
 : 2B
  > 2A


To test H

0
, the test statistic is
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F =
2

2

B

A

S

S (As 2B
S  > 2A

S ) .... (i)

Table Showing Calculations

Units produced (x–x)=   Units produced (y–y)= (y–34)2

by A (x–22) (x–22) by B (y–34)

(x) (y)

19 –3 9 26 –8 64

22 0 0 37 +3 9

24 2 4 40 6 36

27 5 25 35 1 1

24 2 4 30 –4 16

18 –4 16 30 –4 16

20 –2 4 40 6 36

19 –3 9 26 –8 64

25 +3 9 30 –4 16

35 1 1

45 11 121

x=198 (x–x )=0 (x–x )2=80 y=374 (y–y)=0 (y–y)2 =380

x

2
2

A
1

1 80
S ( ) 10

1 9 1
x x

n
     

2
2

B
2

1 380
S ( ) 38

1 11 1
y y

n
     

1

x

n

 198

9
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Putting the values in (i),

38
F = = 3.8

10

Also the critical value of F at 5% level of significance and for v
1
=10 and v

2
=8

degrees of freedom in F
10, 8

(0.05)=3.35 [Table 3]. Since calculated value of F is

greater than F
10, 8

(0.05), so H
0
 is rejected at 5% level and, in the light of data

information, 2B
  > 2A

 , i.e., A is more stable worker..

13.4 ANALYSIS OF VARIANCE

The student t-test is used for testing the hypothesis of equality of two

normal population means when sample size is small. However, in testing of

equality of more than two means, t-test can not be used. In such situations

we use analysis of variance. The analaysis of variance, developd by R.A.

Fisher, is one of the most powerful tools of statistical analysis. The analysis

of variance is a method of splitting the total variation into different components

that measure different sources of variation.

Classification of Observations : The follwoing criteria of classification of

observations are used in the analysis of variance :

One-way classification : In one-way classification, the observations are classified

according to only one criterian. There are two types of variations in the data

namely, the variation between samples and within samples. If the variation within

the samples and between the sample do not differ from each others, the samples are

said to be belong to the same population. On the other hand the larger variation

between the samples as compared to variation within the samples indicates that the

samples come from divergent populations.

Two-way classification : In a two way classification where the observatons are

classified according to two factors and the number of observations in each cell is

one, we partition the total variaton in the data into three components namely the

variation due to factor first and second and error and then test the signifance of each

factor with the variance due to error.
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Assumptions in Analysis of Variance

The ratio of variation between samples obtained during the analysis of variance

follows F-distribution. For the validity of the F-test in analysis of

variance, the following assumptions are made :

(i) The observations should be independent.

(ii) The parent population from which observations are taken should be notmal.

(iii) The variances for all the populations from which samples are taken should

be equal.

(iv) Various treatment and environmental effects should be additive in nature.

In the following sections we will discuss the analysis and computation of this

technique for one-way and two-way classification.

Analysis and Computation

New we shall present the analysis of variance seperately for both one-way and

two-way classifications.

(I) One-way classification : Suppose there are k normal populations with means


1
, 

2
, ..... , 

k
 and common variance 2 . Further, let k - random samples, one from

each population, are drawn from these populations. Let n
i
 (i = 1, 2, .... k) be the

size of sample from ith population. Using sample information we wish to test

H
0
 : 

1
 = 

2
 = 

3
 = .... = 

k
, i.e.

H
0
 : There is no significance difference between the population means.

Against

H
1
 : Atleast two means are not equal

Let X
ij
 (i = 1, 2, ... k, j = 1, 2, .... n

i
) be the jth observation of ith sample,

then one-way classified data can be arranged as :

Sample Observations Sample Sample

No Totals Means

1 x
11

x
12

      . . . x
1
n

1
T

1 X1

2 x
21

x
22

      . . . x
2
n

2
T

2 X 2

218



| . . . . . . .

| . . . . . . .

| . . . . . . .

k x
k1

x
k2

        . . . x
k
n

k
T

k X k

       Over all total or mean T X

To test the above cited hypothesis, the following are the main steps :

Step-I Complete the above table

Step-II Determine the correction factor (C.F.), as

   CF T

N

Squareof grand total

Total no of observations

2

.

Step-III Find the total sum of squares (T.S.S.) as

T.S.S. =  
i j

X ij CF2

   =  Sum of squares of all the observations — CF

Step-IV Find the sum of squares due to factor which is also called between sum

of squares (B S S) as

BSS = 
i

Ti
ni

2

 — C.F..

= Sum of squares of totals after dividing it by no. of observations

in that sample — CF

Step-V Find within sample sum of square which is also known error sum of
     squares (ESS) as

ESS = TSS – BSS

Step-VI Determine the degree of freedom for different components as

Degree of Freedom (d.f.) for TSS = N–1

Degree of Freedom for BSS = k–1

Degree of Freedom for ESS = N–k
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Step-VII Obtain the variance within samples and variance between samples
by dividing the sum of squares of each by its corresponding
degree of freedom, which is also called mean sum of squares
(MSS).

Step-VIII Compute F-Value as

F
Variance betweensamples

Variancewithinsamples


Step-IX Compare the value of F obtained in step VIII with the tabulated
value of F under given d.f.'s at the desired level of significance
(These values are given in Table - 3). If calculated value of F is
greater than the tabulated value, we reject H

0
, otherwise accept H

0
.

It is customary to summarise the various steps obtained in the form of a table called
analysis of variance (ANOVA) table

ANOVA TABLE

Source of Sumn of d-f Mean sum Calculated Table
Variation squares (SS) of square value of value of

MSS F F

Between samples BSS k–1
BSS

k 1
= VV

1
, say

V

V
1

2
F

k–1, N–k
()

Within samples

or error
ESS N–k

ESS
N k = VV

2
, say

Total TSS N–1 ... ... ...

Example 4. Following are the yields obtained in qtls of three varieties of wheat A,

B and C sown in 14 plots :

Variety of Wheat Yields in different plots

A 12 13 14 13

B 10 9 10 9 9

C 13 14 13 12 14

Is there any significance difference in the production of three varieties of

wheat.
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Solution : First of all we formulate the null and alternative hypothesis as

H
0
 : There is no significance difference in the production of three varieties i.e.

H
0
 : 

A 


B 
 = 

C

Against

H
1
 : Atleast two of  

A 


B 
 and  

C
 differ significantly.

We shall analyse the above data using analysis of variance technique.

Variety Yields in Plots Total Mean

A 12 13 14 13 — 52 13

B 10 9 10 9 9 47 9·4

C 13 14 13 12 14 66 13·2

Total 35 36 37 34 23 165

CF = 1944.64

Total sum of square (TSS) = X2
ij 
– CF

= 122 +132 + 142  + 132 + 102  + 92 + 102 + 92 + 92 + 132

+ 142 + 132 + 122 + 142 – 1944·64

= 1995 – 1944·64

= 50·36

Sum of squares due to variety or between  sum of squares (SSB)

SSB =   Ti
ni

CF
2

  ( ) ( ) ( )52 2

4
47 2

5
66 2

5
 = 1944·64

= 1989 – 1944·64 = 44.36

Sum of squares due to error (SSE)

= TSS – SSB

= 50·36 – 44·36
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= 6·00

Here k = 3, N = 14

Now we summarise the above calculations in the form of following ANOVA

Table

ANOVA Table

Source of Sum of d.f MSS F F

Variation Squares Calculated Tabulated

Between Variety 44·36 2
44 36

2


= 22·18 F
2, 11 

(5%)

22 18
0 546


 =40·62 4.26

Within Varieties 6·00 11
6 00
11


= 0·546

Since tabulated value of F at 5% level of significance for (2, 11) d.f. is 4·26 which
is less than the calculated value of F, hence we reject the H

0
. Thus the varieties

differ significantly

Note : The analysis of variance technique is independent of the shift of origin. If

the individual observations are large values we can subtract any constant quantity

from each individual value and then perform  ANOVA. The calculated value of F

will remain the same and the computational work will be reduced.

Example 5. The following data shows the lives in hours of four batches of electric

tubes :     Batches Lives in hours

A 1700 1710 1750 1780 1800 1820 1900

B 1680 1740 1740 1800 1850

C 1560 1650 1700 1720 1740 1760 1840 1920

D 1610 1620 1630 1670 1700 1780

Total 50.36 13
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Perform the analysis of variance and show that four batches are homogeneous.

Solution : First of all we formulate the H
0
 as

H
0
 : Four batches are Homogenous

Since the values are large, so we shift the origin by subtracting 1740 from

each observations. Thus the above data reduced to

Batches Lives in hours         Total

   T
i

A –40 –30   10   40   60 80 160 — 280

B –60   0   0   60   110 — — — 110

C –180 –90 –40 –20   0 20 100 180 – 30

D –130 –120 –110 –70 –40 40 — — – 510

Total – 150

Total sum of squares (TSS)

= X2
ij 
– C.F.

= (–40)2 + (–30)2 + (10)2 + .... + (–40)2 + (40)2 – 865·385

= 195900 – 865·385 = 195034.615

Between (Batches) Sum of Square (BSS)

=  Ti
ni

2
– C.F..

     ( ) ( ) ( ) ( )280 2

7

110 2

5

30 2

8

510 2

6
 – 865·385

= 57082·5 – 865·385

= 56217·115

Sum of square due error (SSE)

= TSS – BSS

= 195034·615 – 56217·115
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= 138817·50

Here k = 4, N = 26

Now we summarise the above celculations in the form of ANOVA Table as

AVONA Table

Source of Sum of d.f MSS F-value F-value

Variation Squares Calculated Tabulated

Between Batches 56217·115 3 18739·04 F
3, 22 

(5%)

18739 04
6309 89




Error 158817·50 22 6309·89 = 2·97 = 3·05

Total 195034·615 25 — — —

Since the calculated value of F (2·97) is less than the tabulated value of F (3·05)

at 5 percent level of significance with 3 and 22 d.f., so we accept our H
0
. Hence

we may conclude that four batches are homogenedus.

Two-way Classification : As discussed earlier in two-way classification the set of

observations are classified according to two factors. Thus such a classification can be

presented in the form of a rectangular array in which rows represent one factor of

classification and columns represent a second factor of classification. In general let

there be r rows and c-columns. Let X
ij
 denotes the value of the ith row and jth column

(i=1, 2, ... r and j=1, 2, 3, ... c).

Thus, a general two-way classification model can be represented as :
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Columns                   Total

 Rows 1 2 . . . j . . . c

1 X
11

X
12

. . . X
i j

. . . X
ic

T
1.

2 X
21

X
22

. . . X
2j

. . . X
2c

T
2.

. . . . . . ... . . . . .

. . . . . . ... . . . . .

. . . . . . ... . . . . .

i X
i j

X 
j2

. . . X
i j

. . . X
ic

T
i.

. . . . . . ... . . . . .

. . . . . . ... . . . . .

. . . . . . ... . . . . .

r X
r1

X
r2

. . . X
rj

. . . 
rc

T
r.

Total T
·1

T
·2

. . . T
·J

. . . T
·C

T

Now with the above sample information, two-way analysis of variance involves the

following steps :

Step-I Formulate the two null hypothesis as

(a) H
0
 : Row means are equal [i.e. 

1· 


 


2· 
= .... = 

r
 ].

H
1
 : Atleast two row means are not equal.

(b) H
0
 : Column means are equal, [i.e. 

·1 


 


·2 
= .... = 

c
 ]

H
1
 : Atleast two column means are not equal

Step-II Compute the Correction Factor (C.F.)

C.F. = 
T

rc

GrandTotal

No of rows No of columns

2 2 ( )

( . )( . )

Step-III  Compute total sum of squares (TSS) as

225



TSS= X
ij
2 – C.F.

= Sum of squares of observations – C.F.

Step-IV  Determine Row sum of squares (RSS) as

RSS=  T

c
i
2

– C.F..

= Sum of squares of rows total divided by no. of columns – C.F.

Step-V Determine column sum of squares (CSS) as

CSS=  T

r
i
2

– C.F..

= Sum of squares of columns total divided by no. of rows – C.F.

Step-VI  Compute Error Sum of Squares (ESS) as

ESS = TSS – RSS – CSS.

Step-VII Determine the degree of freedom (d.f.) associated with various sum of

squares by using the following :

(a) degree of freedom for TSS = rc–1

(b) degree of freedom for RSS = r–1

(c) degree of freedom for CSS = c–1

(d) degree of freedom for ESS = (r–1) (c–1)

Step-VIII Compute mean sum of squares (MSS) on dividing the sum of squares by

respective degree of freedoms.

Source of Sum of d.f. Mean sum Calculated Tabulated

variation squares of squares value of F value of F

Row RSS r–1
RSS
r 1

= VV
1

F
1
 = 

V

V
1

3
F

r–1,
 

(r–1) (c–1)
()
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Column CSS c–1
CSS

c1
=V

2
F

2 
=

V

V
2

3
F

c–1,
 

(r–1) (c–1)
()

Error ESS (r–1)(c–1) =V
3

Total TSS rc–1

After forming the ANOVA table as above the decisions regarding H
0
 and H

0
'  are

taken as

(a) If F
1
  F

r–1
, 

(r–1) (c–1) 
() ; Accept H

0
, otherwise reject H

0

(b) If F
2
  F

c–1
, 

(r–1) (c–1) 
() ; Accept H'

0
, otherwise reject H'

0
.

Finally after accepting or rejecting H
0
 or H'

0
, as the case may be, the conclusion

is made accordingly.

Example 6. A company appoints four Marketing Trainees T
1
, T

2
, T

3
 and T

4
 and

observes their sales in three regions – North, West and South. The figures of sales
(in lacs) are given below.

   Trainees

  Region T
1

T
2

T
3

T
4

North 23 26 26 24

West 27 26 27 26

South 23 24 25 25

Carry out the analysis of variance. What conclusions do you draw from the

analysis?

Solution : First of all we formulate the following hypothesis :

(i) H
0
 : There is no significance difference between the sales of four Trainees

H
1
 : Sales of atleast two trainees are not equal.

(ii) H
0
1 : There is no significance difference between the sales of three region.

H
1
' : Sales of atleast two regions are not equal

To test these hypothesis, we complete the following table and obtain different

sum of squares.
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     Trainees

Region T
1

T
2

T
3

T
4

Total

North 23 26 26 24 99

West 27 26 27 26 106

South 23 24 25 25 97

Total 73 76 78 75 302

Corrector Factor (C.F.)

  (Grand Total)2

r c
( )320 2

12
= 7600.33

Total Sum of Squares (T.S.S)

T.S.S. = X
ij
2 – C.F.

= (23)2 + (26)2 + (26)2 + (24)2 + (27)2 + (26)2 + (27)2 +

   (26)2 + (23)2 + (24)2 + (25)2 + (25)2 – 7600·33

= 7622 –
 
7600·33

= 21·67

Row Sum of Squares or Sum of Squares due to Regions (R.S.S)

R.S.S.   ( ) ( ) ( )99 2

4
106 2

4
97 2

4
– C.F..

= 7611·5 – 7600·33

= 11·17

Column Sum of Squares or sum of squares due to Trainers (C.S.S)

C.S.S.    ( ) ( ) ( ) ( )73 2

3
76 2

3
78 2

3
75 2

3
– C.F..

= 7604·67 – 7600·33

= 4·37

Error Sum of Squares (ESS)
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ESS = TSS – RSS – CSS

= 21·67 – 11·17 – 4·37

= 6·13

The following are the degree of freedoms, for differente sum of squares :

Degree of freedom for TSS = 12–1 = 11

Degree of freedom for RSS = 3–1 = 2

Degree of freedom for CSS = 4–1 = 3

Degree of freedom for ESS = 11–3–2– = 6

Now we summarise the above calculations in the following ANOVA Table:

ANOVA TABLE

Source of Sum of d.f. M.S.S. F-value F-value

variation squares calculated Tabulated

Rows 11·17 2 5·59
5 59
1 02

 = 5·48 F

2,
 
6
(5%)= 5·14

Regions)

Columns 4·37 3 1·46
1 46
1 02

 =1·43 F

3,
 
6
(5%)= 4·76

(Trainees)

Error 6·13 6 1·02

Total 21·67 11 —

The calculated value of F (5·48) is greater than the tabulated value of F (5·14) with

2 and 6 d.f. at 5 percent level of significance, hence we reject H
0
 and conclude that

regions have significant effect on sales. Further the calculate value of F (1·43) is

less than the tabulated value of F (4·76) with 3 and 6 d.f. at 5 percent level of

significance, thus we accept H
0
1 and conclude that there is no significance difference

in trainees as far as their sales are concerned.

13.7  ASSIGNMENTS

1. A test was given to five students taken at random from the eighth class of

three schools in  a town. The individual scores are :
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School      Scores

I 8 7 9 6 8

II 7 5 4 6 5

III 6 5 4 6 4

Carry out the analysis of variance and state your conclusions.

2. The following figure related to the production (in kg) of three varieties of

wheat used in 15 plots :

Variety of Yield (in kg)

Wheat

A 19 22 21 21 3

B 20 16 18 20 18 19

C 23 21 23 24 20

Test whether there is any significance difference in the production of three

varieties of wheat.

3. The following data represent the number of units of production per day produced

by 5 different workers using four different machines.

Workers Machines

M
1

M
2

M
3

M
4

W
1

54 48 57 46

W
2

56 50 62 53

W
3

44 46 54 42

W
4

53 48 56 43

W
5

48 52 59 49

Test whether the

(a) mean productivity is the same for different machines.

(b) the workers differ with respect to mean productivity.
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4. Using the data of (2) and (3), carry out the analysis of variance after shifting

the origin and state your conclusions.

13.5 Summary

In this lesson you learned the uses and aplication of F- test, which is used to

compare the ratio of variance of two populations. F-Test is also used to test

the difference between several populations through (ANOVA) Analysis of

variance. ANOVA overcome the limitation of T-test where only two population

are studied. In ANOVA multiple population can be considered.

13.6 GLOSSARY

- F-test is also known as F Ratio test.

- Fisher is the founder of F-test.

- F- test is used to find the ratio between the varience of two proportions.

- ANOVA is a multiple Variable test to compare the multiple variable with the help

of F- test.

13.8 LESSON END EXERCISE

1. F- test compares the________________ of two populations.

2. ANOVA is a multi _____________test.

3. F-test is also called ______________
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3. Levin, R. (1984. Statistics for Managements. Prentice-Hall Inc., New York.
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Course No. : SOC-C-302          INTRODUCTION TO Lesson No.
14

Unit - IV COMPUTER OPERATING SYSTEM Semester-III

STRUCTURE

14.1 Introduction

14.2 Objectives

14.3 Computer Operating System

14.4 Summary

14.5 Glossary

14.6 Assignments

14.6 Lesson End Exercise

14.6 Suggested Readings

14.1 INTRODUCTION

With the introduction of computer in statistics research became so easy whether we

talk about data collection, writing  reports, analysis or any thing else. There are

general application software like Ms- word , Ms Excel etc. for general purpose of

writing and analysis. And there are some statistical softwares also like SPSS, AMOS,

PASW etc. In current lesson we will discuss about operating system used in computer

which is also called system software without operating system , computer cannot

work at all.

14.2 OBJECTIVES

After sucessful completion of this lesson , you shall be able to know:-

- What is operating System

- Purpose of operating System

- Input and output devices.

- Window fundamentals
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14.3 COMPUTER OPERATING SYSTEM

What is an Operating System?

An operating system (OS) is a collection of system programs that together

control the operation of a computer system.

What does an operating system do?

An operating system controls the way in which the computer system functions. In

order to do this, the operating system includes programs that

• initialize the hardware of the computer system

• provide basic routines for device control

• provide for the management, scheduling and interaction of tasks

• maintain system integrity and handle errors

Where are operating systems found?

There are many types of operating systems, the complexity of which varies

depending upon what type of functions are provided, and what the system is being

used for. Some systems are responsible for managing many users on a network.

Other operating systems do not manage user programs at all. These are typically

found in hardware devices like petrol pumps, airplanes, video recorders, washing

machines and car engines.

What is a general-purpose operating system?

Windows NT Workstation is known as a general-purpose operating system. This is

because it provides the ability to run a number of different

programs, such as games, word processing, business applications and program

development tools.

A simple operating system for a security control system

An operating system for a security control system (such as a home alarm

system) would consist of a number of programs. One of these programs would gain

control of the computer system when it is powered on, and initialize the system.

The first task of this initialize program would be to reset (and probably test)

the hardware sensors and alarms. Once the hardware initialization was complete,
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the operating system would enter a continual monitoring routine of all the input

sensors. If the state of any input sensor changed, it would branch to an alarm

generation routine.

What are Input and Output devices?

Input and output devices are components that form part of the computer system.

These devices are controlled by the operating system.

Input devices provide input signals such as commands to the operating system.

These commands received from input devices instruct the operating system to perform

some task or control its behavior. Typical input devices are a keyboard, mouse,

temperature sensor, air-flow valve or door switch.

In the previous example of our simple security control system, the input devices

could be door switches, alarm keypad panel and smoke detector units.

Output devices are instruments that receive commands or information from the

operating system. Typical output devices are monitor screens, printers, speakers,

alarm bells, fans, pumps, control valves, light bulbs and sirens.

What is a single-user operating system?

Operating systems such as Windows 95, Windows NT Workstation and Windows

2000 professional are essentially single user operating systems. They provide you

the capability to perform tasks on the computer system such as writing programs
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and documents, printing and accessing files.

Consider a typical home computer. There is a single keyboard and mouse that

accept input commands, and a single monitor to display information output. There

may also be a printer for the printing of documents and images.

In essence, a single-user operating system provides access to the computer system

by a single user at a time. If another user needs access to the computer system, they

must wait till the current user finishes what they are doing and leaves.

Students in computer labs at colleges or University often experience this. You might

also have experienced this at home, where you want to use the computer but

someone else is currently using it. You have to wait for them to finish before you

can use the computer system.

What is a multi-user operating system?

A multi-user operating system lets more than one user access the computer system

at one time. Access to the computer system is normally provided via a network, so

that users access the computer remotely using a terminal or other computer.

In the early days of large multi-user computers, multiple terminals (keyboards

and associated monitors) were provided. These terminals sent their commands

to the main multi-user computer for processing, and the results were then displayed

on the associated terminal monitor screen. Terminals were hard-wired directly

to the multi-user computer system.

Today, these terminal are generally personal computers and use a network to

send and receive information to the multi-user computer system. Example of

multi-user operating systems are UNIX, Linux (a UNIX clone) and mainframes

such as the IBM AS400.
Mainframe

Network
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The operating system for a large multi-user computer system with many terminals

is much more complex than a single-user operating system. It must manage and run

all user requests, ensuring they do not interfere with each other. Devices that are

serial in nature (devices which can only be used by one user at a time, like printers

and disks) must be shared amongst all those requesting them (so that all the output

documents are not jumbled up). If each user tried to send their document to the

printer at the same time, the end result would be garbage. Instead, documents are

sent to a queue, and each document is printed in its entirety before the next document

to be printed is retrieved from the queue.

Operating system utilities

The operating system consists of hundreds of thousands of lines of program code

and stored on hard disk. Portions of the operating system are loaded into computer

system memory (RAM) when needed. Utilities are provided for

• Managing Files and Documents

• Development of Programs and Software

• Communicating between people and with other computer systems

• Managing user requirements for programs, storage space and priority

What is a multi-tasking operating system?

A multi-tasking operating system provides the ability to run more than one program

at once. For example, a user could be running a word processing package, printing

a document, copying files to the floppy disk and backing up selected files to a tape

unit. Each of these tasks the user is doing appears to be running at the same time.

A multi-tasking, operating system has the advantage of letting the user run more

than one task at once, so this leads to increased productivity. The disadvantage is

that more programs that are run by the user, the more memory that is required.
Basic Features of Graphical Interfaces

Graphical systems use windows to display information and thus allow more than

one window to be displayed at any time. Each window is associated with a running

program. User input is derived from a keyboard and mouse.

The mouse

The mouse, invented in 1963 at the Stanford Research Institute by Douglas
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Engelbart, has done much to enhance the use of the personal computer. Engelbart’s

prototype, made of wood, with metal disks for rollers that detected the motion of

the mouse, was further developed by Xerox at it’s Palo Alto Research Center in the

early 1970’s under the direction of Jack S Hawley.

Most mice have two or more buttons, which users depress to select items from

a menu or click on graphical objects on the computer

screen, thus sending commands to the computer.

The mouse is held in the hand and moved

across a flat surface. As the mouse is moved, its

movement is detected and translated into both X and

Y movements, which updates the indicated position

of the mouse pointer on the computer screen

accordingly

The mouse cursor

The position of the mouse is shown on the screen as the mouse cursor and is

denoted by a number of symbols.

Selecting items with the Mouse

i) Single Click

A single mouse click refers to moving the mouse pointer over the desired item and
quickly pressing the left mouse button once.

ii)  Double Click

A double mouse click refers to moving the mouse pointer over the desired item and
quickly pressing the left mouse button twice in rapid succession.

 iii)  Drag

A drag or move operation is performed by moving the mouse pointer over the
desired item and holding the left mouse button down. The mouse is then used to
move to drag the object or window to the new position, then the left mouse button
is released.

Window Fundamentals

In a graphical operating system, information is represented in graphical
ways. Little symbols or pictures (called icons) are used to display programs or
information. Information is displayed inside windows, each of which has similar
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properties.

It is possible to have
more than one window
on the screen at one
time, and windows may
be cascaded (on top of
one another) or tiled (all
displayed at once and
all visible).

In this picture,
the windows have been
cascaded. This makes
each window appear on
top of each other, one
after the other.

The front most window is considered to be the active window, i.e., window to
which the users commands will be sent.

In windows 95 or Windows NT, the
titlebar of the window is shown in the

default color Blue.

In this picture, the images have been tiled.

This makes all windows visible at the

same time, but resizes the dimensions of

each window so that they all fit on the

available screen space at once.

Tip :  To cascade or tile all windows on the desktop area, right mouse click on an

empty portion of the taskbar and select Cascade Windows or Tile Windows from

the menu.

s Window Properties

Each window has the same properties and behaves the same way. This provides a

consistent interface to the user, as all commands are the same for each window
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and the operations that the user performs on each window are identical.

In the diagram below, we see the basic window as presented by Windows

95 or Windows NT. Each property is listed on the diagram, and below is an

explanation for each of the window components.

The Title Bar

This normally displays the name of the program associated with the window. If the

background color of the title bar is blue, the window is active and any user commands

will be processed by that window. You can also toggle between a maximized window

size and the windows normal size by double clicking in the title bar area.

The Control Menu

Clicking on the Control Menu pops up a small Window of selectable options, which

include the operations of Restore, Move, Size, Maximize, Minimize and Close the

Window.

Control Menu Title Bar

Minimize Window
          Maximize Window
              Close Window

Menu
Bar

Horizontal Scroll Bar Window Display Area

Vertical
Scroll
Bar

W indow
Borders
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The Horizontal and Vertical Scroll Bars

When the amount of information displayed in the window exceeds the viewing space

of the window, scroll bars are automatically to the side and bottom of the window.

This allows the user to scroll the contents of the window in order to view the

remaining information. Arrows are used to indicate the direction of scrolling on the

scroll bar, and an indicator bar represents the relative position of the viewing area

compared to the total size of the information.

Clicking on the arrows associated with the scroll bar move the viewing window up

or down one line, or across or back one character position. You can also click on the

small indicator bar within the scroll bar and drag it with the mouse to quickly scroll

the windows contents.

The Minimize Maximize Close Window Buttons

These buttons are located on the top right corner of each window. Clicking on them

once performs the desired action associated with the button.

• The minimize button – reduces the window and places it on the taskbar at the

bottom of the window.

• The maximize button  expands the window to fill the entire desktop screen area.

• The close button ×  closes the window.

Tip : To minimize all windows on the desktop area, right mouse click on an empty

portion of the taskbar and select Minimize all Windows from the menu.

The Menu Bar

The menu bar presents a

number of options that the program

associated with the Window

supports.

Clicking on an option on the

menu bar will popup a submenu of

choices that you can select from.

The Windows Borders

The windows borders show the

dimensions of the window. Any window
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can be resized, either made smaller or larger, by dragging the window border

appropriately.

• To make the window taller or shorter :

Move the mouse pointer to either the top or bottom window border, and

when it changes to a resize arrow  then hold the left mouse button down

and drag the window border to its new position, then let release the left

mouse button.

• To make the window narrow or wider :

Move the mouse pointer to either the left or right window border, and when

it changes to a resize arrow then hold the left mouse button down and drag

the window border to its new position, then let release the left mouse button.

Moving a Window

A window can be repositioned on the desktop screen display area by moving the

mouse cursor into the title bar area, then holding the left mouse button down and

dragging the window to the new position then releasing the left mouse button.

Switching between Windows

When you have multiple windows displayed on the desktop screen  area, you can

switch between windows by clicking on the programs icon on the taskbar or

pressing ALT-TAB keys on the keyboard. When you press ALT-TAB, it will pop

up a window of the available programs. Hold the ALT key down, and pressing the

tab key will move the selection to the next window in the list. When the desired

window is highlighted, release the ALT key and that window will become active.

Clicking on the applications icon on the taskbar can also do switching to

another application. The following picture shows the Windows taskbar, located at

the bottom of the screen.

This picture shows the ALT-TAB pop up window, which list the available programs

the user can switch to.
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Previous/Home Page/ Next

Window objects and components

This section discusses window options such as buttons and dialog boxes.

Text Boxes

Text boxes allow you to enter text information. To enter text, first click inside the

text area using the mouse, and the cursor will change to a vertical flashing bar/

showing you that text can now be entered.

In this image, a text box allows the user to specify a file to find on the computer.

The name of the text box entry field is called Named :

   Radio Buttons

Radio buttons allow users to select one of a number of options from a selection.

In the following image, a choice between Tiled and Centered is offered. A radio

button is enabled when there is a black dot in its center. A radio button is enabled

when it is empty. To enable a radio button, simply click once on it. To disable a radio

button that is enabled, simply click once on it. It works like a toggle switch.
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   Check Boxes

Check boxes allow users to select one or more options from a selection. In

the following image, the options Show window contents while dragging, Show icons

using all possible colors and Stretch desktop wallpaper to fit the screen are all enabled.

A check box is enabled when it has a tick in it, when a check box is empty,

that option is not selected. To enable a check box, simply click once on it. To disable

a check box that is enabled, simply click once on it. It works like a toggle switch.

Dialog Boxes

Dialog boxes allow you to make choices and enter data. They combine text
boxes with radio buttons and check boxes.

To close a dialog box, press the ESC key.

Display Tile Center

243



List Boxes List boxes present a number of

choices. You select one by double-

clicking on the item you want. Often

the list of choices is in a scrollable

window box.

In this example, the Help dialog box of

Windows lists a number of help topics

that the user can double-click on the

reveal to help associated with that item.

 Drop Down List Boxes

To minimize the

amount of screen space, list

boxes can somet imes be

arranged as a drop down list

box. This displays a single

item, but when the list box

is clicked on, the range of

items pops up in secondary

window.

A drop down list box

is shown below. In this

example, it is part of the

Dialog box associated with

the Display Properties.

244



Tab Controls

Tab controls allow a number of different dialog boxes associated with a

device to be presented as a single combined control. For instance, if we looked at

the screen display in Windows, there are so many things that can be changed, like

screen saver, wall-paper, size and resolution, video display driver and so on.

Putting all of these on a single dialog box is cumbersome and there is just

not enough screen real estate. So, a number of dialog boxes are used, but they are

combined using the tab control. It looks like multiple sections, and each tab has a

heading. Clicking on the tab item reveals the dialog box associated with that tab.

In this example, the tab

control for the Windows

desktop propert ies is

displayed. Note there are

FOUR distinct dialog boxes;

the current choice is Screen

Saver.

Notice the symbol at the end of

the box. Clicking on this symbol

reveals the list of options
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Toolbars

Toolbars appear on a number of windows and application programs. An

example is the My Computer window.

The toolbar is displayed underneath the Menu Bar Options of the window. An

expanded view looks like.

The toolbar consists of a number of icons (little pictures), each representing a

command. As the mouse cursor is moved along each icon, a text description will

pop up revealing the available control that is underneath the mouse  cursor.

Toolbars provide shortcuts to regularly used operations like cut and paste, close,

and Help.

1. What is Windows XP?

Windows XP is the latest version of Microsoft’s graphical user interface. It
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has several advantages, for the user, over previous versions of Microsoft Windows,

these include;

• Windows XP keeps your frequently used programmes within the start menu

making it quick and easy to access programmes for a second time.

• All software installed on the computer is now listed alphabetically within

the  All Programs menu, making it far easier to locate the piece of software

you require.

• Windows XP is faster that previous versions of Windows. This means that, as

well as the software you are using starting faster, you can switch between

software applications much more quickly.

  • Windows XP is more stable than previous versions of Windows making it

less likely that the computer will crash completely.

2.Login Procedure

• Ignore any messages until the  screen asking you to “Press Ctrl. Alt+

Delete to logon” is displayed.

• Press and hold the Control (CTRL) and ALT keys and then press

Delete.

• The following  dialog box will appear
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•Type in your User I.D and then use the mouse to click in box below and type in

your Password.

• Click on the OK button

3. Using Software in Windows XP

 Click on   and a pop up menu will appear..

•Select All Programs, by moving you mouse over it, this will open a sub menu

containing the software installed onto the PC you are using.
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4.Useful Menu Items

These features also appear when you click on the Windows XP Start button

My Recent Documents : This shows the latest documents you have used.

My Computer : Gives access to the Hard Disks and other

 peripherals connected to your computer.

Help and Support : If you are not sure how to do something, the

‘Help and Support’ menu can be very useful.

You can select a Help topic i.e., Windows

Basics, Ask for Assistance or select the task

you’re trying to complete.

Search : Allows you to search for files/folders

5.My Computer

My Computer allows you to explore and maintain your computer by viewing

programs, files and folders. It helps you organise files and folders so that they are

easier to work with.

You can open My Computer by

Double clicking on the My Computer icon on the Desktop Clicking on the

Start button then click on My Computer from the right pane.

Local drives

A :Floppy

C :Hard disk for XP Programmes

D :Hard disk for saving files

E :Zip drive

R : CD ROM/ DVI
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Double clicking on the drive folder will open that drive allowing  the user to see

a list of the files and folders saved.

You can change the way the files/folders are displayed in the View menu

Click on View from the Menu Bar and choose either.

Details (a list containing file information inc. size)

Thumbnails (display images) Tiles (large icons)

Icons List
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Details (a list containing file information inc. size)

Once you have selected the view type you can then arrange the items

Click on View from the Menu Bar and choose Arrange Icons

Name – sorts items alphabetically by name

Type – sorts items by type

Total Size– sorts items by size from smallest to largest

Modified– sorts items by date from oldest to most recent.

6. Creating a new folder

• Double click on the drive or folder in which you want to create a new

folder.

• Click on File the Menu Bar and point to New, then click on Folder.

• Type a name for your New Folder and press the Enter key.

7. Rename a file or folder

• Click on the file or folder you want to rename.

• Click on File from the Menu Bar and then click Rename.

• Type in the new name and press the Enter key
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8.Moving a file or folder

There are several methods available for moving files or folders.

Using Drag and Drop

•Click on the file or folder you wish to move with the left mouse button and continue
holding the mouse button down.

• Drag the icon to the new location (this may be a another folder or drive)

• Release the mouse button.

Using Drop down menu commands

• Click on the file(s) or folder(s) you want to move

• Choose Edit from the Menu Bar and click on Cut.

• Open the drive and/or folder where you want to move the file.

• Click on Edit and then click on Paste.

9.Copying a file or folder

Using Drag and Drop

• Click on the file or folder you wish to move with the right

mouse button and continue holding the mouse button down

• Drag the file/folder to the new

• Release the mouse button

• Select copy here form the menu that appears

Using Drop down menu commands

• Click on the file(s) or folder(s) you want to move

• Choose Edit from the Menu Bar and click on Copy

• Open the drive and/or folder where you want to move the file

• Click on Edit and then click on Paste.

10.Selecting multiple files or folders

To select ALL riles/folders in a location

Click on Edit from the Menu Bar and then click on Select All

To select random riles/folders within a location

Hold down the Control (CTRL) key and then click on each item you want
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to select

To select a group of files within a location

•Select the first file/folder in the group

•Press and Hold the Shift key

•Select the last file/folder in the group

11.Deleting a file or folder

Select the file or folder you would like to delete with the left mouse button and
either;

Click on File from the Menu Bar, and then click on Delete

OR

Press the Delete key on the keyboard

12.Recycle Bin

The Recycle Bin can  be seen on the desktop and is used to store deleted files or
folders. Once a file has been moved to the recycle bin it can either  be;

Removed permanently to create space on your Hard  Disc

Or

Retrieved if you didn’t mean to delete the file.

To empty the Recycle Bin

•Click on the Recycle Bin with the right mouse button.

•Select Empty Recycle Bin from the pop up menu

•Click Yes when asked “Are You Sure’

To recover a file from the Recycle Bin

•Double click on the Recycle Bin to view any files currently stored there.

•Right click on the File/Folder you want to recover

•Select Restore.

13.Search

The Search feature allows you to search your computer for Files/Folders.
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To run this program

• Click on the Start button

• select Search on the main menu.

The Window is divided into 2 main sections

The Left hand section asks What Do You Want to Search For

Making a selection based on the type of file you are searching for

Pictures, Music or Video

Allows the user to run a search based on the type of

file and/or the name of the file  (whether part or the

whole of the file name)
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Documents

Allows you to search based on the last time that you

accessed the file and/or the file name (whether part or the

whole file name)

When you have entered the details you want to use to search for the file/folders you

require, click on the Search button.

The search may take some time as the computer searches all drives to locate

your file. Once the search has finished a list of files which match your search will

appear. To open one of the displayed files simply double click on its file name.

14. Printing

To ensure your work is printed you must

•Click on Start

•Select Middlesex Network Software

•Click on Select Printer and choose the printer you require;

To print your work from a software application i.e. Microsoft Word.

Select Print from the File menu within the application you are working.

This will cause the Print options dialog box to appear.
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This box allows you to set;

• The name of the printer the work will be sent to (make sure this

matches the printer you selected earlier)

• The pages of your document that will be printed

• The number of copies required

14.4 SUMMARY

 So in this lesson you learned that computer is a device which works with the help

of various hardware devices commonly known as input and output devices.

Alongwith hardware, computer requires an operating system also with is actually

a system software. The commonly used system software is windows. The operating

system makes a link among all the hardware devices to give meaningful results.

Through operating system, various personalised settings can be made to computer.

14.5 GLOSSARY

- operating System is a system software for Computer.

- Windows is commonly used operating system.

- Various input and output devices are required to make a computer set all there

devices are known as hardware.
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14.6 ASSIGNMENTS

1. Which is  an operating system ?

__________________________________________________________________

__________________________________________________________________

__________________________________________________________________

2. Which is  a window  What are its various components.

__________________________________________________________________

__________________________________________________________________

__________________________________________________________________

3. Differentitate between system Software and application software with Suitable

example?

__________________________________________________________________

__________________________________________________________________

__________________________________________________________________

14.7 ASSIGNMENTS

1. DOS refers_____________

2. Windows XP is a System Software ( True/ Falsa)

3-Windows XP is an operating System ( True/ Falsa)

4-RAM is required to run the programes ( True/ Falsa)

14.8 SUGGESTED READINGS

Anita Goel : Computer Fundamentals
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Course No. : SOC-C-302 Lesson No. 15

Unit - IV WORD PROCESSING Semester-III

.STRUCTURE

15.1 Introduction

15.2 Objectives

15.3 All about MS word

15.4 Summary

15.5 Glossary

15.6 Assignments

15.7 Lesson End Exercise

15.8 Suggested Readings

15.1INTRODUCTION

In last lesson, we discussed about operating system which is necessary to run a

computer . But merely running a computer do not serve any purpose. It demands

various application softwares for required purpose. M.S - Word is one of the

application softwares which is used to type a text document and perform some non

techanical operations over it. Such as formatting , coloring , tabulating etc. In

present lesson we are going to learn how to perfprm dofferent operations in Ms

Word.

15.2 OBJECTIVES

After completing this lesson you shall be able to know:-

- How to create  a Ms-Word
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- How to open or close a Ms-Word file.

- Printing a Ms-Word file.

- Performing other operations in Ms-Word

15.3 ALL ABOUT MS- WORD

In word processing, what you type on the keyboard is displayed on the screen. As

well as a keyboard you also have a mouse. This is used by sliding it across a flat

surface, which makes a small pointer move across the screen. The pointer changes

shape as it moves. In a text area (a part of the screen in which you can type) it will

be an I-shaped line. If you press (click) the left mouse button, a flashing cursor will

move to the position you have chosen. The  cursor shows where your text will

appear when you start typing.

If you move the cursor out of the white text area it becomes a small arrow.

By positioning this arrow over certain areas of the screen you can activate commands

by clicking the left mouse button. These commands allow you to edit, format, save

and print your text.

Starting Word

Click on Ms Word icon avaliable in start window programmes list.

If you can’t see the Word XP icon, click on the Microsoft Office Suite folder. To

start Word double click on the Word 2000 icon. You may be prompted for user

information: click Cancel to clear this. Finally, the Help system may be active (the

small window with an animated paperclip): click the close box on this to shut it

down.

• Start Word and clear any welcome message, user requests and Help windows.
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The Main Document Screen

To close the New Document box at the right of the screen, click on X. To re-open

select File, New.

At the top of the screen is the Title Bar, which tells you the name of the program

you are using and the name of the document currently open on the screen. This

document is called Document 1 as it hasn’t yet been given a name.

On the right hand side of the Title Bar are three buttons. The left hand button (the

horizontal line) is the minimise button. Clicking on this button will cause  Word to

be minimised to an icon on the desk top.

The button in the middle can take two different forms depending on the size of the

Word window. A single large square is the Maximise button and causes the Word

window to fill the full screen. Once the Window is maximised the button  changes

to two smaller overlapping squares. This is the restore button and clicking it causes

the window to return to its previous size.

The right-hand button is the close button: clicking this will exit  from Word.

Note : these buttons control the Word program; the second set of button underneath

apply only to the current document.
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Menus

Below the Title Bar is the Menu Bar.

This holds all the pull-down menus for Word. To see the menus, click with the left

mouse button on the menu required. When a pull-down menu is displayed it will have

several options which can be selected by clicking on them with the left mouse button.

Some of these options have symbols to the left or right of them:

....this  option will display a dialog box.

this option has a further sub-menu.

this option is currently active (clicking it again will turn it off).

Ctrl+S A key combination to the right of a menu option indicates a keyboard
shortcut to perform the same operation.

this option will display a menu which has more options below.

To pull open a menu using the keyboard : hold down the [Alt] key and press the
underlined letter of the menu option, e.g. pressing [Alt+E] will pull down the Edit
menu.

These menus have become standard for Windows products. All Windows applications
(spreadsheets, databases, word processors, etc)  will have similar menus.

To select an option from a menu, point to the option and click. To close a menu
without choosing a command click on a bank area of the screen. Any options displayed
in light grey are currently unavailable, but may become available at a later time. For
example, you will not be able to use Copy from the Edit menu unless you have
already selected the text you want to copy.

Toolbars

Immediately below the menu bar are one or more rows of toolbars. The
commands you need to perform most of the basic operations in Word can be found
in these toolbars. By clicking on a toolbar button you can activate many different
commands e.g. save, print. Some options on the toolbars are in the form of pull-down
lists (at the end of the toolbar is an icon  ; click here to see more toolbar buttons).
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The standard and formatting toolbar looks like this :

 • Move the mouse pointer over each of the buttons on the toolbar (but don’t click on them).

A short description (called a Tool Tip) pops up to tell you what each button will do.

All the commands found on the toolbars can also be found in the menus above.

A toolbar button which looks “pushed in” means that option is currently active :

clicking it again will turn it off.

 If you need any information about what a particular command will do, or want to

know more about performing certain tasks, then Word has a good on-line help system.

To access this either select a command from the Help menu, or click on the Office

Assistant icon.

The Ruler

Below the toolbars is the ruler.

This displays current margins, tabs and indent settings (explained below).

The Status Bar

At the bottom of the screen is the status bar.

This displays information about your document, including : Page number, Section

number, the total number of pages from the beginning of the document followed by the

total number of pages in the whole document, the position of the cursor from the top

of the page, the line number and column number.

Typing and Editing Text

Word Wrap

Word automatically wraps the lines of text to fit between the margins of the pages as

you type, starting a new line when needed. If you add or delete text, change the

margins, or change the format of your text, Work automatically adjusts the position of

the text for you. Unlike using a typewriter you only need to press RETURN (the large

key marked with a ( ) at the end of each paragraph.
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Correcting Mistakes

If you make a mistake when typing you can delete the character to the left of your

cursor by pressing BACKSPACE (the wide key marked with a  just above the

Return key). You can delete the character to the right of your cursor by pressing

DELETE (to the right of the Return key).

Capital Letters

For single capital letters hold down SHIFT [] key and press the letter. For all

capital letters press the CAPS LOCK key.

Insert/Overtype

By default Word inserts characters you type by moving existing text to the right.

You can change this so that new text replaces old text, character  by character

(Overtyping). To turn Overtype on press the INSERT key (to the right of the

Backspace key). To turn it off press INSERT again.

 Undo

This button on the toolbar allows you to undo a particular command or action. If

you don’t like the results of a command or accidentally delete some text, choose

Undo as your next action. This command is also available in the Edit menu.

Select Edit, Undo... (where... describes the action to undo) from the menu

or

press the Undo button from the standard toolbar (use the Tool Tip to find it!).

Some actions, such as saving a file, can’t be undone. In this case Undo changes
to Can’t Undo in the menu and appears grey in the pull-down list.

Redo

The Redo button works in the same way. Select Edit, Repeat... (If you cannot
repeat the last action then the Repeat command changes to Can’t Repeat).

Saving Your Work

To save a new document for the first time

Select Save from the File menu, or click on the save icon  on the Toolbar. You
will see a dialog box similar to this (the folder and file names will be different) :
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You can now give your document a file name. Word will suggest a name in the File

Name : box. You can accept this, edit it, or replace it with a name of your choice.

Then click Save. Note that your file name replaces “Document 1” (or the current

default filename) in the title bar.

To save an existing document (after further edits)

Select Save from the File menu, or click on the save icon on the Toolbar.

If you choose SAVE AS from the File menu you will be prompted for a filename

every time you save a file. This allows you to change the filename at a later stage

(the original file will still be there).

FILE, CLOSE (i.e. pulling down the File menu then selecting the Close

option) closes the current document, asking you if you want to save any

changes if any have been made since you last saved the file.

Filenames

File names can be up to 255 characters long but cannot include any of the following

characters : forward slash(/), backslash (\), greater than sign (>), less than sign(<),

asterisk (*), period (.), question mark (?), quotation mark (”), pipe symbol (|), colon

(:), or semicolon (;) When saving a file Word will automaticaly give each filename

the extension. DOC to enable Word to recognise its own files.
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Opening Files

To open an existing document you can either select Open... from the File menu or click

on the open icon  on the toolbar..

Both actions will present you with a dialog box similar to this (again the folder and

filenames will be different).

To open a document simply click on it and then click Open.

Clicking on the NEW file button  on the standard toolbar opens a new document

window with a blank document.

FILE, NEW displays a dialog box with a choice of templates for your new document

: selecting Blank Document on the General tab will open a standard document.

Formatting Text

Once your document has been typed, it can be enhanced with effects such as bold,

underline, different fonts and centring.

For new text, we can switch these options on, type the text, then switch the option off

again. However, if we want to alter text we have already typed, we must SELECT it

first.

Selecting Text
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To select : Do this :

A range of words DRAG the mouse across the area to be selected. (Move

the mouse pointer to the start of the text you want to

select; click and hold down the left mouse button;

move the pointer to the end of

the text you want then release the button–the text will

be highlighted as you drag the pointer across it.)

Alternatively : click where you want the selection to

begin. Hold down the SHIFT key. Click where you

want the selection to end.

Word Double-click on the word.

Sentence Hold down CTRL and click anywhere in the sentence.

Paragraph Triple–click anywhere in the paragraph or double-

click in the left margin.

Line of text Click in the left hand margin, next to the relevant line.

Whole document Triple click or CTRL and click in the left margin.

Selected text is reversed (white on black). You can now alter the appearance of the

selected text by choosing one or more of the commands from the Format menu. Or

you can click on one of the format icons on the toolbar. For example, by clicking on

the Bold icon on the toolbar the text will appear in BOLD.

Bold Underline and Italics

Select the text you want to format then click the Bold, Italic, or Underline button.

Text Alignment

The same steps are repeated when aligning text on the screen. The two icons

displayed shows text being left aligned (Align Left), and text being centred between

the margins (Center). To make the text flush to the right margin (Align Right), and

aligning to both margins (Justify), use the pull-down menu for more options.

Fonts and Sizes
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The different typefaces used in word-processing documents are known as

fonts. Fonts are usually measured in points. A point is 1/72 of an inch.

Standard text is usually Times New Roman in 10pt size. Font types and sizes

can be selected before typing text or can be added retrospectively to specific

sections of text (by selecting the text first).

To select font types and sizes from the formatting toolbar, click on the arrow

next to the current font name and a list of available fonts will be displayed.

The pull-down list to the right lets you choose the font size.

Format Menu

Select FORMAT, FONT..... from the menu bar.

You will be shown a dialog box where you can select from a list of fonts as well

as being able to specify its style (bold, italic) and its point size, the colour of the

text, plus some other effects.

Paragraph Numbering of Bulleting

 Word can automatically number paragraphs or put bullet points on them. Select

the paragraphs to be included then click the Bullets or Numbering button on the Toolbar.
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By default, the number or bullet point will go to the left of the first line of each paragraph

selected. To change the style of the bullets or numbers, select Bullets and Numbering....

from the Format menu

• Open the file.

• Using the Toolbar, add bullets to the quotations.

• Using the Format menu, change the bullets from circles to squares.

• Save the file.

Line Spacing

Standard Word documents are in single line spacing. Line spacing can be changed

for individual paragraphs by selecting the paragraphs first.

Move the cursor to anywhere within the paragraph you want to change; if you want

to change more than one paragraph, select them with the mouse.

Select Format Paragraph... Pull down the list box under line spacing  and select one of

the following options :

Single Single line spacing.

1.5 Lines One and a half line spacing.

Double Double line spacing.
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Moving Blocks of Text

Copy and Paste 

This is a way of moving sections of text or copying things into your document. It is

available in all Windows applications, and you can use it to copy things between

different applications. There are two commands involved: Copy and Paste. Each can be

selected from the EDIT menu or from buttons on the standard toolbar.

When you copy text, it is put into an area known as clipboard, which is available to

all Windows programs. Copy simply puts a copy into the clipboard.

The Paste command copies whatever is in the clipboard into the document at the current

cursor position. If text is selected when you paste from the clipboard, its contents replace

the selected text. Text remains in the clipboard until the next Copy, so you can paste

the contents of the clipboard several times.

You can paste between Windows applications. For example, you can insert a picture

into a document by copying it from Paintbrush and pasting it into Word.

Cut

The Cut command is another way of moving sections of text. Unlike the Copy command,

Cut deletes the text from the document and puts the text into the clipboard. You can then

use the Paste command to insert the information elsewhere. The Cut icon can be found

in the pull-down menu located next to the help icon on the toolbar.

Note : the DELETE or DEL key on the keyboard deletes text without copying it to

the Clipboard.

Drag and Drop

Select a block of text to be moved and place the mouse pointer over the text.

Hold down the left mouse button and DRAG the pointer to the new location for the text.

A grey vertical line will indicate where the text will appear in the document.

Release the left mouse button and DROP the text into its new location.

Dragging and dropping is a quick alternative to Cut and Paste but can be little tricky

to control if you are new to using a mouse.

Spell Checking



Word has a built-in  dictionary which can be used to check the spelling in your work.

Word also checks for repeated words (the the), odd capitalisation (tHE), and proper

nouns (london).

To spell check a document select the word or section of the document you want

to check. If nothing is selected, Word checks the document from where the cursor

is, and when it reaches the end will ask if you want to continue from the beginning,

unitl it has checked the whole document.

Select Spellng

Word looks for words in your document that don’t match those in its dictionary.

It highlights those words and displays the Spelling dialog box.

To correct the misspelled word, either type it in the text area or select the correct word

from the Suggestions list.

Press the Change button to replace the misspelled word with the correct one, or press

Change All to change all occurrences of the misspelled word in your document.

If the word highlighted is spelt the way you want, choose Ignore to leave the words

as it is, or choose Ignore All to ignore all occurrences of this word in your document.

If Word highlights a word it does not recognise and you know that it is spelt correctly,

you can add the word to the dictionary by selecting  Add. The word is added to the

dictionary displayed in the Add box.

Word continues checking your document. Choose Cancel at any time to stop the spell

check.

Thesaurus

When you’re not sure of the meaning of a word, or when you think you’re offers

alternatives (synonyms). To use it :

Select a word in your document then select TOOLS, LANGUAGE,

THESAURUS.... from the menu bar.

The Thesaurus dialog box appears, showing the meaning of the word on the left

and a list of synonyms on the right.

To see a list of other related words click on any related words in the meaning box.

To see synonyms for one of the alternative words, select it and click the

lookup button.
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To  choose an alternative, highlight it and then click REPLACE.

Word Count

Select Tools/Word Count.

Headers and footers

Headers and footers are pieces of text that appear at the top or bottom of each page.

To create a header or a footer choose Header and Footer from the View menu. A

text area at the head of the page will be highlighted and you will see the following

toolbar :

You can switch between the header and the footer by clicking on this icon .

Text can be typed into the header  or footer text area. You can also use the buttons

which will automatically include page numbers and the time/date. (Page numbering

is covered in more detail later.) When you have finished click on Close. The header

and footer areas will disappear but you can see them easily by changing the View

of your document.

Changing the View in Word

You can View a Word document in several ways: you can switch between

 them using the View menu or the buttons in the status bar at the bottom of the

screen.

Normal View

Normal View is the default view in Word. Using Normal View it is quick and easy

to edit and format text. Your document will look similar  to how it will be printed

but you will not see the headers and footers.

Web Layout View
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Web View Layout shows how your document will look in a Web

browser. MSWord saves a copy of your document and then opens it in your default

browser.

Print Layout View

Print Layout View shows the layout of each page in your document exactly as it

will look when printed. Headers, footers and footnotes are displayed in the correct

place on the page.

Outline View

Outline View collapses the document to headings only to show the general structure

of a document. This can be useful for very long  documents.

Print Preview

Whichever View you are using, you can always see how your document will look

when it is printed by selecting Print Preview from the File menu or clicking the 

You cannot edit your document in Print Preview. Click the Close button in the Print

Preview toolbar to return to your document.

Zoom

The magnification of the document in a View (or in Print Preview) can be changed

by zooming in or out of the screen :

Select VIEW, Zoom... from the menu, or use the Zoom pull-down menu list from

the standard toolbar and select a percentage or automatic size from the list provided.

Zoom does not change the font size in your document.

Pages, Page Breaks and Pagination

As you type in Word, when you reach the end of a page you will automatically be

taken to the top of the next page. The status bar will tell you which page you are

on and, in Normal View, the page break will be shown as a horizontal dotted line

across the page.

If you want to start a new page before you reach the end of the current one, you

can force a page break. To create a page break:

Select INSERT, BREAK....from the menu.
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Select PAGE BREAK from the Break dialog box and press OK.

or

Press CTRL + RETURN.

To remove a page break from a document, move the cursor onto the dotted

line and press DELETE.

Sections

When you start a new document the same formatting setting (margins, page

numbering, etc.) apply to the whole document. To apply different settings to different

parts of the document you must create a section for each part. Each section can then

have its own settings.

The different types of sections are :

CONTINUOUS Starts the new section wherever the cursor is.

NEW PAGE Starts the new section at the top of the next page (Word

automatically inserts a PAGE BREAK).

ODD/EVEN This is used particularly for double sided  printing where page

PAGES numbers, margins and headers/footers are different on odd and

even pages.

To create a new section, move the cursor to where the section should start.

Select INSERT, BREAK....from the menu.

Select the relevant SECTION BREAK.

You will only see section break lines in Normal view (not in Page Layout view).

Make sure you are in Normal view before continuing.

To remove a section break, move the cursor to the section break line and press

DELETE.

Page Numbering

Word can automatically number your pages. Page numbers appear in the header or

footer area of your document.

Inserting page numbers into headers and footers

Move to page one and select View, Header and Footer
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Select the Header or Footer area. If the Header or Footer already has text

in it, move the cursor to where the page number should appear.

Click on Insert Page Number . The page number appears in the header

or footer. You can select this page number and format it as you would any other
text. You can also add any additional text you want in the header or footer.

To delete the page number, select it then press the DELETE key.

Click on CLOSE to leave the Header and Footer area.

Page Numbers do not display in Normal or Outline View. To see page
numbers switch to either Print Preview or Page Layout View.

Adding page numbers only

If your  header or footer will contain only a page number and no other text,
you can use this shortcut to insert page numbers:

Put the cursor on the first page of your document.

Select Insert, Page Numbers

In the position box select either Top of the Page or Bottom of the Page.

In the alignment box select the desired position.

Click OK.

This header/footer can be edited in the usual way.

Margins

Margins are the spaces between the edge of your text and edge of the paper

to be printed on. Default margins (top, bottom, left and right) are applied when you

open a new Word document. You can change the margins for the whole document

or for individual sections.

Select File, Page Setup....

Click on the Margins tab in the Page Setup dialog box.

Type in the required margin measurements (or use the scroll tabs to alter the

values up and down).

Choose the area the margin changes APPLY TO :
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This Section : applies the new margins to the current section only.

This Point Forward: creates a section break and applies the new margins. (Note :

click on the Layout tab and make sure that the ‘Section Start’ setting is of the type

required.)

Whole Document: applies the new margins to the whole document.

Click OK. (Note : you will have to use Print Layout View to see the effect of

margin changes).

Multiple Documents

In Word you can work with several  documents  at the same time and copy or move

text between them. Each new document you create or open has its own document

window. As you open successive documents, they appear as the topmost window,

hiding any previous documents behind them. (Note that each document has its own

set of Minimise/Restore/Close buttons below the set for the Word program.) To

switch between documents :

Put down the Window menu: a list of open documents appears in the bottom

section of the menu.

Select the name of the file you want to switch to.

Indentation

Indentation is the position of the text relative to the margins.

Left Indent Only : this paragraph is indented from the  left

margin and not indented from the right.

 Left and Right Indent : this paragraph on the other 

hand is indented from both the left  and right margins.

First Line Indent : this paragraph has no indentation from the right

margin but has a first line indent from the left margin.

Hanging Indent : this paragraph has no first line indent but all subsequent lines

are indented from the left  margin. This is a hanging indent

and is useful for any item whose first line needs to begin at the left margin.

To indent a paragraph, place the cursor in the  paragraph you want to indent and
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then drag the indent markers on the Ruler to the required position. Any changes

only affect the current (or selected) paragraphs.

The Increase/Decrease Indent buttons on the formatting toolbar are a quick way of

changing the left indent. The right hand button increases the indent by one tab stop,

the left hand decreases the indent.

Indents can also be changed using the Format menu. Put the cursor  in the paragraph

you want to indent and choose Format, Paragraph and change Left and Right

indent measurements. To set first line only or hanging  indents use the Special box,

then set the amount in the By box

Tab Settings

Tabs are another way to indent text. Using Tab settings is the method to use if you

want to align text in columns or you only want the first line  moved from the left

margin. Tabs cannot be used to indent whole paragraphs.

Do not use the space bar to align text in columns: the columns will almost never

appear properly aligned when you print your document.

There are 4 types of tab stop:  Left justified;  Right justified;  Centre

justified and  Decimal justified. Tabs are shown on the ruler. Different symbols

indicate different types of tab.

[Left]

Williams

Evans

Smith

Richard

[centre]

Williams

Evans

Smith

Richard

[right]
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Williams

Evans

Smith

Richard

[deci.mal]

12.433

4897.213

45.64

1200.09

Tabs can also have leaders (dots, dashes or solid lines between the margin and the

tab position):

.................12

.................24

.................36

Setting Tabs Using the Ruler

To ADD a tab: Click the tab button at the left hand end of the Ruler until

the symbol for the tab you want appears.

Click on the Ruler at the position you want the tab.

To MOVE a tab: DRAG it to its new position.

To DELETE a tab: click on the tab and DRAG  it off the Ruler.

Setting tabs with the Format menu

Use the Format menu if you want precise control over tab positions or if you
want to set tabs with leaders. Put the cursor where you want the formatting to
start or select the existing text you want to add tabs stops to.

Select Format, Tabs...

Type the position you want the tab stops to be placed at in the Tab Stop Position
box (zero is the left margin).

Under Alignment, select Left, Centre, Right or Decimal.

Under Leader, select the option you want (if any).

Click the SET button.

Choose OK.
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The tabs you have set will appear on the ruler.

Using Tabs

To  use a tab press the TAB key on the keyboard and the cursor will jump to the
next tab stop on the ruler.

To return text to its untabbed position (without deleting the tab position from the
Ruler)  press the BACKSPACE key.

Printing

Select FILE, PRINT from the menu

The Print Dialog Box appears.

Options allow you to: print all of the document, the current page, a range of pages,
or selected text; print just oddor even pages; print multiple copies. Click OK when
ready.

Note : if you want to do a standard print of all pages  using the default settings click
the Print button on the toolbar. This will send your document directly to the printer
without opening the Print Dialog Box first.

Remember that you can see how your document will look when it is printed by
selecting Print Preview... from the File menu. You can print your document using
the  Print button or the File menu from the Print Preview screen as well as from
the main document screen.

15.4 SUMMARY

After studing this lesson it is clear that Ms-word can be used to create a test
document with different fonts and Styles. It offer many functions inculding  printing
mail merging , inserting tables, images, paint files etc. It is user friendly application
software.

15.5 GLOSSARY

- Ms -word is one of application offered by Microsoft office.

- In Ms- word almost every utility is avaliable if the job is typing the document with
multimedia options too.

15.6 ASSIGNMENTS

1. What is  Ms- Word and What are various function that can be performed in this
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application software ?

__________________________________________________________________

__________________________________________________________________

__________________________________________________________________

2. What is mail-merge and how it works.

__________________________________________________________________

__________________________________________________________________

__________________________________________________________________

3. What are clipboard operations?

__________________________________________________________________

__________________________________________________________________

__________________________________________________________________

15.7 LESSON END EXERCISE

1. Short cut key for opening a file are___________

2. Short cut key for closing a file are___________

3. Short cut key to save a  word file are___________

15.8 SUGGESTED READINGS

1. Anita Goel : Computer Fundamentals.
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Course No. : SOC-C-302 Lesson No. 16

Unit - IV INTRODUCTION TO MICROSOFT EXCEL   Semester-III

STRUCTURE

16.1 Introduction

16.2 Objectives

16.3 All about Ms- Excel

16.4 Summary

16.5 Glossary

16.6 Assignments

16.6 Lesson End Exercise

16.6 Suggested Readings

16.1 INTRODUCTION

Microsoft Excel® is a piece of software which allows you to create professional

spreadsheets and charts. It performs numerous functions and formulas to assist you

in your projects.

16.2 OBJECTIVES

After successful completion of this lesson you should be able to :-

- Create , open or close excel file

- Print excel file

- Perform clipboard operations

- Create formula.

- Use charts, graphs.

- Database operations.
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16.2 ALL ABOUT MS-EXCEL

Getting started

1.Click on the Start button towards the bottom left of the screen.  Windows

operating system.

2.Click on each of the following: Programs> Office XP®> Microsoft Excel.

3.Within a few moments, Microsoft Power Point® will open.

Starting a new presentation

 1.When you first open Excel t®, a new workbook will automatically appear.

 2. If at any time you wish to start a new file, click the        New button from the

toolbar.

Opening an existing Workbook

There are several ways to open an existing presentation.

1. From the ‘New Workbook’ menu to the right, select a file name (the four

most recently opened files are listed in order).

2. From the ‘New Workbook’ menu to the right, select the ‘More Work books’

281



option to manually locate your file within a specific folder. Double click

onto the file once located to open it.

3. From the Menu Bar, select FILE  then OPEN to manually locate your file

from a folder. Double click onto it once located.

Some important terms used in excel

Work book :  An Excel file is called a workbook.

Worksheet : The page you work on which is made up of grid cells.

Cell/Selected Cell : Where you type data/formulae into. Cells are arranged in

numbered rows and lettered columns. You have to select a cell to add data to it.

data/formulae can also be typed into the formula bar.

Column/Row Heading: Use the column/row headings to identify a cells position

on the worksheet i.e., A12, B6. Click heading buttons to select a whole column/

row of cells.

Name Box: Holds a cell’s selected reference number—it’s position on the worksheet.

Worktab Sheet: click the tabs to move between worksheets.

Scroll Bars: Use them to display hidden parts of the worksheet.

Entering data into the worksheet

New Workbook
Open workbook

Travel exploses decpal
Travel exploses decpal
Travel exploses decpal
Travel exploses decpal

New
Open workbook

Travel exploses decpal
Travel exploses decpal
Travel exploses decpal
Travel exploses decpal

Open workbook
Travel exploses decpal
Travel exploses decpal
Travel exploses decpal
Travel exploses decpal

Manually locate
a workbook

Recently opened
files
(last four)
Manually locate a
workbook

Microsoft ® Corporation

Opening an existnig workbook
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1. Click on a cell. A thick border indicates that the cell is selected.

2.Start typing. Note that data appears in the cell and in the formula bar.

Editing data in a cell

1. Double click the cell and make any necessary changes.

2.Press ENTER to accept the changes, or ESCAPE to cancel.

If you make a mistake or change your mind, you can normally undo your last

action by choosing UNDO from the EDIT menu.

Deleting cell contents

1.Select the cell(s).

2.Press the DELETE  key.

Selecting a cell

1.To select a single cell: Click onto it.

2.To select range of cells: Place the pointer on the first cell; hold down the mouse

button and drag to the last cell that you want to select; release the mouse button.

3.To select a row/column: Click the appropriate row/column heading button.

Copying and pasting cells

1.Select the cells you want to copy.

2.From the Edit menu Copy.

3.Click in the destination cell.

4.From the Edit  menu, choose Paste... A moving border around the selected area,

means that the cells may be pasted again. Press the Escape  key to cancel the

border.

Alternatively—

1. Select the cell that you want to copy.

2. Place the pointer over the black square

at the bottom right of the cell; when the

pointer changes to a black cross..

3. Hold down the mouse button and drag
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over the cell(s) that you want to copy to.

4. Release the mouse button.

5. Click the cell to cancel the selection.

Note : This method will only copy to neighbouring cells in the same row or column.

 Cutting and moving cells

1. Select the cell(s) and place the pointer over the cell’s border.

2. When the pointer changes to an arrow, hold down the mouse button and

drag the cell to a new location.

Inserting cells between existing cells

1.Copy/cut your cell(s) using the Edit menu.

2.Click on the cell that you want to move data to.

3.From the Insert menu, choose Cut or Copied Cell

4.Choose a direction to move existing cells; click OK

Inserting new cells, rows, or columns

1.Decide where you want to insert a cell/row/column, and click a cell.

2.From the Insert menu, choose Cells... Rows or Columns.

This will have the following effect on existing cells;

a new cell moves cells down or right, depending on your choice.

a new column moves column to the right.

a new row moves rows down.

 Deleting cells, rows, or columns

1.Select the cell(s) delete.

2. From the Edit menu, choose Delete...

3. Decide what you want to delete, and click OK.

This effects existing cells in the opposite way to inserting new cells  - see above.

 Changing column width

* To adjust row height, follow the same procedures but use the row heading
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buttons.

If a column isn’t wide enough to display numbers in a cell, ‘#’ symbols are

shown.

Separating column headings, situated to the right of column letters, are border

lines.

When the pointer is over one of these lines, it changes to a black cross.

• double click the line to match column width to the longest data entry.

• drag the line for manual control over column width.

Changing the width of several columns at once

1.Decide how many columns you want to adjust, and place the pointer over the column
heading of the first of these columns.

2.Hold down the mouse button and drag over the headings of the other columns.

3.Release the mouse button.

4.Drag the border line of the last column in the selection to adjust column width.

5.Click on the worksheet to cancel the selection.

Formating text, numbers and cells

General is the standard data format; it aligns numbers to the right, text to the left.
Cells containing text and numbers are aligned left.

Commonly used formatting options relating to the appearance and alignment

of text, can be chosen from the toolbar at the top of the screen.

font and size align left, centre
and right

increase/decrease
decimal places

bold, italic, underline currency & percent
styles

cell border style

Microsoft®
Corporation
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To change a cells number format, use the Cell option in the Format menu.

1. Select the cells you want to change.

2. From the Format menu, choose Cells...

3. Click the Number tab.

4.

Applying percentages

There are two ways of applying a percentage:

•type in the actual pecentage ie 54%

•apply the percent style button from the toolbar

The percent style can be applied before or after a number has been typed into the
cell, but the number must be expressed as a decimal, as the percent style multiply
numbers by 100. Eg. 0.54 would give 54%; 54 would give 5400%

Calculations

To peform calculations, you have to type in a mathematical formula. A
formula must start with = followed by a combination of cell names, numbers and
operators, Example formulae :

addition = A4 + C12 multiplication =C1*D1

subtraction =D3–H3 exponentiation =E3^2

division =B12/D18 percentage =A3*20%

1.Click on a blank cell to hold the result of the calculation.

2.Click in the formula bar or cell, type =, and then the formula.

3.Press Enter to perform the calculation.

To refer to a range of cells, there is no need to type out each individual reference

number from A1 to A15 for example, just  type A1 : A15 - the colons mean ‘to’.

Like data, you can copy and paste formulae. See page 367, copying and pasting

cells.

Totaling cells

1.Select the cells that you want to total – these must all be in the same column.

2.Click the Autosum button on the toolbar.
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The result will appear in a new cell, under the totalled cells. Microsoft®
Corporation

Calculating averages

1.To display the result, choose a new cell under the ‘calculation’ cells.

2.Click the Function Wizard button on the toolbar.

3.On the right side of the Paste Function box are a list of Function names; choose

Average.

4.Click OK.

5.A grey box will open; if necessary, move the box by dragging it.

Option Number 1 holds the range of cells that Excel will find the average of.

It the range is incorrect, highlight the cells on the worksheet that you want to find

the average of - this will modify the contents of option Number 1.

6.Click OK.

Tip :  to reduce the number of decimal places, use the decrease/increase decimal

places button in the toolbar.

Creating Charts

1.Type in your the data. The category axis (X-axis) labels in a single  column and

the value axis (Y-axis) labels at the top of each column after that.

2.Select your data, including the category and value axis labels.

3.Click the Chart Wizard  button on the toolbar.

4.Follow the Chart Wizard’s instructions.

Click Next to move through the stages.

Changing the Values of the Value axis (Y-axis)

1.Double click the chart’s Value axis.

2.From the Format Axis box, click the Scale tab.

3.Make any necessary changes, and click OK.

287



 Printing
(If you want to print the chart without data, select the chart before choosing

Print.)

1.From the File menu, choose Print...
2.Under Print what, on the left of the print box, decide what you what to print;

Active sheet(s) Entire Workbook Selection

Selected Chart

prints the current worksheet;

prints every worksheet that contains data;

prints selected data;

prints the currently selected chart.

Saving your File

1.Choose SAVE AS...
from the FILE  menu.

2.Click in the box next

to File Name, and enter

a name for your

publication.

3.Click on the drop-down

menu next to Save In, and

choose the Home

Directory Folder as
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indicated by your  student username e.g. aq 123456

4.Click the SAVE button.

5 To save again click the save         button

6.It is good  practice to save every 10 minutes or so and make a backup of your

work to Pen drive or CD.

Formatting

Any cell or range of cells can be given one of a number of formats, which affect

the way the cell content looks and prints but do not change the actual contents. We

will change the results of the Profit Forecast to show as monetary amounts with a

£ symbol in front.

Note that the precision with which numbers are stored is not altered by the process

– only the appearance changes.

Highlighting a range is achieved by moving the mouse pointer to the tope-left cell

of the range, holding the left mouse button and dragging the pointer to the bottom

right cell.

.......... Highlight the range.

.......... Chose Cells from the Format menu

Ensure you have the ‘number’ tab selected, click on ‘currency’ from

the category section as in the example below :
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........... Click on OK

The figures on the worksheet will now be prefixed by a £ symbol and

should display 2 decimal places.

Erasing cell contents

Deleting a row or column causes the surrounding rows or columns to close

up and fill the gap. In order to blank out the contents of a cell or range without

disturbing the rest of the sheet, the Delete key on the keyboard is use.

........... Highlight the range

Press the Delete key

The contents of the cells have been erased. The formatting applied earlier

will remain associated with the empty cells.

Creating a graph

Creating a graph needs several steps. To produce the graph, Excel needs to

know the location of the data to be plotted and what type of graph (Column, Bar

etc) to plot. Other information such as titles and legends can be added to the graph

but these are optional.

Excel does however have a chart wizard, which takes you through the

steps needed to create a graph.

The example we will use is the Profit Forecast and it is reproduced below with the

associated graph for the Sales Revenue, Cost of Sales and Gross Profit.
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Defining the plot area

As we are going to plot the Sales Revenue, Cost of Sales and Gross Profit

for 2000-2003, all of this data needs to be highlighted for the chart wizard  to

create the graph.

.....Highlight A3 : E8

.... Hold the Ctrl Key

.....Highlight A9:E11

.... Let go of the Ctrl key and the 2 separate ranges should be highlighted

:

It is important that the cell A3 is highlighted, even though it contains no data
as Excel creates graphs using a pattern matching process - it will match one row
by five columns against three rows by five columns. Don’t worry about this at the
moment, just make sure the 2 ranges are highlighted as in the diagram above.

Using the chart wizard

.....Click on the Chart Wizard Button 

Step one of the Chart Wizard will be displayed.

Step one - chart type

This box allows you to chose the Chart Type.
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.....Select the type indicated then click on Next.

Step two - data definition

The data range selection box is shown below :

As you selected the data before starting, this should be correct. Click on Next.
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Step three - entering titles and labels

Next is the chart title and axes labels. Enter in the appropriate areas :

Profit Forecast for the title

Years for the X axes labels

Pounds for the Y axes labels

There are lots of other options in this section, which you can look at later, for now

just click on Next.

Step four - chart location

Next is the option to insert the chart as a new sheet or as an object on the
sheet
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Choose the option you want and then select Finish

Your graph will be inserted in the workbook either as a new sheet or as an

object depending upon your selection.

You have now completed your graph

16.4 SUMMARY

Hence in excel all the mathematical operations can be done sufficiently by creating
customised formulae. This software is also thus helpful to perform statistical operation
with graph and charts. It is a basic ulility in the world of Statistics.

16.5 GLOSSARY

- In excel, charts and graphs cen be used to show your arethmatic data.

- You can copy the work done on excel to your word document if the need arises.

- you can do advanced programming to Ms- excel to customise it for any particular
operation..

16.6 ASSIGNMENTS

1. Give the brief description about Microsoft excel and its functions ?

__________________________________________________________________

__________________________________________________________________

__________________________________________________________________

2. What is the main difference between Ms word and Ms excel.

__________________________________________________________________

__________________________________________________________________

__________________________________________________________________

16.7 LESSON END EXERCISE

1.Ms - Excel is used to performVarious arithmatic operations (True/ False)

2. In excel simple to complex dat processing is possible if you know little

programming (True/ False)

16.8 SUGGESTED READING

1. Anita Goel : Computer Fundamentals.
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Course : 302 Lesson No. 17

Unit - IV M.S. POWER POINT    Semester-III

STRUCTURE

17.1 Introduction

17.2 Tool Bar, Icons and Commands

17.3 Navigating in Power Point

17.4 Working with Power Point

17.1 INTRODUCTION

Power Point is a presentation tool that helps you create eye-catching and effective

presentations in a matter of minutes. A presentation comprises of individual slides arranged

in a sequential manner. Normally, each slide would cover a brieftopic. Once having prepared

a presentation, you can ask PowerPoint to also generate hand out material and speaker's

notes. Similarly, you have, the option of either printing out the slides-in case you want to

use an overhead projector, or simply attach your computer to an LCD display panel that

enlarges the picture several times and shows you the output on a screen.

When you create a new presentation, you have three options:

1. You can start by working with a wizard (called the AutoContent Wizard) that helps

you determine the theme, contents and organization of your presentation by using a

predefined outline, or

2. You can also start by picking out a PowerPoint Design Template, which determines

the presentation's color scheme, fonts, and other design features, or

3. You can also begin with a completely blank presentation with the color scheme,

fonts, and other design features set to default values.

Should you decide to choose the third option, PowerPoint designers have provided a

wide assortment of predefined slide formats and Clip Art graphics libraries. Through these
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predefined slide formats, you can quickly create slides based upon standard layouts and

attributes.

PowerPoint shares a common look and feel with other MS Office components, and once

having mastered Word and Excel, learning PowerPoint is almost like playing a game.

And of course it is easy to pick up data from Word and Excel directly into a PowerPoint

presentation and vice versa.

The next page shows you the various parts of a PowerPoint screen. Also it is important to

familiarise yourself with the PowerPoint tool bars. All these are presented in the following

pages. Do not worry if everything does not make complete sense to you at this stage.

Once you do the hands on exercise, you will understand these options much better.
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17.2 TOOLBAR, THEIR ICONS & COMMANDS

Standard Toolbar
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Formating Toolbar
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Drawing Toolbar
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17.3 NAVIGATING IN POWERPOINT

Now that you have a general idea of the various command, & toolbars, let us see how we

can carry out simple operation like saving and opening files, creating and printing slides,

etc. For this follow the step-by-step instructions given below.

Creating a New Presentation

1 Choose New command from File menu.

2 The following dialog box would be displayed. Generally this option (Blank

Presentation) always comes highlighted, but if not, Click to highlight.

3 Click on OK button to continue.
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4 The following dialog box would appear. Click on the type of slide that you

want:

5 Click on OK button.

A The following blank presentation would be displayed.

Opening a Presentation

1 Choose Open command from File menu.

2 Choose the file that you want to open or type the name of the file in the

"File Name" window.

3 Click on Open button.

A The requested file would open up.
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Creating a New Slide

1. Click on the New Slide icon from the standard toolbar or alternatively, click

on the Common Tasks roll-down menu and choose New Slide command.

2. Choose the slide type that you want.

3. Click on OK button.

A A blank new slide

would be inserted.
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Deleating a Slide

1 Choose Delete Slide command from Edit  menu.

A The slide chosen has been deleted and the number of slides has changed from

8 to 7.

Copying a Slide

1 Choose Duplicate Slide command from Insert menu.

A A duplicate slide has been inserted.
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Slide Numbering

1 Choose Header and Footer command from View menu.

2 The following dialog box would be dislayed. Click on the Slide Number
check box.

3. Click on Apply to All button to apply numbering to all the slides or click on

Apply button to apply numbering to the current slide only.

A You can also click on the Date and Time check box to apply the current date

and time to the slides.

B You would notice numbering on all the slides.
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Saving a Presentation

1 Choose Save command from File menu

2 The following dialog box would be displayed. Type the name of the presentation.

3 Click on Save button.

A In case you wish to save the file into another directory, specify the correct

path and directory here.

Closing a Presentation

1 Choose Close command from File menu

A You would see PowerPoint’s exit screen.
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Saving a Presentation with a Different Name

1 Choose Save As command from File menu.

2 The following dialog box would be displayed. Type in the name that you want

to save the file as.

3 Choose the directory in which you want to save the file in.

4 Click on Save button.

A You would notice that the changed file name appears on the Title bar.

310



311



Changing the Default Directory

1 Choose Options command from Tools menu.

2 The following dialog box would be displayed. Click once on Save folio/tab.

3 Type in the name of the Default directory.

4 Click on OK button.

312



AutoSave

1 Choose Options command from Tools menu.

2 The following dialog box would be displayed. Click once on Save folio/tab.

3 Click on the scroll buttons to increase or decrease the AutoSave recover

time.

4 Click on OK button to continue.
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Printing a Presentation

1 Choose Print command from File menu.

2 Click on the roll-down list and choose your printer.

3 Click on the Properties button to choose whether you want in Best, Normal
or Ecofast  quality print.

4 Click on OK button.
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17.4 WORKING WITH POWERPOINT

Now that you have got a general idea about PowerPoint let us get down to brass tracks.

We will create a presentation in PowerPoint to see how simple it really is. For this purpose,

I have deliberately taken a slightly longer route to create this presentation and have even

made the user do things, which PowerPoint can very well do itself. The intention behind

this has been to demystify the PowerPoint features and show how you can cutomize

templates and wizards provided by PowerPoint and get the exact look that you want.

You have already seen the various parts of the PowerPoint in the previous screen. Also, it

is important to familiarise yourself with the PowerPoint standard toolbar, the formatting

toolbar, the drawing toolbar, and the autoshapes toolbar. So if you have skipped that

section please go back and take a look there.

Please take a look at the sample exercise pages (ten slides), so that you know what

presentation you have to create and then follow the steps mentioned in the following pages.

So let’s begin now!
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Starting PowerPoint

1 Click here to start PowerPoint or

2 Choose Microsoft PowerPoint from Microsoft Office 2000 from

Programs menu.

First Screen

This is the first screen that appears on starting PowerPoint. Let me briefly explain

about the option here.

A This is the quickest way to create a presentation by choosing from

predefined subjects and templates.
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B In case you simply wish to use predefined templates containing colour schemes

and background, etc. choose this option.

1 To create a presentation from scratch, click here.

2 Click on OK button once to continue.

3 Choose the Title Slide from Auto Layout box.

4 Click on OK  button to continue.
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Creating Front, Font Size and Bold

1 Type the presentation title.

2 Click on the text box boundary to select the entire text box.

3 Drag the box to the top of the slide and position at the desired location. You

can also resize this box, as

shown here.

4 Click here to continue.

5 Type the desired text.
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Moving the Frame and Inserting ClipArt

1 Click here to increase Font size.

2 Click here to decrease Font size.

3 Click here to apply shadow effect to the text.

4 Choose ClipArt command from Picture option of Insert menu.

A Highlight the text and format the text to your liking. You can change the Font,

Point size, Font style and Alignment. You will notice that the formatting toolbar

is ver similar to Word or Excel.

B Once having applied the desired formatting command, drag and move the

box towards the right hand side.

5 Click here to choose Animals Category.

6 Click here to choose the picture and Click Insert Picture icon to insert picture

into your slide.
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C You would see the picture inserted in your slide.

This dialogue box would be shown to you. Move up and down through

various categories and pictures using Scroll bars to see a preview of the pictures.

7 Drag and move the picture box to the new position.

8 Size the picture box to fit within the available space.
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Inserting Picture

1 Choose again Clip Art command from Picture option of Insert menu.

2 Choose ‘Cartoons’ Category

3 Choose the picture.

4. Click here to insert picture.

5 Use the technique explained earlier to move the picture to the right position

and resize it as per your requirement.
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A Congrats! You have just finished your fist slide
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Inserting a New Slide

1 Click here to create a new slide.

2 Choose Title Only’ from Auto layout.

3 Click on the OK button once to continue.

4 Type the text and apply Bold attributes.
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Copying Picture from Previous Slide

Now we wish to insert the Elephant picture (our logo) slide. We have two options.

One, we use step for moving and inserting Clip Art, explained earlier to do so.

The second and simpler would be to copy it from the previous slide. Doing so

would be much faster.

1 Press Page Up key to go the previous slide.

2 Click here to choose this picture box.

3 Click here to copy

4 Press Page Down key to go to the new slide.

5 Click on Paste icon and get the properly sized and placed picture.
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Moving the Text

Now since the picture is overlapping on the text box we will have to resize our text

box.

Inserting Picture

1 Choose Clip Art command from Picture option of Insert menu.

2 Choose ‘Sports and Leisure’

A Now both the picture and text fit properly.
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3 Choose the picture.

4 Click to insert another picture.

5 Resize and drag to place the picture at the desired location

6 Now use the same technique to get all the other picture so that the slide looks

like this.

331



Inserting Text

1 Click on this icon. Place the mouse pointer here by clicking it once.A small

box with a cursor in it would appear.

2 Type ‘Mysore City Corporation’ and click anywhere outside this box to

conclude.
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A You can open the Drawing toolbar by clicking on Drawing command from

Toolbars option from View menu.

B The second slide is complete.
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New Slide

1 Choose New Slide from the Status Bar.

2 Choose bulleted list from Auto layout box.

3 Click OK to continue.
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Changing the Font Size

1 Type the title and highlight it.

2 Click here to give a shadow effect.

3 Choose ‘Comic Sans MS’ font.

4 Increase the size of the font.
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Copying Picture from Previous Slide

1 Copy the picture from previous slide.

2 Type the points

3 Highlight all the points

4 Click here repeatedly to increase the paragraph spacing to desired level.
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Sizing Box and Inserting Picture

1 Size the box to the size of text.

2 Choose Clip Art command from Picture options of Insert menu. Choose People

from category.

3 Choose the picture

4 Insert another picture.

5 Size the picture box to fit within the space available.
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Copying Text from Previous Slide

1 Copy this text box from previous slide

2 Paste it here.
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A Your third slide is complete!
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New Slide

1 Add a ‘Title only’  slide.

2 Type and format the text and copy the logo picture from previous slide.

3 Insert a text box.
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Text Styling

1 Type the motto. Increase the font size.

2 Apply the Bold, Italics, Underline attributes.

3 Insert another text box and type and format the text.
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Insert Picture

1 Choose Clip Art command from Picture option of Insert menu. Choose

Sports from Category.

342



2 Choose the picture.

3 Insert another picture.

4 Size the picture to fit on the full slide.
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Send to Back

You might have noticed that the picture is overlapping on your text and therefore,

the entire text is not legible. Let us see how we can use a special effect to send this

picture in the background, so that instead of picture coming on top, the text comes

on the top.

1 Select the picture. Right click with the mouse on it. The following menu would

appear. Select Send to Back command from Order menu.

2 Click on the text box once again to add something. Type the additional text

and click outside the box to finish.

A Your fourth slide is complete!
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New Slide

1 Insert a new slide.

2 Choose Graph from Autolayout box.

3 Click on the OK button once to continue.
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4 Add the title and the logo.

5 Double click here to start creating a graph.
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Entering Data to Graph

A This window would appear containing sample data.

1 Overwrite the sample data with your data.

2 Highlight and press Del to delete unwanted data.

3 Size this column so that the complete text is visible.

4 Click here to close the datasheet.

B You will see graph based upon provided data. You should insert the Footer

after this and you fifth slide would be complete.
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Review Questions

1 What are the steps involved in creating a new presentation?

2. What are the option available for creating a presentation?
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Course : 302 Lesson No. 18

Unit - IV INTRODUCTION TO MICROSOFT OFFICE   Semester-III

The Microsoft Office Button

We'll use Microsoft Word 2007 for our initial illustrations of Ribbon, Tab and Group

examples.

The first thing you'll notice, when

you open a 2007 Office

application is that there is no

longer a File choice in the Menu

Bar. The arrow above points to

the Microsoft Office Button
- which replaces File.

As you move your cursor over the

Microsoft Office Button a preview
image (image on right) will appear.

Click  the Microsoft Office button .

When you click the Microsoft Office
button, it will turn orange and a "File
like" menu will appear (similar to the

image on the right).

You'll notice that you now have little

images for choices and that some of

them have little arrows pointing to the

right.



These arrows indicate that there are additional choices for a selection.

We'll show you one of these on the next page.

On the right side of the Microsoft Office Button menu screen you will see your most

recently used files - Recent Documents (see arrow above on right).

Each Microsoft Office Button menu is tailored to its Office application (Word, Excel,

Power Point, etc).

Move your cursor over the

arrow to the right of the Print
button ( 1. ), a menu of print
choices will appear on the right
- under Preview and print the
document ( 2. ) (image on right).

Click Print ( 3.) at the top of the
Menu.

A standard Print Menu screen

will appear.

It is suggested that you spend a few minutes clicking the various choices in the

Microsoft Office Button menu screen to familiarize yourself with what they do.
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If you look at the bottom of the

Microsoft Office Button
menu screen you will see two

buttons. Since we're using

Word, the buttons indicate Word Options and Exit Word .

The buttons change with each application (e.g. PowerPoint will indicate PowerPoint

Options).

When you click the Word Options button the image below will appear. Notice, on the

left side of the menu screen there are a number of choices (e.g. Personalize, Display,

Proofing, etc.). When you click a choice on the left side of the screen, the options for that

choice appear on the right. Take a few minutes and move through these choices to
familiarize yourself with this menu screen. You will see that Microsoft has placed a lot

of resources that were under FileTools-Options, in previous versions of Office, in this

menu.
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Notice all of the useful online resources available to you.

Quick Access Toolbar

In the upper left corner - to the right of the

Microsoft  Office Button - you will see an area

called the Quick Access Toolbar (image on

left). This area is quite handy as it currently

contains several of the most used buttons in Office applications - Save, Undo, Redo, Print

and Print Preview. You can customize this toolbar by adding and removing as many Quick

Access button choices as you desire.

In the Quick Access Too1bar (on the left)

you can see we added the Insert Picture

button - since we are using it a lot for this

tutorial.

To add this button to the too1bar we

first clicked  the Insert Tab and

then RIGHT clicked the Insert
Picture button. One of the choices

was Add to Quick Access Toolbar.
When we clicked this choice the Insert Picture button was added. You can add any

button you choose by doing this.

To remove buttons from

the Quick Access

Too1bar just RIGHT
click on the button you

desire to remove and

choose Remove from
Quick Access Toolbar.

Ribbons

This is the new term you hear a lot about in 2007 Office. Ribbons stretch across the top of
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your application screen with features to assist you as you click the Ribbon Tabs. To us,

Tabs and Ribbons are the same. It like unreeling holiday ribbon from a spool and seeing

new images on the ribbon - very cool! So, we'll cover Tabs/Ribbons in great detail.

Tabs

Below the Microsoft Office Button and Quick Access Toolbar we see a series of

Tabs/Ribbons.

Tabs are similar to the Drop Down Menu choices in previous versions of Office. The Tabs

are, logically, a bit different for each 2007 Office application to assist you with the most

common features of that application. All the 2007 Office applications begin with the Home

tab.

The Home Tab/Ribbon for Word 2007 looks like the image below.

The Home Tab/Ribbon for PowerPoint 2007 looks like the image below.

The Home Tab/Ribbon for Excel 2007 looks like the Image below.
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The Home Tab/Ribbon for Access 2007 looks like the Image below.

You'll quickly notice that the Home Tab/Ribbon for each application shows the Clipboard
as the left "Group"  (except in Access) In Word and Excel, the Font Tab/Ribbon is to the

right, but in PowerPoint, because working with slides is paramount, the Slides Tab/Ribbon

comes next. If you have 2007 Office installed on your computer, open these four
applications and take a few minutes looking at each application's Home Tab/Ribbon.

Notice, the Tabs to the right  of the Home Tab/Ribbon are tailored to each application.

We'll work a bit with this in a little while.

Groups

In the image below, the arrows point to a new topic - Groups.

Clipboard Group

The Tab/Ribbon bar images (in this tutorial) are hard to read, so we've placed arrows (in
the image above) for the Groups in the Word Home Tab/Ribbon. Again, the Tabs/

Ribbons, and Groups,will vary depending on the application you're using. Let's look a bit

at the Groups in Word.
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The first Group on the Word Home Tab
is Clipboard. To open a Group you move
your cursor over the little down
pointing arrow in the lower right corner
of a group.

T h i s

arrow is

enlarged

in the

i m a g e

below.

When you click this arrow  the image on the right appears. Notice that the Clipboard

appears on the left side of your screen and shows any text or images you've copied. To

close this group, click the "X" in the upper right comer of the Group.

Font

Notice, in the Font Group area (above),

you have the most used Font features.
However, if you desire all of the font
features, just click the Open Group arrow
to the right of Font.

An old friend - the Font menu screen
appears (when you click the Open Group

arrow). You'll see this a lot as your learn more

about 2007 Office. Many of the "tried and

true" menu screens will appear in logical

places.
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Select Text Mini Toolbar

When you're working with text and fonts a really ingenious "new thing" occurs as you

highlight text - a Select Text Mini Toolbar appears!

In the image on the right we

highlighted - Highlight Text. When we

paused the cursor over the
highlight, a "shadow like" toolbar
appeared. When we move our cursor over the toolbar, it is ready for us to use it to

modify our text.

This is really handy as many of text formatting features are in the Mini Toolbar. The first

time you try this, be patient, it sometimes takes a few tries.

Paragraph

Notice in the Paragraph Group area (left)

you again have the most used Paragraph

features. However, if you desire all of the
paragraph features, just click the Open
Group arrow to the right of Paragraph.

The Paragraph menu screen appears when

you click the Open Group arrow to the right of

the Paragraph Group. You should now have a

"feel" for how the Tabs/Ribbons and Groups work

together to assist you.
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Styles

Hang on! The next Group on the Word Home Tab/Ribbon is Styles. If you go back to

Page 6 and glance at the Word, PowerPoint and Excel Home Tabs, you'll see that the right

portion of a Tab is where the application selections change to fit the application. In Word
you can now select a style from the Styles Group (image below). If you click the

More arrow in the lower right comer of the Styles group, you will see additional choices.

When you click the More arrow you will see an image similar to the one below. Notice

that we are in Times New Roman - Normal. On the next page we'll show you one of

the really, really neat new features in 2007 Office.
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Fasten your seatbelts!

We're going to highlight this paragraph (when we have finished typing it). Then we're

going to open the Styles Group. When the Group is open we'll move our cursor over
the choices, and as we do, you'll see, in the images below, that the entire paragraph
changes to that Style!

And another.........

We’re going to highlight this text - when we have funished typing it. Then we’re going to open the
Style Group. When the Group is open we’ll mover our cursor over the choices, and as we do, you’ll
see, in the images below, that the entire paragraph changes to that Style!

Other Tabs/Ribbons -

When you move to the other Tabs/Ribbons, you'll notice that they contain their own

Groupsassociated with that Tab. The Insert Tab/Ribbon (below) has logical "things" that

you would insert into a document - Shapes, Pages, Tables, Illustrations, Links, Headers/

Footers, Text and Symbols. Again, depending on your choices, many selections allow you

to "preview" what you've highlighted - similar to the two illustrations above.

358



It is suggested that you click the Tabs/Ribbons in each application you'll be using to

get a "feel" for them.

The Page Layout Tab/Ribbon also has logical selections - Themes, Page Setup, Page

Background, Paragraph and Arrange.

The References Tab/Ribbon will really come in handy for those publishing long
documents, articles or books - Table of Contents, Footnotes, Citations & Bibliography,

Captions, Index, and Table of Authorities.

The Mailings Tab/Ribbon lets you work with Envelops, Labels, Mail Merge, Fields and

Preview. It includes Create, Start Mail Merge, Write and Insert Fields, Preview Results

and Finish.

The Review Tab/Ribbon has the Proofing Tools, Comments, Tracking, Changes, Compare

and Protect features.
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The View Tab/Ribbon allows you to change the document Views, do Show/Hide, Zoom

and arrange your Windows.

This gives you a "feel" for how the Tabs/Ribbons work in Word 2007. Again, it would be
prudent to look at the other 2007 Office applications you will be using - to get a
similar sense for these new features.

Now we'll look at several other neat features of 2007 Office.

Picture Tools

Currently, when you click an image in Word 2007, PowerPoint 2007 or Excel 2007, a
Picture Tools Tab/Ribbon will be available to you. We placed a Microsoft Clip Art

frog on the left.

When we click the frog a Picture Tools Tab appears above of the other Tabs/
Ribbons.

When you click the Picture Tools Tab (we're still in Word ) the Picture Tools Ribbon
below appears.

Notice, like the other Ribbons, that Picture Tools also has its own Groups - Picture

Tools, Shadow Effects, Border, Arrange, and Size.
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You can click the Open Group
arrow at the lower right of some

groups to see more of the Group.

We clicked the Open Group
arrow on the Size Group and the

Format Picture Menu Screen

appeared.

If we are in PowerPoint - and click an image - Picture Tools becomes available. The

image below shows that there are different selections since we are now using PowerPoint.

SmartArt

In the Insert Ribbon/Tab at the bottom of page 10 there is a new selection that improves

on the "old" Drawing Toolbar - especially SmartArt . SmartArt is a part of Word, Excel
and PowerPoint.

We've enlarged the Word
Insert Ribbon/Tab (right) to

show the SmartArt selection.

When you click SmartArt a
Choose a SmartArt Graphic
menu (image below) will appear.

If you have used SmartArt in the past, you'll quickly see that it has been greatly enhanced.
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We'll click on the Pyramid and then click the OK button.

A Pyramid Diagram, similar to the one

on the right, will appear. Now it gets

exciting!

When you click the Pyramid you'll notice

a new SmartArt Tools Ribbon/Tab
appears (top of next page).

Similar to Picture Tools, you'll notice several Layout and SmartArt Styles Groups
designed for enhancing the Pyramid on which you're working.
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If you click the Change Colors
button in the SmartArt Styles
Group an image like the one the

right will appear. As you move
your cursor arrow over the
Primary Theme Colors, you'll

see that the Pyramid changes
to that color. We choose the one

you see marked by the arrow
on the right .

Our Pyramid now has this

shading!

If you now move your cursor
arrow over one of the images
in SmartArt Styles you'll see an

image similar to the one on the

right.

Comparable to the Text Styles

on Page 10, you can see how

2007 Office is enhanced to assist

you with these great previews.

We'll work with these in the

individual 2007 Office tutorials.

Other
Ribbons/Tabs/Tools
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Excel

If you are in Excel, you can now highlight a row, column or entire spreadsheet with
really eye-opening effects.

In the image on the right we opened the spreadsheet developed with the Excel 200

tutorial. We highlighted the December column and then clicked Conditional
Formatting . The drop down menu you see on the right appeared. We then clicked
Color Scales, when the area to the right of Color Scales appeared, we moved our
cursor over the serections. As with other 2007 applications, when you move your

cursor over the choices you will get a temporary preview of how your selection will
appear.

Notice, in Conditional Formatting , there are also Data Bars and Icon Sets selections.

If you were to choose these you would see small bar charts or little flags, smiley faces, etc.

appear in the area you highlighted. And the list goes on and on. Really awesome!

PowerPoint

You saw on Page 12 that Picture Tools is a significant part of Power Point 2007. Text
and titles are also very important. If you click a Text Box an image (similar to the one

below) will appear. Notice that a Drawing Tools Tab/Ribbon is available.

We clicked the Drawing Tools Tab then clicked the More arrow to the lower right of

the Shape Styles Group. An image similar to the one below appeared.

As with other Tools Tabs/Ribbons, when you move your cursor arrow over a selection
in the Format area - a preview of how your text will look with that selection appears.
We chose the one marked by the arrow below and our title looks like the one on the

right of the image.
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Also, in the

Drawing Tools

Tab/Ribbon, is the

Group WordArt
Styles.

We clicked the

More arrow to

the right of Word

Art Styles and the

image on the right

appeared. Once

again, as we

moved our cursor
over the choices,
a preview of our

title appeared in that WordArt Style.

We'll work with these Styles, and more, in the PowerPoint tutorial.
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The Lower Right Corner

Another efficient feature of 2007 Office is in the lower right comer of Word, Excel,

PowerPoint and Access. When you open these applications you will see that the "zoom"

feature is now available, as well as other logical "view" features for each application.

Word

The image on the

right is the Word
View Toolbar
(located on the

bottom Right of the

Word screen).

You'll notice that normal Word document views and zoom features are available.

PowerPoint

The PowerPoint View
Toolbar looks similar to the

image on the right.

Access

The Access View Toolbar
looks similar to the image on

the right.



Excel

The Excel View Toolbar
looks similar to the image on

the right.

We have found these View toolbars to be very handy as we've worked in these applications.

More Excel

While we're in the Excel View Toolbar we'll

mention the new Page Layout View.

When you click the Page Layout View button, an image similar to the one below will

appear. This view is similar to Print Layout View in Word . Now you have it in Excel!

It's really great as it not only gives you a "mini" print preview of your spreadsheet, it

also allows you to work with your Headers and Footers "interactively" by clicking
the Header or Footer area!
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We clicked in the center Header area and the image below appeared. Notice that a

Header and Footers Tools Tab/Ribbon is available - with all of the Header and Footer

Groups - and easy to use buttons.

Notice the Auto Header and Auto Footer buttons to the left of the Ribbon. You can

use these, or the Header & Footer elements, or simply type your header. This is

really flexible and you see your choices instantly.

You can see that 2007 Office is working with you more than ever. As we create the 2007

Office tutorials, we'll introduce you to, and show you how to use these Ribbons, Tabs,

Groups, and Toolbars unique to each application.

At the moment Word, Excel, PowerPoint, Access and creating messages in Outlook Mail

contain these new features. 2007 Publisher is fairly similar to Publisher 2003 - but has

Publisher Tasks to assist you in creating Publications. FrontPage has changed its name and

moved to a new family called Expression - with a new name - Microsoft Expression Web

Designer.
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APPENDIX
Table 1 : Significant Values of Student's t (with n degrees of freedom) Level of Significance

n
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Table 2 : Significant Values of 2 (with n degrees of freedom)
Level of Significance

n
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Table 3 : Significant Points of F (5 percent) with n
1
 and n

2 
degrees of freedom

n
2

n
1

37
1



Table 3 : Continued

n
2

n
1

37
2



Significant Points of F (1 per cent) with n
1
 and n

2
 degrees of freedom

n
2

n
1

37
3



n
2

n
1

37
4


